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Notices 

BioTek Instruments, Inc. 

P.O. Box 998, Highland Park 

Winooski, Vermont  05404-0998  USA 

 

All Rights Reserved 

© 2009, BioTek Instruments, Incorporated. No part of this publication may be 
reproduced, transcribed, or transmitted in any form, or by any means electronic or 
mechanical, including photocopying and recording, for any purpose other than the 
purchaser’s use without written permission of BioTek Instruments, Inc. 

Trademarks 

BioTek is a registered trademark, and EL406™, BioStack™, Ultrasonic Advantage™, 
and Liquid Handling Control™ are trademarks of BioTek Instruments, Inc. Microsoft®, 
Windows®, Windows XP, Windows 2000, Windows Vista™, and Excel® are either 
registered trademarks or trademarks of Microsoft Corporation in the United States 
and/or other countries. All other trademarks are the property of their respective 
holders. 

Restrictions and Liabilities 

Information in this document is subject to change and does not represent a 
commitment by BioTek Instruments, Inc. Changes made to the information in this 
document will be incorporated in new editions of the publication. BioTek assumes no 
responsibility for the use or reliability of software or equipment that is not supplied by 
BioTek or its affiliated dealers. 
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Contacting BioTek Instruments, Inc. 

BioTek Instruments, Inc. 

P.O. Box 998, Highland Park 

Winooski, Vermont  05404-0998  USA 

Customer Service and Sales 

Internet:  www.biotek.com 

Phone:  888-451-5171 (toll free in the U.S.) 
 802-655-4740 (outside the U.S.) 

Fax:  802-655-7941 

E-Mail:  customercare@biotek.com 

Service/TAC 

Phone: 800-242-4685 (toll free in the U.S.) 
 802-655-4740 (outside the U.S.) 

Fax: 802-654-0638 

E-Mail: tac@biotek.com 

European Coordination Center/ 
Authorized European Representative  

BioTek Instruments GmbH 
Kocherwaldstrasse 34 
D-74177 Bad Friedrichshall 
Germany 

Internet: www.biotek.de 

Phone: +49 (0) 7136 9680 

Fax: +49 (0) 7136 968 111 

E-Mail: info@biotek.de 

 
 

BioTek Instruments, Inc. 



Document Conventions  |  xi 

Document Conventions 

The intent of this Operator’s Manual is to instruct the new user how to set up and operate 
BioTek’s EL406™ Microplate Washer Dispenser. To help you read and understand this 
manual, certain document conventions have been used. 

Major topic headings start a new page (such as Document Conventions, above) to give 
you a visual and style clue that a new major subject is being introduced. One or more 
subheadings may appear below each major heading. 

This manual uses the following typographic conventions: 
 

Example Description 

 

These icons call attention to important safety notes. 

Warning! 
A Warning indicates the potential for bodily harm 
and tells you how to avoid the problem. 

Caution 
A Caution indicates potential damage to the 
instrument and tells you how to avoid the problem. 

 This icon calls attention to important information. 

 

The menu path to open the feature described is shown in this format. 

When applicable, the above format shows you how to navigate to the feature described 
in that section. 

 Note: Information of particular importance or usefulness is presented 
in this format.   

  Tips or other helpful information is presented in this format. 
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Revision History 

Rev Date Changes  

A 10/2008 First Issue 

B 4/2009 Full keypad control was added to EL406 and documented in 
this manual. Chapter 3, Operations includes complete 
instructions for operating the instrument using the keypad. 

  1536-well plate processing capability is available with required 
hardware. Operating instructions and physical descriptions 
were updated where applicable throughout the manual.  

  New 1536-well hardware includes 128-tube aspirate manifold 
and two 32-tube Syringe dispenser manifolds. Installation 
instructions, Specifications, operation and maintenance 
sections were updated accordingly. 

  AutoPrime functionality was changed: 
 Submerge tips, also known as soaking, capability was 

added; 
 First-use control to trigger function was removed. 

AutoPrime, when enabled, always runs regardless of 
whether the device has been used since startup. 

   

 

BioTek Instruments, Inc. 



Intended Use Statement  |  xiii 

Intended Use Statement 

 The EL406 Microplate Washer Dispenser provides microplate priming, washing, 
dispensing, and aspiration for ELISA, fluorescence and chemiluminescence 
immunoassays, cellular and agglutination assays. 

 The EL406 can operate as a stand-alone instrument or with standard robotic 
systems, such as BioTek’s BioStack™ Microplate Stacker. 

 The intended use of this instrument is dependent on the instrument’s labeling. If 
there is an IVD label, then the instrument may be used for clinical, research and 
development, or other non-clinical purposes. If there is no such label, then the 
instrument may only be used for research and development, or for other  
non-clinical purposes. 

Quality Control  

It is considered good laboratory practice to run laboratory samples according to 
instructions and specific recommendations included in the assay package insert for the test 
to be conducted.  Failure to conduct Quality Control checks could result in erroneous test 
data. 

 

Warranty & Product Registration 

Please take a moment to review the Warranty information that shipped with your 
product. Please also register your product with BioTek to ensure that you receive 
important information and updates about the product(s) you have purchased. 

You can register online through BioTek’s Customer Resource Center (CRC) at 
www.biotek.com or by calling 888/451-5171 or 802/655-4740. 
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Warnings   

 

Use the EL406™ Microplate Washer Dispenser on a flat surface and away 
from excessive humidity. 
When operated in a safe environment, according to the instructions in this 
manual, there are no known hazards associated with the EL406. However, 
the operator should be aware of certain situations that could result in 
serious injury:  
Do not reach into the instrument during operation, as the washer 
manifold or peristaltic pump (Peri-pump) pump barrel may pinch your 
fingers. Do not reach for the microplate carrier until it is in its home 
position. 
Do not run the Peri-pump without a cassette installed on the pump. 
Strict adherence to instrument maintenance and qualification 
procedures is required to ensure accurate dispense volumes and risk-free 
operation.  

 
 

Hazards and Precautions 

Hazards   

 

Warning! Power Rating. The EL406 must be connected to a power 
receptacle that provides voltage and current within the specified rating for 
the system. Use of an incompatible power receptacle may produce 
electrical shock and fire hazards. 

 Warning! Electrical Grounding. Never use a two-prong plug adapter to 
connect primary power to the EL406. Use of a two-prong adapter 
disconnects the utility ground, creating a severe shock hazard. Always 
connect the system power cord directly to a three-prong receptacle with a 
functional ground. 

 Warning! Internal Voltage. Always turn off the power switch and 
unplug the EL406 before cleaning the outer surface of the instrument.  

 
Warning! Liquids. Avoid spilling liquids: fluid seepage into internal 
components creates a potential shock hazard. Wipe up all spills 
immediately. Do not operate the instrument if internal components have 
been exposed to fluid. 
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Warning! Potential Biohazards. Some assays or specimens may pose a 
biohazard. Adequate safety precautions should be taken as outlined in the 
assay’s package insert. Always wear safety glasses and appropriate 
protective equipment, such as chemically resistant rubber gloves and 
apron.  

 Warning! Ultrasonic Energy. Ultrasonic energy is present in the 
ultrasonic cleaner reservoir when AutoClean programs are running 
(Ultrasonic Advantage™ models only). Avoid putting your fingers in the 
bath. Ultrasonic energy can be destructive to human tissue.   

 
Warning! Software Quality Control. The operator must follow the 
manufacturer’s assay package insert when modifying software parameters 
and establishing wash methods. 

 
Warning! Unspecified Use. Failure to operate this equipment according 
to the guidelines and safeguards specified in this manual could result in a 
hazardous condition. 

Precautions   

Caution: Service. Only qualified technical personnel should perform 
troubleshooting and service procedures on internal components. 

 Caution: Environmental Conditions. Do not expose the instrument to 
temperature extremes. For proper operation, ambient temperatures should 
remain between 10– 40C (50 –104F). Performance may be adversely 
affected if temperatures fluctuate above or below this range. Storage 
temperature limits are broader. 

 Caution: Chemical Compatibility. Some chemicals may cause 
irreparable damage to this instrument. The following chemicals have been 
deemed safe for use in this instrument: buffer solutions (such as PBS), 
saline, surfactants, deionized water, 70% ethyl, isopropyl, or methyl 
alcohol, 40% formaldehyde, and 20% sodium hydroxide. Other chemicals 
may cause severe damage to the instrument. Contact BioTek Instruments if 
you require further assistance. Refer to the Chemical Compatibility 
listing in Appendix C. 
Never use DMSO or other organic solvents in the Washer component. 
These chemicals may cause severe damage to the manifold. Use of wash 
buffers containing acetic acid is limited to washers upgraded with  
PN 68098 Teflon® valves. Contact BioTek for upgrade information and 
prior to using other questionable chemicals. 

 Caution: Sodium Hypochlorite. Do not expose any part of the 
instrument to sodium hypochlorite solution (bleach) for more than 20 
minutes. Prolonged contact may damage the instrument surfaces. Be 
certain to rinse and thoroughly wipe all surfaces.  
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Caution: Buffer Solution. Although many precautions have been taken 
to ensure that the instrument is as corrosion-proof as possible, the EL406™ 
is not sealed and liquids can seep into sensitive components. Make sure 
that any spilled buffer solution is wiped off its surfaces. Continuous 
exposure to salt solution may corrode parts of the microplate carrier, 
movement rail, springs, and other hardware. 

 Caution: Bovine Serum Albumin. Solutions containing proteins, such 
as bovine serum albumin (BSA), will compromise the washer’s 
performance over time unless a strict maintenance protocol is adhered to. 
Specific instructions regarding BSA are provided with the Preventive 
Maintenance guidelines. 

 Caution: Shipping Bracket. The manifold shipping bracket must be 
removed prior to operating the EL406, and reinstalled before repackaging 
the washer for shipment. Follow the Installation instructions. 

 Caution: Waste Sensor Port. The waste sensor port on the back of 
EL406 instruments is the same type as the 24-VDC power connector on 
some other BioTek products (like the BioStack™ Microplate Stacker). Do 
not plug an external 24-VDC power supply into the waste sensor port! This 
will permanently damage components of the PCB inside the EL406. 

 Caution: High Flow Pump Installation. DO NOT plug the High Flow 
vacuum pump cable into a wall outlet! Use the adapter provided with the 
pump to connect the pump to the accessory outlet on the back of the 
washer. Follow the Installation instructions. 

 Caution: Warranty. Failure to follow preventive maintenance protocols 
may void the warranty.  

 Caution: Disposal. This instrument contains printed circuit boards and 
wiring with lead solder. Dispose of the instrument according to Directive 
2002/96/EC, “on waste electrical and electronic equipment (WEEE).” 

 Caution: Electromagnetic Environment.  Per IEC 61326-2-6 it is the 
user’s responsibility to ensure that a compatible electromagnetic 
environment for this instrument is provided and maintained in order that 
the device will perform as intended. 

 Caution: Electromagnetic Compatibility.  Do not use this device in 
close proximity to sources of strong electromagnetic radiation (e.g., 
unshielded intentional RF sources), as these may interfere with the proper 
operation. 
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CE Mark 

 
Based on the testing described below and information contained 
herein, this instrument bears the CE mark 

Directive 2004/108/EC: Electromagnetic Compatibility 

Emissions - Class A 

Emissions - Class A 

The system has been type tested by an independent, accredited testing laboratory 
and found to meet the requirements of EN 61326-1 and EN 61326-2-6: Class A for 
Radiated Emissions and Line Conducted Emissions. Verification of compliance was 
conducted to the limits and methods of the following: 

CISPR 16-1, EN 55011 

This equipment has been designed and tested to CISPR 11 Class A.  In a domestic 
environment it may cause radio interference, in which case, you may need to 
mitigate the interference. 

Immunity 

The system has been type tested by an independent, accredited testing laboratory 
and found to meet the requirements of EN 61326-1:2003 and CISPR 16-2:1999 for 
Immunity. Verification of compliance was conducted to the limits and methods of 
the following: 

EN 61000-4-2 Electrostatic Discharge  

EN 61000-4-3 Radiated EM Fields 

EN 61000-4-4 Electrical Fast Transient/Burst 

EN 61000-4-5 Surge Immunity 

EN 61000-4-6 Conducted Disturbances 

EN 61000-4-8 Power Frequency Magnetic Field Immunity Test 

EN 61000-4-11 Voltage Dips, Short Interruptions and Variations 

Directive 73/23/EEC: Low Voltage (Safety) 

The system has been type tested by an independent testing laboratory and was found 
to meet the requirements of EC Directive 73/23/EEC for Low Voltage. Verification of 
compliance was conducted to the limits and methods of the following: 

EL406 Washer Dispenser  
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EN 61010-1 (2001) 2nd Edition 

“Safety requirement for electrical equipment for measurement, control and laboratory 
use. Part 1, General requirements.” 

EN 61010-2-101 (2002)  

“Particular requirements for in vitro diagnostic (IVD) medical equipment.” 

Directive 2002/96/EC: Waste Electrical and Electronic Equipment 

This instrument contains printed circuit boards and wiring with lead solder. Dispose of 
the instrument according to Directive 2002/96/EC, “on waste electrical and electronic 
equipment (WEEE).” 

EN 50419:2005 Marking 

Directive 2002/95/EC: Reduction of Hazardous Substances 
(RoHS) 

This instrument is exempt from RoHS requirement per Article 2, Category 9. 

Directive 98/79/EC: In Vitro Diagnostics (some models) 

 Product registration with competent authorities 

 Traceability to the U.S. National Institute of Standards and Technology (NIST): 

Microplate Washers: Dispense precision and average residual volume is 
traceable to NIST.  

EN 61010-2-101: Particular requirements for in vitro diagnostic (IVD) medical 
equipment. 
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Electromagnetic Interference and Susceptibility 

USA FCC CLASS A  

Warning:  Changes or modifications to this unit not expressly approved by the 
manufacturer could void the user's authority to operate the equipment. 

This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to Part 15 of the FCC Rules.  

These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. Like all 
similar equipment, this equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, 
may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause interference, in which case the 
user will be required to correct the interference at their own expense. 

Canadian Department of Communications Class A  

This digital apparatus does not exceed Class A limits for radio emissions from 
digital apparatus set out in the Radio Interference Regulations of the Canadian 
Department of Communications. 

Le present appareil numerique n'met pas du bruits radioelectriques depassant les 
limites applicables aux appareils numerique de la Class A prescrites dans le 
Reglement sur le brouillage radioelectrique edicte par le ministere des 
Communications du Canada. 

User Safety 

This device has been type tested by an independent laboratory and found to meet the 
requirements of the following: 

 Underwriters Laboratories UL 61010-1: 2004 

“Safety requirements for electrical equipment for measurement, control and 
laboratory use; Part 1: general requirements” 

 Canadian Standards Association CAN/CSA C22.2 No. 61010-1-04  

“Safety requirements for electrical equipment for measurement, control and 
laboratory use; Part 1: general requirements” 

 EN 61010 Standards – See CE Mark List 
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Safety Symbols   

Some of these symbols may appear on the instrument.  
 

 Alternating current 
Courant alternatif 
Wechselstrom 
Corriente Alterna 
Corrente alternata 
 

 Direct current 
Courant continu 
Gleichstrom 
Corriente continua 
Corrente continua 
 

 Both direct and alternating current 
Courant continu et courant alternatif 
Gleich-und Wechselstrom 
Corriente continua y corriente alterna 
Corrente continua e corrente alternata 
 

 

Earth ground terminal 
Borne de terre 
Erde (Betriebserde) 
Borne de tierra 
Terra (di funzionamento)  
 

 

Protective conductor terminal 
Borne de terre de protection 
Schutzleiteranschluss 
Borne de tierra de protección 
Terra di protezione 
 

 

On (Supply) 
Marche (alimentation) 
Ein (Verbindung mit dem Netz) 
Conectado 
Chiuso 
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Off (Supply) 
Arrêt (alimentation) 
Aus (Trennung vom Netz) 
Desconectado 
Aperto (sconnessione dalla rete di alimentazione)  
 

 

Warning, risk of electric shock 
Attention, risque de choc électrique 
Gefährliche elektrische Schlag 
Precaución, riesgo de sacudida eléctrica 
Attenzione, rischio di scossa elettrica 
 

 

Caution (refer to accompanying documents) 
Attention (voir documents d’accompanement) 
Achtung siehe Begleitpapiere 
Atención (vease los documentos incluidos) 
Attenzione, consultare la doc annessa 
 

 

Warning, risk of crushing or pinching 
Attention, risque d’écrasement et pincement 
Warnen, Gefahr des Zerquetschens und Klemmen 
Precaución, riesgo del machacamiento y sejeción 
Attenzione, rischio di schiacciare ed intrappolarsi 
 

 
 

 

Consult instructions for use 
Consulter la notice d’emploi 
Gebrauchsanweisung beachten 
Consultar las instrucciones de uso 
Consultare le istruzioni per uso 

 

 

In vitro diagnostic medical device 
Dispositif médical de diagnostic in vitro  
Medizinisches In-Vitro-Diagnostikum 
Dispositivo médico de diagnóstico in vitro 
Dispositivo medico diagnostico in vitro 

 

Separate collection for electrical and electronic equipment  
Les équipements électriques et électroniques font l’objet d’une collecte 
sélective 
Getrennte Sammlung von Elektro- und Elektronikgeräten 
Recogida selectiva de aparatos eléctricos y electrónicos  
Raccolta separata delle apparecchiature elettriche ed elettroniche 
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Introducing the EL406™ 

 

3 

A 

D 

B 

C 

2 

1 

E 

The EL406 offers two or three devices in one instrument: a microplate Washer, a 
peristaltic pump dispenser called the Peri-pump, and, optionally, a dual Syringe 
dispenser unit.  

 Device/Component Description 
1 Washer manifold 96- or 192-tube devices aspirate and dispense fluid; or 128-tube 

manifold aspirates fluid from 1536-well plates. 
2 Peri-pump 

Dispenser 
Peristaltic, 8-channel dispenser with entirely visible fluid path. 

3 (Optional) Syringe 
Dispensers 

Two distinct syringe-pump dispensers, each with a 16- or 32-tube 
manifold. 

A Ultrasonic cleaning 
and priming trough 

Supports AutoClean™ ultrasonic cleaning of the washer. 

B Dispense heads Supports Peri-pump’s Tip Holder and the Syringe dispensers’ two 
manifolds.  

C Priming trough Waste reservoir for collecting priming fluid for the Peri-pump and 
Syringe dispensers.  

D Plate Carrier Holds standard microplates for processing. 
E Keypad One of two ways to control the instrument; the other way is LHC. 

BioTek Instruments, Inc. 
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Features of the EL406 

 Supports all microplate-based assays, including ELISA, fluorescence, 
chemiluminescence, RIA, DNA probes, and cellular assays. 

 A variety of solutions, including buffered saline and reagents can be dispensed. 

 The intuitive menu-driven onboard software allows you to create and store up to 
99 wash and dispense protocols. BioTek provides numerous pre-defined protocols 
for maintenance and instrument qualification purposes. 

 Compatible with BioTek’s BioStack™ Microplate Stacker and BioStack™ Twister II 
Microplate Handler for automated plate processing. See page 6, Compatibility 
with the BioStack System.  

 A robot-accessible carrier that can be interfaced into some robotic systems. 

 Computer control using BioTek’s Liquid Handling Control™ software (“LHC”) 
and the EL406 Interface Software. 

 A low-maintenance design, the result of BioTek’s long history with  
liquid-handling instruments.  

Washer  

 Programmable dispense volumes, flow, and aspiration rates for a wide range of 
wash options, from gentle washing for cellular assays to vigorous washing for 
ELISA. 

 A “bottom washing” routine to lower the background absorbance and “crosswise” 
or secondary aspiration to reduce residual volumes, except in 1536-well plates. 

 Supports Wash, Prime, Dispense, and Aspirate steps (except dispensing to 1536-
well plates, which is performed with the dispensers).  

 An optional external buffer-switching module with four different supply bottles 
supports complex assays by allowing one protocol to automatically draw reagent 
from up to four separate reservoirs.  

 Built-in fluid flow, fluid detection, and vacuum sensing provide complete 
protection for unattended operation. 

 Several pre-defined programs are provided to simplify preventative maintenance, 
which should be performed regularly to ensure optimum washer performance. 

 BioTek’s patent-pending Ultrasonic Advantage™ (ultrasonic cleaner) provides 
extra cleaning power by using ultrasonic pulses in a water bath to remove residue 
on the manifold tubes. A stainless steel cleaning reservoir with an ultrasonic 
transducer bonded to the bottom of the reservoir is mounted on the washer. An 
AutoClean function enables the user to run ultrasonic cleaning routines. 

EL406 Washer Dispenser  
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Peri-pump Dispenser 

 A peristaltic pump with eight individual tubes transfers fluid from a supply bottle, 
or up to eight different supply bottles, to various vessels. The pump has four 
rollers over which the tubing is stretched.  

 The tubing is contained in an easy to load and unload cassette that is attached to 
the pump head. The pump’s protective cover must be in place to run a dispense 
routine. 

 Three cassette sizes are available: 1 µL, 5 µL, and 10 µL for the most precise 
dispensing of volumes from 1 to 3000 µL. 

 Autoclavable tubing (steam temperatures and pressures of 121 C and 1 bar  
(750 mmHg)) is compatible with 70% ethyl or isopropyl alcohol and 0.5% sodium 
hypochlorite (bleach) solution for easy maintenance. 

Syringe Dispensers 

 The Syringe dispenser has a long-lasting seal that ensures precise and accurate 
fluid delivery, as well as reproducibility for repeated dispenses. 

 Two syringes support distinct fluid sources, each with a 16- or 32-channel 
manifold to dispense to standard plates: 

 16-channel: one tube per well for 384-well plates and two tubes per well for 96-
well plates. 

 32-channel: one tube per well for 1536-well plates. 

 Autoclavable components can be used with organic solvents and provide easy 
maintenance. 

 Does not require recalibration. 

Liquid Handling Control™ (LHC) Software 

BioTek’s Liquid Handling Control (LHC) software lets you control the EL406™ 
Washer Dispenser from your computer. You’ll enjoy the convenience of programming  
assay-specific wash and dispense protocols in a familiar Windows environment 
(Microsoft® Windows Vista™, Windows XP, and Windows 2000). And, to keep the 
instrument in peak condition in busy laboratories, the LHC offers custom reminders 
that can be programmed for regular maintenance routines.  

For high-throughput applications, the LHC supports BioStack™ integration. 
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 

Please refer to the LHC Installation Guide and Help system to 
learn about: 

 Installing the LHC software on the controlling computer 

 Running Maintenance protocols 

 Enabling AutoPrime  

 Running Qualification protocols 

 Special considerations when operating with the  
BioStack Microplate Stacker 
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Compatibility with the BioStack 

The EL406 is compatible with BioTek’s BioStack Microplate Stacker.  The BioStack can 
rapidly transfer microplates one-at-a-time to and from the instrument, and includes: 

 Removable stacks (one input and one output). 

 Optional restacking of plates to maintain correct sequencing.  

 The ability to continue processing plates following the aborting/failure of one 
plate. 

 The ability to pause processing to allow the user to add more plates to the input 
stack or to remove some from the output stack. 

If you have purchased the BioStack to operate with the EL406, refer to the BioStack 
Operator’s Manual for instructions on configuring the EL406 to run with the BioStack. If 
you are interested in purchasing the BioStack, contact your local BioTek dealer for more 
information or visit our website at www.biotek.com. 
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Package Contents 

 Part numbers are subject to change over time. Contact BioTek 
Customer Care with any questions. 

 Description  PN 

Power cord (part numbers vary according to country of use) Varies 

RS-232 serial cable 75034 

USB cable (USB Virtual COM Port Driver Software & instructions) 75108 

Microplate carrier  7180501 

Priming trough insert (1) for Peri-pump 7182043 

Priming trough insert (2) for Syringe dispensers 7182044 

Mist shield and thumbscrews (2 installed) 7182042  

Strip plate (12x1) 98265 

Screwdriver, Phillips  98268 

Stylus – for cleaning 96- and 192-tube aspirate manifold tubes   7102108 

Stylus – for cleaning 96-tube dispense manifold tubes and 128-tube 
aspirate manifold tubes 

2872304 

Stylus – for cleaning 192-tube dispense manifold tubes   7102139 

10 cc Syringe and tubing for Peri-pump cassette maintenance 49919 

7182005 Shipping brackets (2) 

7182073 

Instructions for removal of shipping brackets 7181003 

Hex wrench – 9/64” for removing washer manifold 48434 

Hex wrench – 3/32” for removing syringe pumps 48570 

Hex wrench – 1/16” for removing magnets from dispense manifolds 48713 

Spare fuses (3) 46055 

EL406 Installation Guide (and Operator’s Manual on CD - PN 7181009) 7181010 

EL406 Keypad Quick Guide 7181022 

Packing instructions 7181004 

Document kit: Warranty statement, Calibration certificate 94075 

Declaration of Conformity For clinical use (IVD label) 7181007 

Vacuum line filter  48294 

EL406 Washer Dispenser  
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Optional Accessories 

 Part numbers are subject to change over time. Contact BioTek 
Customer Care with any questions. 

Module Description PN 

Washer  
 Buffer Switching external valve module w/ 4 supply bottles 7100540 
  Power cable for valve module 7100503 
 Additional washer manifold:   
 192-tube wash manifold (for HT 384-well plates)  
 1536-well hardware: 128-tube aspirate manifold and 32-tube 

Syringe dispenser manifolds (2) 
 

 4L bottles, standard vacuum pump:  
  Waste System (includes pump) 115V 7100529 
  Waste System (includes pump) 230V 7100546 
 4L bottles, high flow vacuum pump:  
  Waste System (includes high flow pump) 115V 7100584 
  Waste System (includes high flow pump) 230V 7100585 
 10L bottles, standard vacuum pump:  
  Vacuum pump, 115V 7100562 
  Vacuum pump, 230V 7100561 
  Waste System 7100582 
 10L bottles, high flow vacuum pump:  
  Waste System 7100582 
  High flow vacuum pump 115V 7100563 
  High flow vacuum pump 230V 7100564 
 Note: High flow pump recommended for 384-well washing with buffers not 

containing surfactant. 
 
Peri-pump Dispenser 
 Cassettes for peristaltic dispenser  
  1 µL Cassette – molded plastic tips 7170012 
  1 μL Cassette – sapphire jeweled tips 7170015 
  1 μL Cassette for 1536–well, sapphire jeweled tips 7170016 
  1 μL Cassette for 1536–well, molded plastic tips 7170018 
  5 μL Cassette – molded plastic tips 7170011 
  5 μL Cassette – stainless steel tips 7170014 
  10 μL Cassette – molded plastic tips 7170010 
  10 μL Cassette – stainless steel tips 7170013 
 Replacement Cassette Tubing  
  1 μL Replacement Tubing Set (molded plastic tips*) 7170009 
  5 μL Replacement Tubing Set (molded plastic tips*) 7170008 
  10 μL Replacement Tubing Set (molded plastic tips*) 7170007 
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 Cassette Calibration Kit 7170017 
 *Save your jeweled and steel tips for reuse with a replacement kit. 

  
Syringe Dispensers 
 Syringe Dispenser Module Kit  7180006 
 2 32-Tube Dispense Manifolds (ordered with 1536-Well 

Plate Washer kit) 
 

 Stylus – for cleaning 16-tube dispense manifold tubes  2872304 

 Stylus – for cleaning 32-tube LB dispense manifold tubes  7182095 

 Stylus – for cleaning 32-tube SB dispense manifold tubes  7182102 

 Inline Filters (2) 48705 
General 
 Liquid Handling Control™ Software  LHC 
 EL406™ Interface Software  7180202 
 EL406 Qualification Package (IQ-OQ-PQ)  7180527 
 BioStack Microplate Stacker  BIOSTACK2WR 

BIOSTACK2 
 BioStack Integration Kit for EL406  7310027 
 Blue Test Dye Solution 7773001 
 Wetting Agent Solution 

For evacuation 
and dispense 
tests 

7773002 
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Hardware Specifications 

Labware 

Microplates: 96-well, 384-well, 1536-well that comply with SBS microplate 
standards 1-2004, 2-2004, 3-2004, and 4-2004.  

Microstrips: 1 x 8, 1 x 12. 

Microwells: Flat, round, “V” bottom. 

  

Hardware & Environmental 

User 
Interface: 

2-line x 24 character LCD screen 

25 alphanumeric soft keys 

Power 
Supply: 

The instrument uses two internal power supplies: 24-volt 60 
watt and 48-volt 60 watt. These supplies are compatible with 
100-240 V~; 50-60 Hz. 

Accessory 
Outlet: 

 5.0 A, used for vacuum pump  

Dimensions: 16½ x 125/8 x 18 inches (42 cm x 32 cm x 46 cm)  (WxDxH),  

Weight: 32 lb (14.5 kg)  

Operating 
Conditions: 

10° - 40°C (50° - 104°F) 

Relative 
Humidity: 

The instrument should be operated in a non-condensing humid 
environment having a maximum relative humidity of 80% at 
temperatures up to 31C decreasing linearly to 50% relative 
humidity at 40C. 

Washer 

Manifold Type 

96-tube: Dual manifold with 96 sets of aspirate and dispense tubes 
arranged in an 8x12 array to process 96-well microplates. 

192-tube: 
Optional 

Dual manifold with 192 aspirate tubes and 192 dispense tubes 
arranged in a 16x12 array to process 384-well plates. 

128-tube: Aspirate-only manifold with 128-tubes in 32X4 array to process 
1536-well plates. One dispense pin in the manifold fills the 
priming trough for maintenance procedures. 

 

Other 

Waste bottle 
volume: 

4 or 10 liters, depending on the accessory package. 

Supply bottle 
volume: 

3.7 liter (4) with Buffer Switching module or optional 10 liter 
bottles.  

 

BioTek Instruments, Inc. 



Hardware Specifications  |  11 

Peri-pump Dispenser 

Peristaltic 
pump: 

Positive displacement peristaltic pump with 4 rollers that 
stretch the 8 tubes (one per channel) to deliver fluid 

 

Cassette 
Types 

Dispense range Cassette Life 
Dead 

Volume 

1 µL 1 – 3000 µL  1000 384-well plates @ 5 µL/well 1.2 mL 

5 µL 1 – 3000 µL 1000 96-well plates @ 50 µL/well 4.2 mL 

10 µL 1 – 3000 µL 1000 96-well plates @ 100 µL/well 7.4 mL 

 

Syringe Dispensers  

Manifold Type: 1x16-channel autoclavable manifold with replaceable stainless 
steel tubes.  

 1x32-channel manifold cannot be autoclaved, and does not 
support non-factory tube replacement; inline 90-micron filter 
included to minimize clogs.  
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Performance Specifications  

Washer  

Average Residual Volume (Evacuation Efficiency) 

96-Tube 
Manifold  

Average residual volume in the wells is  2 µL per well after a 3-
cycle wash, when 300 µL of deionized water with 0.1% Tween 20®, 
or buffer equivalent, is dispensed per well into a Costar®  
96-well flat-bottomed plate. The aspirate height adjustment is 
optimized for the plate prior to testing. 

192-Tube 
Manifold   

Average residual volume in the wells is  2 µL per well after a 3-
cycle wash, when 100 µL of deionized water with 0.1% Tween 20, 
or buffer equivalent, is dispensed per well into a Costar 384-well 
flat-bottomed plate. The aspirate height adjustment is optimized for 
the plate prior to testing. 

128-Tube 
Manifold 

Average residual volume in the wells shall be ≤ 0.1 µL per well 
when 10 µL of deionized water with 0.1% Tween 20 solution is 
dispensed per well into a 1536 well flat bottomed Nunc® plate.  

 

Dispense Accuracy 

96-Tube 
Manifold   

 5% when dispensing 300 µL per well of deionized water with 0.1% 
Tween 20, with FD&C #1 blue dye at a rate of 300 µL per well per 
second into a Costar 96-well flat-bottomed plate. The weight of the 
fluid dispensed shall be measured gravimetrically. 

192-Tube 
Manifold   

 5% when dispensing 80 µL per well of deionized water with 0.1% 
Tween 20, with FD&C #1 blue dye at a rate of 102 µL per well per 
second into a Costar 384-well flat-bottomed plate. The weight of 
the fluid dispensed shall be measured gravimetrically. 

 

Dispense Precision 

96-Tube 
Manifold   

 3.0% CV when dispensing 300 µL per well of deionized water with 
0.1% Tween 20, with FD&C #1 blue dye at a rate of 300 µL per well 
per second into a Costar 96-well flat-bottomed plate. The 
absorbance of the solution is read at 630 nm and 450 nm reference. 

192-Tube 
Manifold   

 4.0% CV when dispensing 80 µL per well of deionized water with 
0.1% Tween 20, with FD&C #1 blue dye at a rate of 102 µL per well 
per second into a Costar 384-well flat-bottomed plate. The 
absorbance of the solution is read at 630 nm and 450 nm reference. 
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Peri-pump 

 Dispense Precision and Accuracy 

Cassette  Precision is measured for multiple 
dispenses per channel using clean 
deionized water with 0.1% Tween 20 
with FD&C #1 blue dye. The 
absorbance of the solution shall be 
read at 630 nm and 450 nm 
reference. Specifications apply to 
volumes that are full unit increments 
for the cassette to which they apply. 
For example: the precision 
specification for a 10 L cassette is 
valid at 10, 20, 30, …, 3000 µL. 

Accuracy is measured 
gravimetrically when 
dispensing clean deionized 
water. Specifications apply to 
volumes that are full unit 
increments for the cassette to 
which they apply. For 
example: the accuracy 
specification for a 10 L 
cassette is valid at 10, 20, 30, 
... 3000 µL. 

< 10% CV  @ 1 µL per well ± 10% @ 1 µL per well 1µL 

< 5% CV  @ 2 µL per well* ± 5% @ 2 µL per well* 

< 5% CV  @ 5 µL per well ± 4% @ 5 µL per well 5µL 

< 2.5% CV  @ 10 µL per well* ± 2% @ 10 µL per well* 

< 4% CV  @ 10 µL per well ± 4% @ 10 µL per well 10µL 

< 2% CV  @ 20 µL per well* ± 2% @ 20 µL per well* 

 * These specifications are for these dispense volumes and higher. 

Syringe 

 

Dispense Accuracy Performance 

The weight of the fluid dispensed shall be measured gravimetrically. 

16-Tube When dispensing room temperature deionized water: 

 384-Well Dispense 

     1 µL for volumes of 5 to 100 µL, or 1% for all other volumes;  

96-Well Dispense 

     2 µL for volumes of 10 to 200 µL, or 1% for all other volumes. 

32-Tube  5% when dispensing 6 µL/well of deionized water with 
approximately 15% ethanol and FD&C #1 blue dye at flow rate 3.  
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Dispense Precision Performance 

16-Tube  2% CV typical when dispensing 100 µL of deionized water with 
FD&C #1 blue or #5 yellow dye, at dual wavelength using the 
appropriate wavelength for the dye. 

< 5% CV (typical precision at 20 µL per tube) 

< 10% CV (typical precision at 5 µL per tube) 

Note: Factory-tested using dispense volumes of 80 µL and 20 µL. 

32-Tube < 12% CV when dispensing 6 µL per well of deionized water with 
approximately 15% ethanol and FD&C #1 blue dye. Absorbance 
shall be read at 630 nm and 450 nm reference. 
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Glossary 

Pre-dispense Pre-dispense is a quick prime (over the priming trough) to normalize 
or wet the tips or tubes to correct for evaporation and other minor 
fluid loss. All dispense steps can be preceded by a pre-dispense, and 
generally this is recommended for precise, accurate dispensing. 
 Also called a "tip prime." 

Prime Thoroughly wetting the tubing and removing all air bubbles is 
required to meet performance specifications. Priming flushes the 
tubing and disposes fluid into the device's priming trough. The 
EL406 uses the vacuum pump to empty the fluid into the waste 
containers. Fluid used to prime the washer cannot be retrieved, but 
the Peri-pump and Syringe dispensers ship with "priming trough 
inserts" that sit in the priming trough to capture expensive 
reagents. 

Purge The Peri-pump dispenser offers “Purge” capability to reclaim fluid in 
the tubing. Purge reverses the flow direction, pumping fluid back 
into the supply vessel. 

Soak After dispensing fluid to the plate, a soak step temporarily stops the 
washer, allowing the fluids to interact. It can be combined with a 
Shake step to better mix the fluids. Your assay may benefit from a 
soak period to draw unbound reagent from the solid phase. 

Submerge The washer provides the ability to soak the manifold tubes in fluid 
for cleaning purposes. This option is enabled as part of a Prime step. 
After the priming fluid is dispensed into the trough, the tubes are 
lowered into the fluid, where they remain for the specified duration.  

Bottom wash For extra vigorous plate washing, a Bottom Wash adds an initial 
dispense-aspirate sequence (wash cycle) to the specified number of 
cycles. Fluid is simultaneously dispensed and aspirated to create 
cleaning turbulence, and ends with a final dispense to fill the wells. 

Cell wash Certain options and parameters are offered for extra-gentle plate 
washing. Find “Cell Wash” in the LHC Help and Operations chapter. 
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BioTek Instruments, Inc. 

Product Support & Service 

A superior support staff backs all of BioTek’s products. If your instrument or software ever 
fails to function perfectly, if you have questions about how to use or maintain them, or if 
you need to send an instrument to BioTek for service or repair, please contact our 
Technical Assistance Center (TAC). 

Our Technical Assistance Center is open from 8:30 AM to 5:30 PM (EST), Monday through 
Friday, excluding standard U.S. holidays. You can send a fax or an e-mail any time. 

Phone: (800) 242-4685 or (802) 655-4740 Fax: 802-654-0638 

E-Mail:  tac@biotek.com 

You can also request technical assistance from our website: www.biotek.com 

Please be prepared to provide the following information: 

 Your name and company information, along with a daytime phone or fax number, 
and/or an e-mail address 

 The product name, model, and serial number  

 The software configuration information: in the Liquid Handling Control™ (LHC) 
Software, select Tools>Instrument Utilities 

 For troubleshooting assistance or instruments needing repair, the specific steps 
that produce your problem and any error codes displayed on the screen  
(see also Appendix A, Error Codes). 

Returning Instruments for Service/Repair 

If you need to return an instrument to BioTek for service or repair, please contact the 
TAC for a Return Materials Authorization (RMA) number before shipping the 
instrument. Repackage the instrument properly (see Chapter 2, Installation), write 
the RMA number on the shipping box, and ship to this address: 

BioTek Instruments, Inc. 
ATTN: RMA# xxxxx 
Highland Park  
100 Tigan Street  
Winooski, Vermont  05404  USA 

Contacting BioTek for Applications Support 

BioTek’s fully equipped Application Laboratory provides our on-staff scientists with 
the means to assist you with the integration of our instrumentation and software with 
your unique scientific applications.  

Phone: (888) 451-5171  E-Mail: applications@biotek.com 

 



Chapter 2 

Installation 

This chapter includes instructions for setting up the EL406™ 
Washer Dispenser and installing its components. Instructions for 
repackaging the instrument for shipment are also included. 

1: Unpack and Inspect the Instrument .................................... 16 
2: Remove the Shipping Hardware.......................................... 18 
3: Set Up the Washer Component........................................... 21 
4: Set Up the Peri-pump Component....................................... 28 
5: Install the Syringe Dispenser Component............................. 33 
6: Install the LHC Software/Connect to Computer (Optional) ...... 39 
7: Connect to Power ............................................................. 40 
8: Define Instrument Settings................................................ 41 
9: Verify Performance ........................................................... 43 
Define Startup Preferences (LHC users only) ............................ 44 
Repacking the EL406 ............................................................ 45 
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1: Unpack and Inspect the Instrument 

 Important! Save all packaging materials. If you need to ship 
the instrument to BioTek for repair or replacement, you must 
use the original packing materials. Using other forms of 
commercially available packing materials, or failing to follow 
the repackaging instructions, may void your warranty.  

If the original packing materials have been damaged, 
replacements are available from BioTek.  

 

Inspect the shipping box, packaging, instrument, and accessories for signs of damage.  

If the EL406 Microplate Washer Dispenser is damaged, notify the carrier and your BioTek 
representative. Keep the shipping cartons and packing material for the carrier’s inspection. 
BioTek will arrange for repair or replacement of your instrument immediately, before the 
shipping-related claim is settled. 

Unpack the boxes containing the instrument and other equipment: 

 EL406 Microplate Washer Dispenser and accessories 

 Buffer switching valve module and accessories 

 Vacuum Pump and accessories 

 Dual Syringe Dispensers and accessories 

 Additional 192-tube washer manifolds for 384-well plate processing or 128-tube 
wash and 32-tube dispense manifolds for 1536-well plate processing. 

Accessories Checklist 

Use this checklist to make sure you have all the accessories: 

 2 Peri-pump Dispense Cassettes (customer specified)  

 Installation Guide and User’s Manual on CD 

 Microplate carrier 

 Mist shield 

 Strip plate 12 x 1 

 Priming trough inserts (3) 

 USB cable, USB Virtual COM Driver Software & instructions 

 Power supply and power cord 

 Serial cable (RS-232) 
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 Shipped in small plastic pouch: 

 Screwdriver for calibrating cassettes  

 10 cc syringe and tubing for flushing cassette tubes and tips 

 Velcro® strips for attaching plastic pouch on rear panel 

 Hex wrenches (3)  

 Spare fuses (3) for vacuum pump 

 Stylus for cleaning manifold tubes, one for each manifold 

 Buffer Switching (external valve) module 

 Vacuum pump and accessories (various models) 

 Bottles and tubing sets (various models) 

Optional accessories shipped separately: 

 Dual Syringe Dispenser module  

 EL406™ Qualification and Maintenance Package 

 Liquid Handling Control™ (LHC) software 

 EL406™ Interface Software 

 BioStack Integration Kit for EL406   

 Cassette Calibration kit 

 Additional manifold: 

  192-tube wash manifold for processing 384-well plates 

  128-tube aspirate and 32-tube dispense manifolds for processing 1536-
well plates 

   Various accessories like stylus for cleaning tubes, inline filters (2) 
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2: Remove the Shipping Hardware 

 

2 1 

2 – Dispense arm bracket 
1 – Manifold bracket 

Two gold-colored shipping brackets: 

Supplies 

A Phillips-head screwdriver is needed to remove the shipping brackets. 

Keep in mind that you will have to reinstall the shipping hardware and use the 
original shipping material if it is necessary to return the instrument to BioTek for 
service or repair. 

Remove the rubber band 

1. Carefully remove the rubber band that holds the pump cover in place 
around the Peri-pump dispenser. 

Store the rubber band in the small plastic storage pouch for future use. 

Attach the plastic storage pouch to the rear panel 

2. Use the Velcro strips to attach the plastic storage pouch to the rear panel of 
the instrument. Select a position that does not block the vent holes. 
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Remove the manifold shipping bracket 

 

2nd 

1st 

Remove the 8 screws and washers 
holding the bracket in place. First 

remove the screws from the manifold, 
and then from the instrument. 

1. Use the Phillips screwdriver to remove the 8 screws and washers holding the 
bracket in place. First remove the screws from the manifold, and then from the 
instrument. 

2. Slide the bracket towards you and remove. 

3. Store the bracket, screws and washers with the other shipping material.0.  
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Remove the dispense arm shipping bracket 

 

Remove 2 screws 

Dispense arm 

Transport rail 

The bracket holds in place both the dispense arm and plate carrier transport rail during 
shipping. 

1. Use the screwdriver to remove the 2 screws holding the bracket in place. 

2. Gently lift the dispense arm slightly to release the bracket and remove it. 

3. Reinsert the screws into the instrument’s base plate to prevent fluid from 
leaking into it. 

4. Store the bracket with the other shipping material. 0.  

The bracket holds in place both the dispense arm and plate carrier transport rail 
during shipping. 
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3: Set Up the Washer  

 Important! Avoid excessive humidity. Condensation 
directly on the sensitive electronic circuits can cause the 
instrument to fail internal self-checks.    

Operating Environment 

The instrument is sensitive to extreme environmental conditions. For optimal 
operation, install the EL406 under the following conditions:  

 On a level surface. 

 In an area where ambient temperatures between 10°C and 40°C can be 
maintained. 

 The instrument should be operated in a non-condensing humid 
environment having a maximum relative humidity of 80% at temperatures 
up to 31°C decreasing linearly to 50% relative humidity at 40°C.   

EL406 Washer Dispenser  



22  | Chapter 2: Installation  

Install the Microplate Carrier 

 

Transport rail 

Y-axis carrier arm 

Microplate clamp 

The Y-axis carrier arm attached to the Transport rail holds the plate carrier. It moves the 
plate carrier during processing to allow the dispensers to address high density plates. 

1. Locate the microplate carrier in the accessories box.  

2. Slide the plate carrier transport rail all the way to the right, and then back to 
the left about 1-2 inches (3-4 cm).  

3. Look at the underside of the carrier to visualize how it fits in place: its two 
legs will be positioned on the left and the curved hollow fits over the 
transport rail on the right. Note the small slit adjacent to the top of the 
curved hollow. This slit fits into the Y-axis Carrier Arm. 

4. Aligning the curved hollow with the transport rail, place the carrier on the 
rail so it fits into the slot on the Y-axis Carrier Arm. If necessary, release the 
spring-loaded microplate clamp in the back left corner of the carrier to level 
the carrier on the instrument. 0 

 If a 401 Instrument Error is displayed at startup, recheck the plate 
carrier position. Make sure the plate carrier is seated in the Y-axis 
Carrier Arm next to the transport rail.  
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Connect the Vacuum Pump, Tubes, and Bottles 

For optimal operation of the EL406, all tubing, cables, and fittings for the fluid supply 
and waste systems must be properly connected. This image illustrates the rear panel of 
instrument and the locations of the ports and connections for the fluid supply and 
waste systems.   

Before connecting the tubes and bottles: Rinse all waste and supply bottles with 
deionized or distilled water before connecting them to the tubing. Rinsing eliminates 
particles that may have collected during packing or unpacking. 

 

 

Rear Panel 
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Waste System 


Caution! Pump Installation.  

Do not plug the vacuum pump cable into a wall outlet! Use 
the adapter provided with the pump to connect it to the 
Accessory Outlet on the back of the instrument. This allows 
the EL406 to regulate the pump, turning it on and off as 
specified by the protocol. 

When using a standard pump (rather than the high flow 
pump), set the instrument’s Vacuum Dissipation Delay to 
prevent the pump from drawing excess current and blowing 
the 5-amp fuse. See Define Instrument Settings on page 41. 

 

 Note: The waste tubes have colored bands that match similarly 
colored dots next to the inlet/outlet ports on the waste bottle caps to 
ensure the correct connection of the tubing. 

 

Connect the tube 
from the waste 
bottle without the 
waste sensor cap, 
to the VACUUM 
port. 

Connect the two waste 
bottles to each other with 
the shortest tube, aligning 
the colored labels. 

Connect the tube from the 
waste bottle with the 
waste sensor cap to the 
vacuum pump. 

Connect the waste 
sensor cable to its 
port. 

Waste System 
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Three lengths of tubing are shipped with the waste module: 

Tubing: Connects: 

Short tube with yellow and green bands The two waste bottles to each other 

Long tube with green bands on both ends Bottle without sensor to vacuum port 

Long tube with yellow and orange bands Bottle with waste sensor to the vacuum pump 

1. Locate the quick-release caps shipped inside the waste bottles and attach 
the tubing to them as follows: 

2. Connect the waste bottles to each other using the shortest length of tubing, 
matching the colored bands on the tubing to colored dots on the caps. 

3. Attach the waste sensor cable to the Waste Sensor port on the back of the 
washer.  

4. Attach the tube from the waste bottle with the waste sensor in its cap to 
the vacuum pump. 

5. Attach the tube from the waste bottle that does NOT have the waste sensor 
in its cap to the Vacuum port on the back of the instrument. 

6.   Important! When installing BioTek’s vacuum pump, 
connect the pump’s AC power cable to the vacuum pump Accessory 
Outlet on the back of the instrument (see Caution on the previous page). 
(Use the accessory outlet adapter provided, if applicable.) 

7. Place the waste bottles and vacuum pump on the same horizontal plane as 
the instrument or below it, such as the floor beneath the work surface. This 
will help optimize performance. 

8. Make sure the waste bottle’s caps are well sealed. 0 

Install the Optional Vacuum Line Filter (PN 48294) 

The optional vacuum line filter can be installed halfway between the last waste 
bottle (overflow bottle) and the vacuum pump.  

To do this, cut the tubing and insert the filter, noting the direction of flow. The 
flow arrow on the filter should point toward the vacuum pump.  

In the event of a fluid overflow, the filter should prevent the destruction of the 
vacuum pump’s internal components. If an overflow does occur, check the filter for 
trapped fluid. If fluid is found in the filter, remove the filter and drain using the 
small white nut on top of the filter. Tighten the white nut and reinstall the filter. 
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Fluid Supply System with the Buffer Switching Module 

 

Connect the Valve 
Control cable from the 
Buffer Switching module 
to the instrument. 

Connect each of the buffer 
bottles to the designated 
buffer valve of the Buffer 
Switching module.  

Connect the Fluid Out 
port on the module to 
the Fluid In port on the 
instrument. 

Buffering Switching System 

1. Connect the valve cable from the Valve Control port on the module to the 
Valve Control port on the back of the instrument. 

2. Place the four supply bottles and valve module on the same surface as the 
instrument to optimize performance. 

3. Connect the tubing from one of the supply bottles to “A” Buffer in the valve 
module. 

4. Repeat step 3 with the other three supply bottles for “B,” “C,” and “D” 
Buffers. 

5. Connect the 6-foot (1.83 Meter) tubing from the valve box Fluid Out port to 
the Dispense Fluid In port on the instrument’s rear panel. This tubing can 
be cut to the optimal length required for the installation. 0 

 Note: Most instruments are configured at the factory to use the Buffer 
Switching Module to supply fluid. If you choose not to use the module 
and instead connect a supply bottle directly to the instrument, the 
volume dispensed to the plate will be slightly larger than specified, 
approximately 3-7% larger. 

Final Check 

 Verify that the tubing was not crimped during installation. 

 Ensure that there are no loose fittings or cable connections. 
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Attach the Mist Shield 

 

Mist Shield 

1. Loosen the two thumbscrews in the front base of the instrument, directly in 
front of the washer manifold and priming trough. 

2. Position the mist shield so the gaps align with the thumbscrews. One side of 
the mist shield rests on the instrument base. 

3. Finger-tighten the two thumbscrews to hold the shield in place. 0. 
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4: Set Up the Peri-pump Dispenser  

Install these items to use the Peri-pump dispenser: 

 Tubing cassette 

 Fluid supply vessel 

 (Optional) Prime trough insert 

Install the Tubing Cassette 

Take a moment to identify the EL406’s parts that are named in the instructions for 
installing the tubing cassette. 

 

 

Cassette latch Pump 

Pump cover 

 

Stainless steel plate 

Dispense arm 

Wash manifold 

To prepare the dispenser for cassette installation, open the pump cover,  
 release the cassette latch and lift the stainless steel plate up and over, to hang freely.    

 The pump cover must be closed to operate the dispenser. 
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Tubing Cassette Diagram 

 

Tip Holder 

2 

3 
1 

Tube Organizer 

Center Holder 

4 

Tube 
Tensioner  

Cassette Diagram 

1. Tip Holder: The cassette’s easiest part to identify, the tip holder fits into the 
dispense arm to the right of the pump for positioning above the plate.  

2. Tube Organizer: At the opposite end of the cassette from the tip holder, the 
tube organizer holds the 8 tubes together for inserting into the fluid vessel. 

3. Center Holder: The center holder is labeled to identify the size of the cassette 
tubing. It also has a serial number for tracking purposes. It fits in between the 
tip holder and the tube tensioner and fixes the tubes in place. It slides into 
grooves on the underside of the pump. 

4. Tube Tensioner: The transparent 5-mm scale on its front surface identifies the 
tube tensioner. It has 8 internal screws for stretching the tubing, one for each 
tube. The tube tensioner’s scale is useful when calibrating the cassette.0. 

Prerequisites: 

 Review the Tubing Cassette Diagram above to learn the names of the 
components. 

 Move the Pump Cover away from the pump to its OFF position. 

 Release the pump’s stainless steel plate: 
 Release the spring-loaded latch on the right–side of the caution symbol 

( ) on the pump and lift the stainless steel plate up and out. 
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Installing the Peri-pump Dispense Cassette                                   

1 Slide the Tip Holder into the dispense arm. The Tip Holder’s front plate with 
the BioTek logo faces the pump. Make sure the tip holder is level and snapped 
into place.  

 

BioTek logo 

Tube 
Tensioner 

Slide the Center Holder into position 
under the pump, with the cassette size 
label facing down. 

Center 
Holder 

Tip 
Holder 

2 Extend the rest of the cassette under the Peri-pump and above the washer 
manifold, so you can slide the Center Holder into its slot on the underside of 
the pump. A tab on the back plate of the center holder fits into a notch on the 
pump. The label on the center holder faces away from the pump. 
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Align the Tube Tensioner 
with the steel plate as you 
wrap them up and around 
the pump, clicking them into 
place. 

5. Align the Tube Tensioner with the stainless steel plate, making sure the 
knobs on top of the tensioner fit correctly into the grooves. Hold the cassette 
and steel plate together as you wrap them around and up against the pump 
and click the steel plate into place.  

 

6. Return the Pump Cover to its RUN position covering the pump. 

7. Lift the Tube Organizer over the pump cover. Place it in the fluid vessel, 
when you’re ready.0. 
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Prime Trough Insert 

 

Syringe 
inserts 

Peri-pump 
insert 

Priming Trough Inserts 

The EL406 ships with reservoirs that fit into the dispensers’ priming trough to 
capture expensive reagent after priming, rather than discarding it. Three Prime 
Trough Inserts are provided: 

 PN 7182043 for the Peri-pump dispenser holds approximately 12 mL 

 PN 7182044 (2) for the Syringe dispensers holds approximately 6.5 mL 

 Without the prime trough insert, the priming trough empties into the 
regular waste bottle described on page 24. 
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EL406 Washer Dispenser  

5: Install the Syringe Dispenser  

 The dual Syringe Dispenser is an optional component. Skip this section 
of the installation process if it is not applicable. 

 1536-well EL406 models ship with both the 16-tube dispense 
manifolds, which dispense to 96- and 384-well plates, and the 32-tube 
dispense manifolds for processing 1536-well plates.  

The Syringe dispenser is an optional component and ships separately.  

To install the unit: 

1. Inspect and unpack the shipping container. 

2. Place the unit on top of the EL406 in the hollow designed to hold it (top left, 
with special indentations for the unit’s feet). Alternatively, place the unit on the 
same surface as the instrument. 

3. Plug the 26-pin high-density cable into the back panel of the EL406 in the port 
labeled Syringe Pump Dispenser. Plug the other end into the dispenser unit. 

4. Connect the tubing:  

 

Check Valves, Tubes, and Bottles 

For each Syringe dispenser, two sets of tubing with check valves and a two liter 
supply bottle are provided. The 32-tube dispense manifolds also ship with an 

Flow 
direction 

Check valves 

Flow 
direction 

Luer fitting 
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optional inline filter that BioTek recommends installing when using the 32-tube SB 
– small bore – models. Learn more about check valves on page 35. 

 The supply bottles have Luer fittings. Finger-tighten only!  

 Rinse all bottles with deionized or distilled water before using to eliminate 
particles that may have entered during packing or unpacking. 

 Place the supply bottles on the same horizontal plane as the instrument. 
This ensures optimum pump performance. 

 Verify that the tubing was not crimped during installation. 

5. Locate the set of tubing with the Luer fitting on one end. (After installing the 
inline filter for 32-tube dispensers, if applicable), gently screw the Luer fitting 
into the top of the supply bottle. Finger-tighten only.  

6. Attach the other end of the tubing from the supply bottle to the bottom port of 
one of the Syringe pumps.  

 

2. Connect the tube going from 
the pump to the dispense 
manifold to the top port. 

1. Connect the tube from the 
supply bottle to the Syringe 
pump’s bottom port. 

Top port 

Bottom port 

Make sure the flow-direction arrows on the check valves point in the right direction.   

7. With the check valve’s flow-direction arrows pointing correctly, connect the 
other tube to the top port of the Syringe pump. 

8. Connect the tube’s other end to the dispenser manifold. 
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Dispense arm posts 

9. Slide the manifold onto the two posts on the dispense arm with the tubing end 
closest to the instrument. Install Syringe A’s manifold first. Syringe B’s 
manifold must be installed after Syringe A’s. See the instructions for removing 
the magnets for certain assays on page 35. 

 The images of syringes labeled A and B on the instrument indicate the 
placement of each dispenser’s manifold: A slides on first, then B. 

 

10. Use the black bracket attached to the instrument just below the Peri-pump to 
keep the tubing out-of-the-way. Make sure the manifold has enough slack in 
the tubing to move freely, and then snap the tubing into the bracket. 

11. Repeat the check valve and tubing installation for Syringe B.0. 

 Important! If the dual Syringe Dispenser unit was 
purchased separately, e.g., at a later date, from the 
instrument, you must tell the EL406 that it is installed, i.e. 
use the Instrument Utilities to update the instrument’s 
internal basecode. Find instructions on page 42.     
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Check Valves 
Note the flow direction arrows on the check valves. Some are harder to see than 
others. 

 PN 68083 – Autoclavable valves for use with non-organic substances. The 
direction arrows are difficult to see.  

 PN 68073 – Check valves recommended for use with organic substances. 
They cannot be autoclaved. Direction arrows are easy to see. 

 Direction of flow
on check valves

Two o-rings on this side One o-ring on this side 

 

 

 

 

 

 

 

 

Autoclavable check valve, detail   

It is difficult to see the flow direction arrows on the autoclavable check valves. The 
valves are made of a translucent plastic, in which the flow direction arrows are 
engraved. 

 Note: If the check valves are replaced, it may be necessary to 
recalibrate the syringe backlash to achieve optimum performance. See 
“Recalibrate the Backlash” in Chapter 4 for more information. 
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Install Inline Filter for 32-Tube Dispensers 
BioTek ships two 90-micron inline filters with the 32-tube dispense manifolds to reduce 
the chances of clogging the dispense tubes.  It is especially important for the SB – small 
bore models. 

To install the filters: 

1. Locate and layout the length of tubing that goes between the supply bottle 
and the pump; it has the Luer fitting on one end.  

2. Cut the tubing approximately one to two inches above the Luer fitting. 

3. Slide the filter’s nozzle ends into the two ends of the tubing, reconnecting it. 

 Nozzle ends 

Inline filter 

Luer fitting 
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Special Procedure for Magnetic Bead Assays 
Before using the dual Syringe Dispenser to dispense magnetic beads, you must 
remove the magnets that normally hold the dispense manifolds on the instrument. 
Two thumbscrews are shipped with the instrument to replace the magnets.  

 

Remove the 
magnet using 
the 1/16th hex 
wrench 

1/16th Set screw 

1. Use the 1/16th hex wrench (PN 48713) to loosen the set screw on top of the 
manifold. 

2. Take advantage of the magnet’s attraction to the hex wrench to remove it 
from the manifold.  

3. Locate the thumbscrews shipped with the instrument’s accessories. After 
sliding both manifolds onto the dispense arm, put the screws into the post 
to hold the manifolds in place. 

 

Put the thumbscrews 
into the posts to hold the 
manifolds in place. 

 Store the magnets in the plastic pouch for potential future installation. 
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6: Install the LHC Software/Connect to Computer 
(Optional) 

For a more graphically rich experience designing protocols and monitoring progress, 
the EL406 can be controlled with software for your personal computer (PC): 

 Liquid Handling Control™ (LHC) Software 

 EL406™ Interface Software (EL406 IS) 

 BioStack™ PC Control Software (if applicable) 
 

Please refer to the LHC Installation Guide for complete installation and setup 
instructions.  Likewise, install the EL406 Interface Software and BioStack PC 
Control Software (if applicable) according to instructions provided with the CD. 

Connect the USB or Serial Cable to the Host Computer 

Two cables are shipped with the EL406: 

If using the serial cable: Plug one end into the RS232 serial port on the rear of the 
instrument and the other end into an available port on the computer. 

If using the USB cable: Plug one end into the USB port on the rear of the 
instrument and the other end into an available port on the computer.  

 If the computer is connected to the internet, turn on the instrument. 
Windows® will automatically locate and install the necessary USB drivers 
(follow the instructions provided on the screen).  

 If the computer is NOT connected to the internet, you can install the drivers 
using the supplied “Virtual USB Com Port” driver software CD.  

 Virtual Com Port (VCP) drivers for all Windows operating systems are 
available at http://www.ftdichip.com/Drivers/VCP.htm  

 The EL406's keypad must be displaying its “Main Menu” for the LHC to 
communicate with it. 

 

EL406 Washer Dispenser  

http://www.ftdichip.com/Drivers/VCP.htm


40  | Chapter 2: Installation  

7: Connect to Power 


Warning! Power Rating. The EL406™ must be connected 
to a power receptacle that provides voltage and current 
within the specified rating for the system. Use of an 
incompatible power receptacle may produce electrical 
shock and fire hazards. 


Warning! Electrical Grounding. Never use a two-prong 
plug adapter to connect primary power to the EL406. Use of 
a two-prong adapter disconnects the utility ground, 
creating a severe shock hazard. Always connect the system 
power cord directly to a three-prong receptacle with a 
functional ground. 

 
The EL406 supports voltage in the range of 100-240 V~ at 50-60 Hz.   

1. Insert the power cable into the power cable socket in the rear panel of the 
EL406. 

2. Insert the three-prong plug into an appropriate receptacle. 0 
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8: Define Instrument Settings 

Standard Vacuum Pump Users 

 Do not perform this step when using the High Flow vacuum pumps 
(PN 7100563, 7100564). High flow pumps are recommended when 
aspirating 384- and 1536-well plates with wash buffers not containing 
surfactant (e.g., pure DI water).  

Perform this step ONLY if you are using the “standard” vacuum pump (BioTek PN 
7100561, 7100562): increase the Vacuum Dissipate Delay to match your waste 
container: 1 second per liter.  For example, if you have a 10 L waste bottle, set the delay 
to 10 seconds. 

Option Description 

Using the keypad 1.  Press Setup Menu. 

2.    Select the arrow (for more options) twice. 
3.  Select VACDIS. 
4.  Use the number pad to set the Vacuum Dissipate Delay to 

match your waste container: 1 second per liter. 

5. Press Main Menu upon completion. 

Using the LHC 

 

1. Select Tools > Instrument Utilities. 
2. Under “General Settings,” increase the Vacuum Dissipate 

Delay to match your waste container: 1 second per liter.  
3. Click Send to download this new setting to the instrument. 
4. Click Exit to return to the main screen. 

 Setup 
 Menu 

LHC Users Only 

 When using the LHC to control the EL406, an important first step is defining your 
instrument’s settings. After installing the LHC and EL406 IS software, you can use the 
desktop icon or from the Windows Start button to launch the LHC: 

 > All Programs> BioTek> Liquid Handling Control 

1. Click the Name link on the main page and, if required, select the EL406. 

2. Specify the COM Port used to connect the EL406 to the computer and click 
Test Communication.  

 Pass: proceed to the next step. 

 Fail: check the Com Port setting. See “About Com Ports” in the LHC Help. 

3. In the Instrument Settings dialog that opens, under Get settings from: click the 
instrument link, and click OK.0. 

EL406 Washer Dispenser  



42  | Chapter 2: Installation  

Update the EL406 to use the Syringe Dispenser 

 Important Prerequisite: The EL406 Interface Software (IS) is 
required to update the instrument’s configuration data. You must be 
controlling the EL406 with the LHC software or obtain a copy of the 
EL406 IS Utility from BioTek’s customer resource center: 
https://customer.biotek.com.  

If the dual Syringe Dispenser unit was purchased separately from the instrument, you 
must update the EL406’s internal basecode.  When the Syringe dispenser is ordered 
with the instrument, BioTek updates the basecode at the factory.  

 1536-well models: All Syringe dispensers are calibrated for use with 
their 16-tube dispense manifolds. When dispensing with the 32-tube 
dispensers, if dispense accuracy needs improvement, make a small 
adjustment to the Backlash to achieve specified performance.  

1 Turn on the instrument, launch the LHC software or the EL406 IS Utility and 
make sure it is communicating with the EL406 (define the correct COM port). 

2 Select Tools>Instrument Utilities>Syringe Dispenser. 

3 Select the Installed button under Syringe Pump Assembly and click Send. 

4 Review or enter the Calibration Data:0 

 

Review the data: 

BioTek enters the Calibration Data and tests 
the syringe before shipping when it is 
purchased with the EL406. In this case, you 
may want to verify the correct values have 
been entered. 

Compare the data onscreen to the data sheet 
on the bottom of the modular unit. 

Enter the data: 

If you have purchased the syringe module 
separately, you must enter the Configuration 
Data for the unit. Find the data sheet on the 
bottom of the syringe dispenser module and 
enter the values in the Cal Pt. table.    

After entering data points, click Send to 
download them to the instrument. 

 Tip: Small adjustments to the Backlash may be needed to improve the 
dispense accuracy of 32-tube dispense manifolds: See Chapter 4, 
Maintenance for “Recalibrate the Backlash” instructions. 
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9: Verify Performance 

Before using the ELx406 for the first time, verify that it is operating properly.  

 When using the LHC, make sure the EL406 is connected to the PC and both 
are powered up.  

 When running standalone, turn on the EL406. 

Using the keypad: 

1. Press the Setup Menu button, and select  for more options. 

2. Select TESTS and SLFCHK. 

Using the LHC: 

1. Click the Name link on the main page and, if required, select the EL406. 

2. Define the COM Port used to connect the EL406 to the computer and Test 
Communication.  

 Pass: proceed to the next step. 

 Fail: check the Com Port setting. See “About Com Ports” in the LHC Help. 

3. In the Instrument Settings dialog that opens, under Get settings from: click the 
instrument link, and click OK. 

4. Select Tools>Instrument Utilities 

5. On the General Settings tab, click the Perform Self-Check link.0. 

Test results: 

 Pass: a passing message is displayed.  

 Fail: an error message is displayed. If this happens, note the error code and 
refer to Appendix A, Error Codes in the operator’s manual to determine its 
cause. If the problem is something you can fix, turn off the instrument, fix 
the problem, and then turn the washer back on. Otherwise, contact BioTek’s 
Technical Assistance Center. 

Chapter 5, Qualification in the operator’s manual provides recommended 
Installation and Operational Qualification procedures to be performed after the 
instrument is installed and before the instrument is used in a laboratory environment.   

The successful completion of the Installation Qualification confirms that the EL406 and 
its components have been supplied as ordered, and assembled and configured 
properly for your lab environment. 

The successful completion of the Operational Qualification confirms that the EL406 is 
operating according to specification. 
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 Note: An instrument qualification package (PN 7180527) for the 
EL406 is available for purchase from BioTek. The package contains 
thorough procedures for performing Installation Qualification, 
Operational Qualification and Performance Qualification (IQ-OQ-PQ) 
and preventive maintenance (PM). Extensive Checklists and Logbooks 
are included for recording results. Contact your local dealer for more 
information. 

 
Important! Before operating this EL406, review the Optimize 
Performance guidelines in Chapter 3, Operation. These 
guidelines include necessary steps to perform before running a 
protocol, information on performing periodic maintenance, and 
points to consider when creating or editing washer programs. 

Define Startup Preferences (LHC users only) 
You can save enormous time creating protocols by following these steps to define a 
New Protocol template and use it at startup. 

Create a protocol template 

1.  Click the New button or select File>New.  

2. Click Name. Select the instrument, if you have more than one, and define its 
Port and Settings. 

3. Optionally, select the Plate Type, fill in the text fields, and add any steps that 
you want all new protocols to include. 

4.  Click Save and assign a unique name, e.g. Template.LHC. 

5. Select Tools>Preferences>New Protocol. 

6.  Select the button for Protocol selected below to use as a template. 

7. Click selected and select the protocol you created as a template. 

Define startup behavior: 

8. After completing the steps above, select the Startup Options tab. 

9. Select the button for New Protocol. 

10. Click OK to save your new preferences.0. 
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Repacking the EL406 

 Failure to comply with the following instructions will void the 
instrument’s warranty.  

 Follow the decontamination procedure in Chapter 4, Preventive 
Maintenance, before returning the instrument. 

Prepare the instrument for shipping bracket installation: 

Using the Description 

Keypad 1.  Press Setup Menu. 

2.  Select  

3.  Select WASH. 

4.  Select PARK. 

LHC 1. Select Tools>Instrument Utilities>Washer.  

2. Click the shipping bracket link under Service Functions.  

 Setup
 Menu

 

Continue to prepare the instrument for shipping: 

1 Remove the Peri-pump’s cassette and the Syringe dispensers’ manifolds, if 
applicable.  

2 Remove the plate carrier and put it in the accessories box.  

3 Slide the transport rail into position next to the dispense arm. It will be 
secured in place by one of the shipping brackets.0 

EL406 Washer Dispenser  



46  | Chapter 2: Installation  

Install the shipping brackets: 

First install the 4 rear 
screws, attaching the 
bracket to the instrument, 
before installing the 4 
screws into the manifold. 
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 The instrument’s packaging design is subject to change over time. If 
the instructions in this section do not appear to apply to the packaging 
materials you are using, please contact BioTek’s Technical Assistance 
Center for guidance. 
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Chapter 3 

Operation  

This chapter covers basic operation of the EL406 using the LHC™ 
software and the instrument’s keypad, and provides guidelines to 
ensure the instrument’s top performance. 
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Basic Operation 

 Review the EL406 Installation Guide or Chapter 2, Installation, for 
instructions on how to set up the fluid supply, vacuum pump, and 
waste receptacles. This section describes how to use the keypad or the 
LHC to run the instrument. 

Two ways to control the EL406 

You can control the EL406 using its built-in keypad or with BioTek's Liquid Handling 
Control™ (LHC) software, which works with the EL406™ Interface Software (IS), to 
design protocols and control the instrument.  

This section includes a quick introduction of the instrument’s keypad, a complete 
description of keypad functionality is provided later in the chapter.  

To use the LHC to control the EL406, it must be attached to and communicating with 
your personal computer (PC), and its main menu must be displayed. Basic protocols 
can be created or modified using the LHC, and then downloaded to the instrument for 
stand-alone operation.   

Using the  Learn about the options: 

Keypad  Introducing the Keypad on the next page. 

 Controlling the EL406 using the Keypad on page 66. 

LHC  Introducing the LHC – EL406 Workspace on page 72. 

 Use the LHC Help system: select the Help menu or click a 
Help button in a window. 

 When using the LHC, make sure the required software has been 
installed and other installation tasks have been completed. 

Turn On/Off the EL406 

To turn the instrument on or off, press the On/Off switch on the rear panel: 
 | = On   = Off 

The EL406 performs a self-test.  

 If the test passes, the Main Menu will appear and the instrument is ready 
for use.  

 If the self-test fails, the EL406 will “chirp” and display an error code. Make 
sure nothing is obstructing the movement of the plate carrier and washer 
manifold and restart the instrument. If the error persists, look up the code 
in Appendix A: Error Codes. 
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Introducing the Keypad  

 This is a quick introduction to the keypad. Find complete instructions 
for using keypad beginning on page 66. 

The EL406 features a keypad and 2-line x 24-character LCD display. The main menu is 
represented here: 

 

Starting at the top of the keypad, note the main menu and the Soft-keys. Use the 
Soft-keys to make selections. To return to the main menu, press the Main Menu key. 

 RUN – to run a defined protocol. Use the Options key to select a protocol 
or enter its number. Review the list of pre-defined protocols on page 97. 

 WASH – to run a quick wash. Put a plate on the carrier, set the desired 
parameters and click Start to run a wash routine. Except when the 1536-
well hardware is installed and quick wash is not supported.  

 DISP – to run a Quick Dispense. Dispense options using the Peri-pump are 
offered first. Press Pump to dispense with one of the Syringe dispensers, if 
applicable.  

 Peri-pump Dispenser Quick Dispense options:  

 Press and hold the Prime and Purge keys to execute these actions 
for as long as you hold the key.  

 Set the dispense Volume using the arrow and number keys, put a 
plate on the carrier, and press Start. 

 First, make sure the CASS (#) matches the installed cassette type. If 
not, change the setting as described on page 50. 

EL406                              CASS (#) 
  RUN        WASH         DISP          

 LCD 

Soft-keys: 
Press a key 
to choose  
the matching 
menu 
option. 

Press Setup Menu to 
change settings. 

Use the arrow keys  
to move the cursor  
in the LCD display. 

Press Options to  
scroll through options 
or the alphabet. 

Press Shift+Options 
to scroll backward 
through options or  
the alphabet. 

Main Menu  

Cassette type 
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 Syringe Dispenser Quick Dispense options: When the dual Syringe 
dispensers are installed press Pump at the quick dispense menu to 
toggle through the list of dispensers, Syringe A, Syringe B, and the Peri-
pump.  

 Press the Prime key to prime the tubing with 5000 µL of fluid. 

  Set the dispense Volume using the arrow and number keys, put a 
plate on the carrier, and press Start. 

 PLATE – The default plate type for Quick Wash and Dispense is 96-well. 
Select PLATE to change it, then scroll to the correct type. Learn more 
beginning on page 54. 

          Setup Menu: press this key to access the instrument’s general 
settings and the settings for each of the devices and the BioStack; to run 
system tests or the Adjust Utility. Turn to page 79 for details. 

  The Options key (and sometimes the arrow keys) scroll 
through the available options or settings for the current focus. 
Shift+Options reverses the scrolling direction.  

  : Select the arrow key in a menu to reveal more options. 

 Define:  leads to the protocol creation and editing mode, which is described 
on page 66. 

Stopping an Operation    

Using the  Description 

Keypad 

 Press the STOP key. 

LHC 
 Click the STOP button. 

Both actions require confirmation. You will be prompted to Stop or Resume. Press 
Stop again to cancel the currently running program. Otherwise, choose Resume. 

 Important!  Settings defined onboard the instrument 
must match its physically installed components. Be sure 
the washer’s manifold, 96-Tube, 128-Tube, or 192-Tube, 
and the Peri-pump’s cassette (CASS), 1 µL, 5 µL, or 10 µL, 
are properly defined before operation.  Operating the 
washer with the wrong setting may damage the manifold 
and void your warranty.   

 Setup 
 Menu
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Changing the Peri-Pump Dispense Cassette  

Find instructions for physically installing the cassette in the Installation chapter or 
the cassette packaging.  

Change the Cassette Setting  
It is critical that the instrument’s cassette setting matches the installed cassette 
type. The instrument’s setting is displayed in the main menu: CASS(#). 

Using the  Description 

Keypad 1.  Press Setup Menu. 

2.  Select PERI. 

3.  Select CASS. 

4.  Select the matching setting. 

5.  Press Main Menu to verify the change. 

LHC 1. Select Tools> Instrument Utilities. 

2. Select the Peri-pump tab. 

3.   Under Cassette Type, select the matching button. 

4.   Click Send.   

 Setup
 Menu

 

 Take note of the Cassette Requirement Mode feature. It lets you require a 
specific cassette when defining a dispense step and offers three methods of handling a 
conflict with that requirement. When the cassette type setting does not match the 
required cassette, this feature provides a way to quickly manage or correct the conflict, 
including changing the cassette setting on-the-fly. See page 81. 

Removing the Tubing Cassette 

 Review the Tubing Cassette Diagram in the Installation chapter, if 
necessary, to recognize the names of the components. 

1. Lift the Tube Organizer out of the fluid vessel. 

2. Open the Pump Cover, moving it away from the pump. 

3. Grasp with your left hand the Tube Tensioner attached to the pump’s 
stainless steel plate as you use your right hand to release the latch on the right 
side of the pump (next to the caution symbol).  

4. Still holding the tensioner with one hand, use the other hand to remove the 
Center Holder from its slot on the underside of the pump.  

5. Hold both the Tube Tensioner and Center Holder in one hand while you slide 
the Tip Holder out of the dispense arm. 0. 
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WASH: Quick Wash (Keypad only) 

Select WASH at the main menu to perform a quick wash. Alternatively, create a 
wash protocol as described on page 66. 

(96)    CYC:003    VOL:0300 ul 
PRIME  CYCLE    PLATE  ASP-Z  

Top line 
Second line 

          Soft-keys 

 Quick Wash is not an option for 1536-well plates. You must define a 
protocol. 

The EL406 saves the parameters that were last used to run a quick wash. They are 
displayed in the top-line of the LCD: 

 (96) is the plate type. Select PLATE to change it. 

 CYC:003 is the number of wash cycles (one aspirate and dispense step per 
cycle). Select CYCLE to change the number of cycles to perform. 

 VOL:0300 ul shows the dispense volume per well in microliters.  

 To change the dispense volume, use the arrow keys to move the 
cursor to the desired number position. The cursor appears to underline a 
number: 0010. When the correct position is selected, use the number pad to 
enter the desired value. 

 PRIME to flush the tubing to remove air bubbles with the desired volume.  

 PLATE lets you change the selected plate type and define a partial plate run, if 
applicable. See page 67. 

 ASP-Z lets you change the height of the aspiration manifold above the wells. 

 When the desired values are entered, put a plate on the carrier and press Start 
to run the routine. Up to 10 quick wash routines are saved. When the maximum 
number has been defined, the newest replaces the oldest. Use the Options key to scroll 
the quick wash routines to select one. 

If the quick wash routines are too limited to satisfy your assay requirements, use the 
LHC or the keypad to define a wash protocol.  All wash parameters can be defined 
during protocol creation, including those recommended for cell washing, for example. 
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DISP: Quick Dispense (Keypad only) 

Select DISP at the main menu to perform a quick dispense.  

(96)   CASS(5)    VOL:0010 uL 
PRIME  PURGE   PLATE   PUMP  

Top line 
Second line 

          Soft-keys 

The EL406 displays the last Quick Dispense that was run. With up to 3 dispensers 
available, you may first need to select the device: 

 PUMP (when applicable) toggles through the dispensers, Peri-pump (displayed 
above), Syringe dispenser A and B. This option is not available when the 
Syringe dispenser module is not installed. 

 (96) is the plate type. Select PLATE to change it. 

 CASS(#) is the type of cassette. Make sure it matches the currently installed 
cassette.  Learn how to change the setting on page 50. Refer to the EL406 
Installation Guide or the cassette packaging for instructions on physically 
changing the cassette.  

 SYR-A or SYR-B identifies the Syringe dispenser to be used in the Quick 
Dispense. Press PUMP to change the device selected. The cassette type (CASS) 
is displayed when the Peri-pump dispenser is selected. 

 VOL:0010 uL shows the dispense volume  (not the priming volume) per well 
in microliters (µL).  

 To change the dispense volume, use the arrow keys to move the 
cursor to the desired number position. The cursor appears to underline a 
number: 0010. When the correct position is selected, use the number pad to 
enter the desired value. 

 Prime: At the Peri-pump dispense screen, press and hold down prime key to 
prime the tubing. Fluid flows into the prime trough for as long as you press the 
key. For the Syringe dispensers, PRIME pumps 5000 µL each time it is selected.   

 Purge: At the Peri-pump dispense screen, press and hold the Soft-key to purge 
the tubing. Fluid is pumped back into the supply vessel as long as you press 
the key. 

 Plate: lets you to change the plate type and plate map or, more accurately, the 
columns of the plate to dispense to. Learn how on page 67. 

 When the desired values are entered, put a plate on the carrier and press Start 
to run the routine. Up to 10 quick dispense routines are saved for each dispenser. 
When the maximum number has been defined, the newest replaces the oldest. When 
the desired dispenser is displayed onscreen, press the Options key to scroll through 
the quick routines to select one. 
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RUN: Running Pre-Defined Protocols 

BioTek provides numerous pre-defined protocols for maintaining the instrument in top 
condition and for qualifying its performance. Review the list of pre-defined protocols 
on page 97. 

To run a pre-defined protocol: 

Using the  Description 

Keypad 1.  At the main menu, press RUN. 

2.  Press Options to scroll to the desired protocol or use the 
arrow and number keys to enter its number. 

3.  Press ENTER and follow the prompts. 

LHC  
 

 

Important: 

1. Select Open and locate the EL406 folder. 

2.  Open the EL406 folder to access the Maintenance folder. 

3. Select the desired protocol. 

Be sure to customize the pre-defined protocols as described on 
page 75. 

 

Creating Protocols: Washing, Aspirating and Dispensing Fluid 

In addition to the quick routines available from the keypad’s main menu, you can 
define and run protocols. Protocols offer more parameters, giving you the ability to 
fine-tune instrument performance, and perform more complex processing.  

Keypad Control 

  Instructions for creating or modifying protocols using the keypad, as well as a 
map or grid showing the available options, can be found beginning on page 66.  

Liquid Handling Control™ (LHC) Software 

  Launch the LHC software to create or modify protocols, wash plates, dispense 
fluid and so on.  Turn to page 72 for an introduction to the LHC workspace. 

  Select Help>Help Topics to learn about the LHC.  
       Watch the Help>Tutorials for an interactive learning experience. 
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About Plate Types and Processing Patterns  

With the required equipment installed, e.g. wash manifolds, the EL406 can process 96-, 
384-, and 1536-well Plate Types.  

The default parameters for wash and dispense steps represent the optimal positioning 
of the hardware for the plate type. The aspirate and dispense heights and horizontal 
positions can be adjusted when necessary for special situations. 

Processing Patterns 

When using a 96-tube manifold to process a 96-well plate, all wells are processed 
simultaneously. But this is the only one-to-one relationship available with the EL406's 
hardware. To process 384- and 1536-well plates a processing pattern is needed. One 
advantage to this arrangement is the ability to process the plate partially, leaving some 
portions of the plate untouched. The processing pattern is determined by the 
hardware's footprint. 

You can select which sectors, or columns to wash or dispense to, and which to skip. 
The graphic representation of the sectors/columns makes it easy to pick and choose 
which ones to process. Plate maps can be changed on-the-fly for both quick routines 
and protocols. 

Plate Types Table 

  Compatible Washers  
(# of Sectors) 

Compatible Dispensers  

Plate 
Type 

Columns 
x Rows 

96-
tube 

192-
tube 

128-
tube 

8-tips 
(Peri) 

16-
tube 

32-
tube 

96-well 12x8 √ (0) N/A N/A √ √ N/A 

384-well 24x16 √ (4) √ (2) N/A √ √ N/A 

1536-well 48x32 N/A N/A √ (12) √ N/A √ 

N/A = Not applicable, the plate type is not supported by the device. 

96-tube wash pattern for 384-well plate 

 

To process a partial plate, you must select the sector or sectors you want to process. 
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128-tube wash pattern for 1536-well plate 

 

The 128-tube aspirate manifold processes 1536-well plates in 12 sectors. When you 
select the columns to process for a partial plate, they correspond to these sectors. 

192-tube wash pattern for 384-well plate 

 

To process a partial plate, you must select the sector you want to process. 

 

How to change the plate type and plate map: 
 Keypad control, see page 67. 

 LHC control, see page 73. 
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Operating with the BioStack 

If you purchased BioTek’s BioStack™ Microplate Stacker to operate with the EL406, 
here is some important information about running it: 

LHC Control: 

 The LHC lets you design protocols that integrate BioStack controls with EL406 
steps. You must keep both instruments connected to the computer during 
operation to run these protocols.  

 In the LHC, select Help>Tutorials, click Sections in the toolbar for a drop-
down menu, select Controlling the Bio-Stack with LHC. It only takes a 
couple minutes to complete this interactive demo. It is a great way to learn 
about the special BioStack features offered with the LHC. 

Keypad Control: 

 The EL406’s Quick Wash and Quick Dispense options do not function with the 
BioStack. You must create and RUN your own protocols to process plates using 
the BioStack. 

 You can use the Quick Wash and Quick Dispense prime options. This is 
recommended especially prior to processing plates, to remove air from the 
tubing. Review the important information in the Maintenance chapter of 
operator’s manual about running the pre-defined maintenance protocols when 
the BioStack is under keypad control. 

Install and configure the BioStack: 

1.   Set up the BioStack according to instructions in your BioStack Operator’s 
Manual to interact with the EL406. Connect it to the: 

 Host computer (PC) when using the LHC to control the EL406. 

 Instrument when using the keypad to control the EL406.  

2.   Install the BioStack™ PC Control Software shipped with the stacker to 
control the BioStack using the LHC. 

3.   Align the BioStack’s gripper with the EL406’s plate carrier:  

Using the Description 

Keypad 1.  Press Setup Menu. 

2.  Select  

3.  Select BIOSTK. 

4.  Select ALIGN. 

Find instructions in your BioStack Operator’s Manual. 

LHC 1. Select Tools> BioStack Utilities. 

2. Use the Alignment Utility. 

Click the Help button for detailed instructions. 

 Setup
 Menu
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4.  Define the BioStack operating mode: 

 Option Description 

Keypad 
Using the 
keypad to 
control the 
BioStack; 
stand alone 
operation 

1.  Press Setup Menu. 

2.  Select  

3.  Select BIOSTK. 

4.  Select CONF. 

5.  Select BIOSTACK. 

LHC 

 

Important: When using LHC to control the EL406 and the BioStack:  

5.  Select MANUAL, instead of BIOSTACK. 

 Setup
 Menu

 To Restack or not? Yes: to keep plates in the same order. No: to 
save time when the plate sequence is unimportant. 

5.  Verify the setup: perform a protocol with 1 or 2 plates specified in the LHC or 
placed in the input stack when under keypad control.  

 At the start of the day, power up the BioStack first, and then the EL406. Lift the 
BioStack’s claw/gripper before turning it on. 
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Optimize Performance 

Here are some guidelines to ensure optimal performance and to prevent potential 
problems.  

Keep devices clean and tubing wet 

The most critical factor for ensuring optimal performance is to adhere to the maintenance 
schedule described in the Maintenance chapter. Enable AutoPrime to keep tubes from 
clogging.  

Release the tension on the Dispense Cassette 

When not in use, BioTek recommends releasing the tension on the cassette. This 
practice extends its life, preserving the tubing’s integrity. To release the tension: 

  

 

Cassette Rest 

Tube Tensioner 

Pump Cover 

1 Open the Pump Cover. 

2 Pull out the Cassette Rest.  

3 Release the spring-loaded latch that holds in place the Tube Tensioner 
attached to the pump’s stainless steel plate. It will rest against the 
cassette rest. 
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Recommended volumes for fully priming EL406 devices 

One of the best habits to develop is regular and frequent priming of the tubing and 
devices to keep them in a wetted state, free from clogs and air bubbles. 

Washer 

To fully prime the wash manifold before processing plates, use these prime 
volumes: 

When tubes are empty When changing fluid 

Prime Volume Low Flow Path Prime Volume Low Flow Path With Buffer 
Switching module 750 mL 50 mL 900 mL 100 mL 

     

Prime Volume Low Flow Path Prime Volume Low Flow Path Without Buffer 
Switching module 

360 mL 50 mL 400 mL 100 mL 

 These prime values do not apply to 1536-well hardware which uses the 
Syringe module to dispense fluid. 

Peri-pump dispenser 

At the start of the day: 

Prime the tubing to prepare for a dispense run. 

1 Reload the cassette and fill the supply vessel: 

 When dispensing solutions not effected by water, simply prime with the 
dispense fluid. 

 When dispensing protein solutions, first prime the tubing with a 
buffered saline solution to remove any traces of water in the tubing, 
then, prime with the dispense fluid. 

2 Hold the Prime button on the keypad until fluid flows into the priming 
trough and all visible air bubbles have been removed.0 

At the end of the day: 

Purge the tubing to reclaim the dispense fluid, then Prime the tubing to flush it 
clean. 

1 Hold the Purge button on the keypad until the tubing appears empty. 

2 Replace the supply vessel with the appropriate rinse fluid: 

 When dispensing water soluble solutions, use DI water. 
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 When dispensing protein solutions, first prime the tubing with a 
buffered saline solution to remove protein particles, then, prime with DI 
water. 

3 Hold the Prime button on the keypad:0 

 1 µL cassette = 5 seconds 

 5 µL cassette = 7 seconds 

 10 µL cassette = 10 seconds. 

Syringe dispensers 

The pre-defined maintenance protocols for the syringe dispensers fully prime 
the system, pumping 40 mL through the tubing and pump: 

 S-DAY_RINSE_A&B – to fully prime both Syringe systems 

 S-DAY_RINSE – defined for Syringe A only 

Modify these protocols as needed when changing fluids and performing other 
tasks. For example, edit S-DAY_RINSE to use Syringe B or add another prime 
cycle when changing fluids to make sure all previously used fluid is expelled 
and replaced with the new liquid. 

  The approximate dead volume for each Syringe dispenser system is 12 mL. 
Generally, three times the dead volume completely primes the system. When using 
precious fluids, e.g., expensive reagents, you can change the prime parameters: reduce 
the defined volume or number of cycles specified in the pre-defined protocols. 
Alternatively, create your own protocols. 

 

Best Practices for all EL406 Devices 

 Fill the supply bottles with sufficient fluid.  Make sure the supply tube is in 
the liquid. 

 Make sure the bottles, solutions, and tubing are clean and do not contain 
any particles or mold. Water and dye solutions that are recycled over 
several days will grow algae, bacteria, molds, or other undesirable 
organisms. 

 Prime before dispensing. Priming the tubing is the most critical factor in 
assuring optimal performance.  

 Empty the waste bottles and firmly seat the bottles’ caps and quick release 
connectors. To make sure fluid does not back up into the vacuum pump 
during operation keep the waste sensor cable installed and the waste 
detection sensor activated (see Sensors Enabled on page 86). If fluid 
collects in the overflow bottle, thoroughly rinse the level switch assembly 
and bottle. 

BioTek Instruments, Inc. 



  |  61 
 

 Put microplates on the carrier with position well A1 in the left rear corner 
as you face the instrument, and firmly seat the plate in the carrier.  

 Rinse and soak the fluid path, clean and replace components, and 
decontaminate the instrument as described in the Maintenance chapter. 

 

Before using the Washer  

 The supply tube should extend to the bottom of the bottle and be cut at 
the end (see drawing to the right) to ensure free flow of liquid at the 
bottom of the supply bottle. 

 

 Check the external tubing connections for kinks and clogs. 

 To avoid creating air bubbles every time the supply bottle is filled, make a 
mark halfway down the bottle and refill when the fluid level has dropped 
to that point. Unscrew the cap and let it hang over the side just enough to 
avoid emptying the inside tube and enough to refill the bottle. 

Before using the Peri-pump 

 For top performance and to preserve precious fluids, Purge the fluid at the 
end of a dispense run and Prime the tubing before dispensing. The tubing 
is permeable to air. When 20 minutes or more have elapsed between 
dispenses, or less than 20 minutes when using 1 µL cassettes, it is important 
to thoroughly prime the tubing before dispensing. 

 Use the priming trough insert to capture expensive reagents for reuse. 
The Peri-pump’s insert can hold up to 12 mL. 

 Filter the dispense fluid to 50 microns before dispensing with the 1 µL 
cassettes. The dispense tips are very small. Filtering the fluid helps prevent 
clogging.  

 Select the right cassette for the job: match your desired dispense 
volume to the recommended cassette. The smallest recommended volume 
for a cassette type is one aliquot. An aliquot matches the cassette type, 1 µL 
for the 1 µL cassette, 5 µL for the 5 µL cassette, and 10 µL for 10 µL cassette. 

 Dedicate cassettes for specific fluids or applications. Reserving specific 
cassettes for specific uses avoids contamination. 

 When the dispenser is idle, release the Tube Tensioner element of the 
cassette from its place on the pump to minimize unnecessary stretching of 
the tubing. This is especially true for the 1 µL tubing. The best practice is to 
unload the 1 µL cassette when dispensing is completed.  

 To more quickly dispense to 384- and 1536-well plates, use the Instrument 
Utilities to change the Dispense Pattern to Row. If precision is more 
important than speed, keep the pattern set to Column.  
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Before using the Syringe Dispenser 

 Sufficiently prime the Syringe dispenser to ensure precision and accuracy: 
increase the number of prime cycles to adequately remove all air 
bubbles from the tubing. 

 Use the priming trough insert to capture expensive reagents for reuse. 
Each Syringe dispenser’s insert can hold up to 6 ½ mL. 

Optimize protocols to improve evacuation 

When a wash protocol leaves too much residual fluid in the wells, optimize the 
protocol with these recommendations: 

 Add a secondary aspiration to the aspirate steps, including Final Aspirate, 

 Decrease the aspirate Travel Rate, 

 Add a Delay to the aspirate step and/or Final Aspirate, 

 Lower the aspirate height (Z-axis position). 

Recommendations for 1536-well Hardware 

When using the 128-tube aspirate manifold and the 32-tube Syringe dispenser 
manifolds, try these recommendations to achieve top performance. Experiment 
with the parameters and settings to determine the optimal values for your assays. 

 High-throughput - to speed up processing try these settings: 

Plate Clear Height 90 steps 

Aspirate Travel Rate 6 CW 

Dispense Flow Rate 5 

Use the Adjust Utility to test the Plate Clear Height before applying 

 Improve Accuracy: set the Dispense Flow Rate to 2.  

 Improve evacuation: for the smallest residuals use a standard Aspirate 
Travel Rate, not a CW (cell wash) rate. 

 Increase residuals: to retain fluid in the wells, increase the aspirate height, 
Z Position. For example, in our testing, 56 steps, instead of 40, left 3 µL DI 
water in each well. 

 Remember to keep the dispense manifolds wet when not in use: soak 
the tubes in the priming trough inserts with AutoPrime, for example.  
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Cell Wash Assays 

 Find instructions for defining a cell wash protocol below. 

Low-flow Fluid Path 

The EL406 supports cell-based assays that require the addition and removal of buffer 
solution without disrupting the cells in the wells of the microplate. Cells are often 
dislodged when fluid is dispensed at too high a pressure and lost during subsequent 
aspiration of the fluid from the well unless counter measures are taken. The EL406 is 
equipped with a low-flow fluid path that provides a "cell wash" alternative for cell-
based assays. 

 

The low-flow tubing is used during a wash step when the Flow Rate is set to 1 or 2. It 
dispenses fluid to the wells slowly enough to avoid damaging the cells. Note that the 
low flow line is always open, i.e. some fluid flows through the tubing during normal 
dispenses. For this reason, priming the low flow tubing is recommended for all Prime 
steps.   
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Additional Techniques  

Delay Aspiration: Also critical to cell-based assays is delaying aspiration to allow the 
slower dispense process to finish before beginning fluid removal from the well. This 
option, offered as part of the dispense step, is called Delay Start of Vacuum or 
Vacuum Delay Vol on the keypad. 

Adjust the Aspirate Travel Rate and Aspirate Height: when defining the aspirate step 
select one of the specially designed travel rates that minimize turbulence in the wells. 
Also consider increasing the aspirate height to leave more residual fluid in the wells to 
protect the cell layer. 

Adjust the Dispense Flow Rate, Height and Position: when defining the dispense 
step be sure to select one of the special Flow Rates that trigger use of the low-flow 
tubing, 1 or 2 CW. Also consider adjusting the dispense height and position to aim the 
fluid at the side of the well to further minimize turbulence.  

 Use the Adjust Utility to determine the optimal height and position of 
the tubes when addressing the wells. 

Define a Cell Wash Protocol 

Adjust the volumes recommended in this procedure to meet your specific needs. Also 
consider changing the dispense height and position to aim fluid at the side of the well 
to reduce turbulence and change the aspirate height to increase the amount of residual 
fluid left in the well to protect the cell layer. 

1  Create a new protocol. 

2 Add a Prime step, especially when the lines are empty or when changing 
fluids. Recommended volumes in mL: 

Regular Prime Changing Fluids  
Prime Low Flow Prime  Low Flow 

With Buffer 
Switching  

400 300 600 400 

No Buffer 
Switching 

200 150 300 200 

3 Add a Wash step and define it as you normally would, except with these 
special parameters: 

 Set the Aspiration Travel Rate to 6 CW and the Delay to 0. 

 Set the Dispense Flow Rate to 1 or 2. 

 When using the keypad set the Vacuum Delay Vol. 
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 When using the LHC: click the Dispense Advanced Options link and set 
the Delay start of Vacuum until sufficient fluid has been dispensed. 
For small dispense volumes, BioTek recommends setting the delay 
volume to equal your dispense volume. 

 Optionally, change the dispense height and position to aim fluid at the 
side of the wells to reduce turbulence and change the aspirate height 
to increase the amount of residual fluid left in the well to protect the 
cell layer.  
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Keypad Control of the EL406 

This section provides a detailed description of how to use the keypad.  

Create or Edit a Protocol 

At the main menu: 

1 Select  for more options. 

2 Select DEFINE and then, CREATE or EDIT. 

 CREATE EDIT 

3. Name the protocol (see page 69) 
and select the Plate Type. Press 
the Soft-key to scroll through 
options. Press Enter after making 
selections to proceed. 

Select the protocol to edit: enter its 
number or use the Options key to 
scroll through the stored protocols 
to select one. Then, you can edit 
the name and plate type, if 
desired. Press Enter to proceed.  

4. Select ADD to define the first step: 
then, select the device to use or 
SHAKE to mix or soak the plate’s 
contents. 

EDIT the first step or press the 
Options key to scroll to the step 
you want to change in a multi-step 
protocol. 

Select the device to use: 

 WASHR  To use the wash manifold to wash, dispense or aspirate fluid 
or to run AutoClean. 

 PERIP To dispense fluid using the Peri-pump dispenser. 

 SYRNG To dispense fluid using one or both of the Syringe 
dispensers, A or B. 

 SHAKE To mix the contents of the plate and/or soak or steep the 
fluids for a specified time period. 

 
5. Select the action you want the device to perform and then define the 

step’s parameters.  Press Enter to proceed. 

6.  Keep Added Step? Save Step Changes?  

 Select Yes or No using the Soft-keys to save or discard your inputs for 
the current step.   

*  Press Main Menu to end the session at any time. Then, select RUN and 
select the protocol to run it.  

 See a description of the parameters for each step and their default 
values in the tables beginning on page 90. 
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Define the Plate Type and Plate Map (or Partial Plate) 

 Learn about the supported plate types and processing patterns on 
page 54. 

The EL406, depending on the currently installed hardware, can process 96-well, 
384-well, and 1536-well plate types. Washing and dispensing to a partial plate is 
limited to choosing the sectors to be processed when washing a 386- or 1536-well 
plate and the columns to dispense to when dispensing to any plate type. This 
requires defining a “plate map.” By default, the whole plate is processed.  

Quick Routines: Quick Wash and Quick Dispense 

 When defining a quick routine, select Plate with the Soft-key to set the plate 
type, and to define the plate map.    

Protocols: Wash and Dispense 

 When creating or editing a protocol, set the Plate Type after naming the 
protocol. Press the Soft-key to scroll to the correct plate type.  

 To define the plate map, or more precisely, the columns or sectors to wash or 
dispense to:    

 Wash step: select OPTS and then FORM. First choose the processing mode 
Sector or Plate. Then, you will proceed to the plate map screen. 

 Dispense step: press Enter to proceed to the plate map screen.  

To change the plate type: 

 Repeatedly press the Soft-key under the plate type (in the right corner of 
the display) to scroll through the available options. Hold the Shift key while 
pressing the button to reverse direction. 

                    
 —                   

Column: 02 . . 12                96 

 
              

The two-line display changes to show a representation of the current plate 
type’s columns or sectors in the top line. The display shows each column as a 
filled or empty square; empty columns/sectors will not be dispensed to or 
washed. For the current plate type, shown in the right corner, the left corner 
shows the selection range, beginning with the currently selected 
column/sector. (In the top example, column 2 is currently selected.) 

EL406 Washer Dispenser 



68  | Chapter 3: Operation 

                    
—                    
Sector: 01 . . 04                386 

 
              

  Press the Clear button once to empty all the columns. Press it again to fill all the 
columns. This is useful when you want to dispense to only a couple columns. 

 

 

 

 

                      
—                      

Columns: 01 . . 24               1536  

 
               

 1536-well plates require two screens to show all 48 columns. Select 
the  key to toggle between the two screens to select the columns to 
dispense to. 

To change the plate map (selected columns): 

1.  Use the arrow keys to move the cursor to the column/sector you want to 
change. The cursor underlines the currently selected column and its number is 
shown in the display. (In the top example, column 2 is currently selected.) 

2. Press the Options key to toggle between filling the column or not. When the 
image of the column is filled it will be dispensed to. Conversely, when the 
column image is blank or unfilled, the column will not be dispensed to. 

3. Press Enter to save the settings and continue. 0. 
 

Common tasks using the keypad 

This section contains instructions for commonly performed tasks. 

How to: 

 Name a protocol  

 Copy a protocol 
 Use AutoClean to clean the wash manifold 

 Add a Secondary Aspiration to a wash cycle 
Also see: 

 Create or edit a protocol: see page 66. 

 Run a pre-defined protocol: see page 53. 

 Perform a Quick Wash or Quick Dispense: see page 51. 
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How to name a protocol 

 
NAME: 

- % & _ 

 

At the Name screen when you are creating or editing a protocol, you can enter up 
to 16 alphanumeric characters to name the protocol: 

 Press Shift + the number key for A-H, or scroll through the alphabet with 
the Options key for A-Z. 

 Press Shift + Options to reverse direction.   

 Use the arrow keys ◄ ► on either side of the Options key to move the 
cursor within the display.  

 Press its Soft-key to add one of the four symbols (- % & _) in the display to 
the protocol name.  

 Press ENTER when you are finished to store the protocol name. 

 If the program name already exists, an Invalid Protocol Name 
message displays and you must enter a unique name. 

Copy a protocol 

>DEFINE>COPY 

You can save significant time creating protocols by copying one with similar 
parameters.  

1 Select  at the main menu. 

2 Select DEFINE and then, COPY. 

3 Select the protocol you want to copy: enter its number or use the Options key 
to scroll through the stored protocols, e.g. S-DECON. Press Enter to select it. 

4 Assign a unique name to the protocol, e.g. SB-DECON, and press ENTER. 

5 Select YES to copy. 

6 Select EDIT and make the needed changes. 

7 When all changes are made, select EXIT. 0 
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How to use AutoClean to clean the manifold 

>DEFINE>ADD or EDIT>WASHR>ACLEAN  

 Before running AutoClean, the EL406’s ultrasonic cleaner, review the safety 
information in the Maintenance chapter of the operator’s manual.  

To create an AutoClean protocol using the keypad: 

1 Select  at the main menu. 

2 Select DEFINE and then, CREATE. 

3 Name the protocol, e.g. ACLEAN. 

4 Press Enter past the plate type. 

5 Add a Prime step to fully prime the tubing with the cleaning fluid (water): 
WASHR>PRIME and define the parameters. Use the recommended volumes 
for fully priming the tubing on page 59. 

6 Add an AutoClean step: WASHR>ACLEAN and set the duration. 

7 Save the steps and select Exit. 0  

Fill the supply vessel with sufficient water or cleaning fluid before running the 
protocol. 

 1536-well hardware: The 128-tube aspirate manifold cannot completely evacuate 
the priming trough. When AutoClean is finished, you must manually remove the 
residual liquid using a paper towel or other method. Be sure to follow the 
manufacturer’s handling instructions for the cleaning fluid you are using. 

 32-tube dispense manifolds: Also see the Maintenance chapter for instructions to 
use AutoClean to clean the hard-to-clean dispense manifolds. 
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How to Add a Secondary Aspiration to a Wash Cycle 

When too much residual is left in the wells during a wash cycle, you can add a 
secondary aspiration to remove it. Secondary aspiration is recommended for 
optimizing performance. It is not available for 1536-well plates. 

1 Edit the Wash step or stand-alone Aspirate step: Define>Edit>select protocol, 
and if necessary press Options to scroll to the desired step. 

2 Select ASPIR and press Enter until Secondary Aspirate is offered. 

3 Select YES to perform a second or crosswise aspiration. 

4 Optionally, adjust the position of the manifold as it addresses the wells by 
changing the X–, Y-, or Z-Positions. 0 

To get hard-to-reach areas of certain types of wells, you may want to adjust the 
X- or Y- axes to better position the aspirate tubes. Or, you may want to lower 
the height by adjusting the Z-axis, to better evacuate fluid.  

 Run the Adjust Utility: To determine the precise positioning of the 
dispense and aspirate tubes.  

 Final Aspirate: For the most complete evacuation of the wells, consider adding a 
Secondary Aspirate to the Final Aspirate: Select OPTS>POST at the Wash Step 
Parameters menu and follow the prompts to enable the feature. 
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LHC Control of the EL406  

This section provides an introduction to the LHC workspace for controlling the EL406. 
More information is available in the LHC Help system.  

 

 Instrument Settings described on page 78 

 EL406 Steps described below 

 Protocol Definition described on the next page 

EL406 Steps 

Because the EL406 offers two or three devices in one instrument: a microplate washer, 
a peristaltic pump dispenser called the Peri-pump, and, optionally, dual Syringe 
dispensers, there are action buttons for each component. Click the action button and 
define the parameters to add that step to the protocol: 

 W- for steps performed by the Washer. 

 P- for steps performed by the Peri-pump dispenser. 

 S- for steps performed by one of the Syringe dispensers, when installed. 
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  Shake and soak are device-independent. 

Define a Protocol 

Review “Define a Protocol” in the LHC's Help, if you haven’t already done so. 

In short: 

1 Click a button in the Add Step area.  

2 Define the parameters for the step in the dialog that opens. 

3 Continue adding steps, if desired. 

4 Save the file and/or click Run to execute the protocol. 

 Double-click a step in the protocol to open it for editing. 

      Highlight a step and press Delete to remove it. 

      Click and drag a step to change its sequence order. 
 

 Learn details of each action step in the LHC’s Help: select Help>Help 
Topics 

Run a protocol: 

 

After defining the protocol steps, make sure the device is properly prepared, e.g., 
supply bottle is filled and connected. Put the plate on the carrier and click Run when 
you're ready. 

Define Your Startup Preferences 

You can save enormous time creating protocols by following these steps to define a 
New Protocol template and use it at startup. 

Create a protocol template 

1  Click the New button or select File>New.  

2 Click Name. Select the instrument if you have more than one, and define its 
Port and Settings. 

3 Optionally, select the Plate Type, fill in the text fields, and add any steps that 
you want all new protocols to include. 

4  Click Save and assign a unique name, e.g., Template.LHC. 

5 Select Tools>Preferences>New Protocol. 

6  Select the button for Protocol selected below to use as a template. 

EL406 Washer Dispenser 



74  | Chapter 3: Operation 

7 Click selected and select the protocol you created as a template. 

Define startup behavior: 

8 After completing the steps above, select the Startup Options tab. 

9 Select the button for New Protocol. 

10 Click OK to save your new preferences. 
 

Pre-Defined Protocols 

BioTek provides pre-defined protocols for maintenance routines, quality control, and 
general samples for common applications like serial dilutions. Review a listing with 
brief descriptions of the Pre-Defined Protocols beginning on page 97. 

Typically, you must Customize the Pre-Defined Protocols (see below) to match 
your instrument configuration and to meet your assay requirements. 

Instrument Settings: In addition to action steps, every protocol file contains 
instrument settings (described on page 78), including COM port, manifold type, and so 
on. Edit the protocol to match your instrument's COM Port and other configuration 
details:  

 Power Users: If you create protocols for multiple instruments or for other 
LHC users, read this more detailed description of how the EL406 validates a 
protocol to be run on a specific instrument. 

 Recommended: After making changes to a pre-defined protocol, 
select File>Save As and give it a unique name. This practice 
preserves the protocol in the case of a future upgrade. 

File Location 

The EL406 Interface Software (IS) installs the protocols in the Windows Common 
Applications Data Folder: 

 Windows® XP, 2000: C:\Documents and Settings\All Users\Application 
Data\ 

 Windows® Vista™: C:\ProgramData\ 

The file location path continues: 

[CommonAppDataFolder]\BioTek\Liquid Handling Control\Protocols\EL406 

Three folders are provided: 

 \Maintenance: the recommended daily and periodic maintenance routines; 

 \QC: some of the quality control or performance verification procedures; 

 \Samples: examples of common applications, including washing 96- and 
384-well plates, performing serial dilutions, and a cell wash protocol. 
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Customize the Pre-Defined Protocols 

BioTek provides pre-defined EL406 protocols for maintenance routines and quality 
control tests. You can quickly customize the protocols for regular use.  

With the EL406 connected to and communicating with the host computer: 

1  Click the Open button, locate the EL406 folder and click Open.  

2 Open the Maintenance or other folder and select the desired protocol. 

3   Change the COM port if necessary: click the Port link and use the drop-
down list to select the port. 

4   Click the Settings link, which opens the Instrument Settings dialog. 

5 Under Get settings from: click the instrument link.  

6   Click Validate.  

A "Validation successful" message is displayed unless the protocol cannot be 
run on your instrument.  

7   Save the protocol. 

 

Maintenance Protocols for the EL406 

Regularly running maintenance protocols is required to keep the instrument in top 
condition.  

Unless you have changed the file location: 

1. Click the Open button on the toolbar and locate the EL406 folder. 

2. Open the EL406 folder to access the Maintenance folder. 

3. Select the desired protocol.  

About the Maintenance Protocols 

 

File names: The protocol file names mirror the LHC™ buttons. The prefix letter 
indicates the applicable device. For example, W-RINSE_&_SOAK is a daily routine for 
the washer component, and P-1UL_CASS_RINSE is designed for the Peri-pump.  

Some washer protocols are further distinguished with a number that represents the  
96- or 192-tube manifolds. Syringe dispenser (S-) protocols are defined for Syringe A 
only. Copy the protocol and modify it to perform the routine for Syringe B. 
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Upload-Download Protocols 

The LHC lets you transfer protocols from your computer to your instrument and back 
again.  

Limitation: Protocols must contain only instrument-supported action steps to qualify 
for download. That is, the protocol cannot contain any of the LHC provided steps like 
Delay and Loop (buttons in the left column of the Add Step box of the main view). 
And, a Protocol Name is required. 

 The instrument's main menu must be displayed for the LHC to 
communicate with it. 

1 Select Tools>Transfer Protocols. 

2 Make sure the desired protocols are displayed: check the Protocol Folder path 
for This computer. Refresh the list of protocols onboard the Instrument by 
clicking the Settings link. 

3 Highlight one or more protocols in a display box. (Hold the Ctrl or Shift key to 
simultaneously select multiple files.) 

4 Optionally, at the top left corner of the screen, choose to Disable Editing of 
transferred protocols to lock the protocols from editing or deleting when they 
are onboard the instrument.  

5 Click the applicable Upload or Download button. 0 

The LHC will confirm the transfer or prompt you for more information. When the 
transfer is complete, you can manipulate the files as you normally would in their new 
location. 
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LHC Protocols for the EL406 Explained 

Prerequisite 

This discussion of the EL406 protocols will be easier to follow if you are already 
familiar with the LHC. Read "Understanding the LHC." You can search for it after 
selecting Help>Help Topics.   

Protocol Files 

In addition to action steps with specific, user-defined parameters, each protocol file 
contains "Instrument Settings."  

 

Generally, especially when you are managing only one instrument, the recommended 
best practice is to match the Instrument Settings to your instrument. However, unless 
a step requires a specific component for successful completion, the LHC runs the 
protocol even when the settings do not match the physical configuration of the 
instrument.  

For example, a protocol whose Instrument Settings include Buffer Switching can be 
run by an instrument without the Buffer Switching module when none of the steps 
actually call for different buffer valves, i.e., all steps use the same buffer. 

Similarly, an EL406 that does not have the Syringe dispenser installed can run 
protocols with Instrument Settings that include the Syringe, as long as the protocol 
does not include any Syringe dispenser steps. 

This flexibility is useful when you are designing protocols for multiple instruments. It 
also makes it easier to design protocols when the computer is not connected to an 
instrument. And, it facilitates shipping Pre-Defined Protocols with the software. 

Validate versus Run 

  Validate checks the action steps against the protocol's Instrument 
Settings. 

 Run talks to the instrument to check the action steps against the 
instrument's onboard settings. 

Validate will catch errors when the Instrument Settings have been changed after the 
protocol steps have been defined and there is a mismatch. Run performs a similar 
validation before executing the protocol. Errors are not reported unless the steps 
cannot be performed.   
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Instrument Settings 

Click the  link in the main workspace to open the dialog. 

 

Identify the exact configuration of your EL406 
to ensure it can successfully perform the wash 
and dispense protocols created with the LHC. 

Get settings from: 

 Instrument: BioTek configures and tests 
the EL406 at the factory before shipping 
it. If you have not changed the 
instrument's onboard settings, you can 
safely click the instrument link to upload 
the correct settings from the instrument. 

 Settings file: If you have previously 
saved the instrument's settings to a file 
(using the option at the bottom of the 
screen), click this link to import them. 

 Configured with: 

Fill the checkboxes and buttons to select the 
currently installed manifolds and 
accessories: 

 

 Be sure to complete all the steps for Changing the Manifold, when 
applicable, as described in Appendix B. 

Save Settings File 

If you have multiple instruments or use one instrument in multiple configurations, you 
can create unique settings files for each configuration and save time when defining 
protocols for that configuration.  

Click the Save link and use Windows' file-saving dialog to create a .SET file based on 
the currently-selected parameters. Then use the settings file link under "Get settings 
from" to load the parameters. 
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EL406 Settings and Utilities 

BioTek configures the EL406’s internal basecode with the correct settings before it 
leaves the factory. You can review the settings at any time and alter them when 
necessary. For example, if you change a hardware component, like the wash manifold, 
you must update the instrument’s settings to match the hardware. You can also enable 
and disable sensors, AutoPrime, and perform other functions. 

Keypad LHC 

Use the keypad’s Setup Menu button to 
access the utilities and to change settings. 

Select Tools> Instrument Utilities to 
access utilities and to change settings.  

 

 Setup Menu (Keypad Only) 

Press the Setup Menu button in the middle of the keypad: 

WASH PERI SYR  TESTS ADJST  
(Adjust Utility) 

BIOSTK  AUTPRM SNSRS 
(Sensors) 

VACDIS  

Manifold 
type 

Purge Manifold 
type 

 Self Check Plate Type: 96, 
386, 1536 

CONF 
(Mode) 

 Interval 
 

VACUUM Vacuum 
Dissipation 

Plate clear 
height 

Cass type   CHecKSUM: 
UI, MC, 

BioStack 

Washer 
Aspir/Disp 

Axis: Man   POS: 
CARX  CARY 

ALIGN  Washer 

Volume, Rate, 
Buffer, 

Submerge  

WASTE Delay in 
seconds 

Park for 
shipping 

Prime    PeriPump   
First/Last col. 

Axis: Disp 
Pos: CarX/CarY 

VERIFY  Syringe A 

Volume, Rate, 
Submerge  

FLUID 
 

 

 Pattern: 
Row or 
Column 

   Syr-A/Syr-B 
First/Last col. 

Axis: Disp 
Pos: CarX  CarY 

  Syringe B 

Volume, Rate, 
Submerge  

FLOW  

 Mode: 
Prompt, 

Error, Set 

         

Washer Utilities and Settings  

Define your instrument’s configuration and other details for optimal operation. 
Also see AutoPrime and Sensors in this section. 

Manifold Selection 

Using the  Description 

Keypad 1.  Press Setup Menu. 

2.  Select WASH and then MAN. 

3.  Select the currently installed wash manifold by pressing its 
Soft-key: 96-, 192-, or 128-tube. 

LHC  1. Select Tools> Instrument Utilities. 

 Setup 
 Menu 

EL406 Washer Dispenser 



80  | Chapter 3: Operation 

 

 
 

2. Select the Washer tab. 

3. Under Manifold Selection, choose the button that represents 
the installed manifold. 

4. Click Send to send this setting to the EL406. 

Changing the Washer Manifold 

BioTek offers a second washer manifold as an accessory to the instrument. Follow 
the instructions provided in Appendix B to physically change the manifold and to 
reconfigure the instrument to function properly with the installed manifold. 

Plate Clearance Height 
To accommodate plates that are slightly taller than standard plates, use this setting 
to make sure the manifold tubes rise high enough above the plate to prevent 
crashes when the plate carrier moves. Default setting: 130 steps or 16.52 mm.  

First use the Adjust Utility to determine the correct setting. 

Using the  Description 

Keypad 1.  Press Setup Menu. 

2.  Select WASH and then CLRHT. 

3.  Enter the number of steps determined using the Adjust 
Utility. 

LHC  
 

 
 

1. Select Tools> Instrument Utilities. 

2. Select the Washer tab. 

3. Under Plate Clear Height, Enter the number of steps 
determined using the Adjust Utility. 

4. Click Send to send this setting to the EL406. 

1536-well hardware:  Lowering the Plate Clear Height to 90 steps for the 128-
tube aspirate manifold sped up processing in tests performed by BioTek. Use the 
Adjust Utility to verify this height is compatible with your plates. 

Position Manifold for Shipping  
Prior to packing up the EL406 for shipping, you must position the Washer to allow 
installation of the shipping bracket.  

Using the  Description 

Keypad 1.  Press Setup Menu. 

2.  Select WASH and then PARK. 

LHC  
 
 

1. Select Tools> Instrument Utilities. 

2. Select the Washer tab. 

3. Under Service Functions, click the shipping bracket link. 
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Peri-pump Utilities and Settings 

When using the keypad, the Setup Menu for the Peri-pump includes basic 
functionality like priming and changing the cassette setting; see page 50. 

Dispense Pattern 

When processing 384- and 1536-well plates, select the fill pattern: by column or by row. 
For these high-density plates, the 8-tip manifold must address the plate multiple times 
to fill it. Column-wise dispensing fills each column before moving to the next. Row-
wise dispensing fills the first 8 rows, then reverses direction to fill the next 8 rows, and 
so on. Choose row for faster throughput. Column is the default setting because it is 
more precise. Once it is defined, your Pattern preference will apply to all runs, Quick 
Dispenses and Protocols. 

Using the  Description 

Keypad 1.  Press Setup Menu. 

2.  Select PERI and then . 

3.  Select PATRN and then COL or ROW. 

LHC  
 

 
 

1. Select Tools> Instrument Utilities. 

2. Select the Peri-pump tab. 

3. Under Dispense Pattern, select by column or by row. 

4. Click the Send link. 

Cassette Requirement Mode 

CASSETTE TYPE:          ANY 
ANY    1ul      5ul     10ul   

          
When defining a Peri-pump dispense step, you can require a 

specif ic cassette type be used or not. 

When defining a Peri-pump dispense step, you can require a specific cassette type 
or allow any cassette type to be used. When a specific cassette type is required, the 
EL406 needs to know how to behave when the required cassette is not installed at 
runtime: 

 Prompt the user to confirm that the required cassette type is installed. This 
option provides the best protection against an unintentional mismatch. If the 
cassette type itself has been physically changed to match the protocol, but the 
instrument's setting has not been updated, it will update the EL406's setting 
upon confirmation. However, if the cassette has not been changed to match the 
protocol, users are given a chance to cancel the run, fix the error, and rerun the 
protocol.  
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 Return an Error code and stop processing. This option gives robotics 
programmers the ability to design and run unattended processing routines 
without fear of a message screen interrupting the operation.  

 Automatically Set the cassette type and continue the routine without notifying 
the user. This option changes the EL406's setting without a confirmation. This 
option is for advanced users only. 

 No action is taken when the cassette type setting matches the 
protocol's required cassette type. 

Using the  Description 

Keypad 1.  Press Setup Menu. 

2.  Select PERI and then . 

3.  Select MODE and then Prompt or Error or Set. 

LHC  
 

 
 

5. Select Tools> Instrument Utilities. 

6. Select the Peri-pump tab. 

7. Under Cassette Requirement Mode, select an option. 

8. Click the Send link. 

Syringe Dispenser Utilities and Settings  

Three models of dispense manifold are available for the EL406’s Syringe dispenser 
module. You must define your instrument’s configuration and other details for optimal 
operation.  

Manifold Selection 

Using the  Description 

Keypad 1.  Press Setup Menu. 

2.  Select SYR and then MAN. 

3.  Select the currently installed dispense manifold by pressing 
its Soft-key: 16, 32LB (large bore) or 32SB (small bore). 

LHC  
 

 
 

1. Select Tools> Instrument Utilities. 

2. Select the Syringe Dispenser tab. 

3. Under Dispenser Assembly, choose the button that 
represents the installed manifold. 

4. Click Send to send this setting to the EL406. 

The EL406 Interface Software (IS) is required to update the instrument with additional 
configuration data for the Syringe dispensers. You must be controlling the EL406 with 
the LHC software or obtain a copy of the EL406 IS Utility from BioTek’s customer 
resource center: https://customer.biotek.com.  
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Adjust Utility 

About the Adjust Utility  

The Adjust Utility is a tool for determining the precise positioning of the dispense and 
aspirate tubes when addressing the plate. Generally, the default positions function 
perfectly, but certain assays may be improved by repositioning the dispense or aspirate 
tubes. For example, to minimize cell damage, tubes can be positioned at the sides of the 
wells, rather than the center. Use the utility to identify the offsets required, then, enter 
these offsets when defining the wash or dispense step. 

The Adjust Utility puts the plate in its run position and lets you move the washer's 
manifold, the Peri-pump's tip holder or the Syringe dispenser manifolds step-by-step 
to the desired position. You can: 

 Raise or lower the tubes/dispense tips in the Z-axis to determine the desired 
dispense or aspirate height. BioTek has set the default position for each plate 
type based on optimal performance. 

Positioning the tubes in the X and Y axes occurs in relation to the center of the well and 
is accomplished by moving the plate carrier. The default position is the center of the 
well, 0 steps. Negative offsets are left and back of center; positive offsets are right and 
forward of center. 

 Move the carrier left or right in the X-axis.  

 Move the carrier forward and back in the Y-axis; only available for the washer 
manifold. 

Warning: The Adjust Utility does not have limits to protect you from making bad 
choices. It is possible to identify dispense positions that miss the wells, for example. If 
incorrect values are defined in the protocol, you'll have a big mess on your hands. 

How to use the Adjust Utility (Using the LHC) 

1 Select Tools>Instrument Utilities>General Settings.  

2 Click the Adjust Utility link. 

3 Click the Help button for guidance.  

How to use the Adjust Utility (Using the Keypad) 

1 Place a microplate on the carrier. 

2 Press the Setup Menu button. 

3 At the Setup menu, select  for more options and then select ADJST. 

4 Select the PLATE TYPE: 96, 384 or 1536 and press Enter. 

5 Select the device: Washer, Peri-pump, or one of the Syringes. 
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Washer 
 

Dispensers:  
Peri-Pump, Syringe A or Syringe B 

 

Aspirate Dispense First column Last column 

                       
MAN Manifold Z-axis 

(up/down) 
DISP Manifold Z-axis 

(up/down) 

CARX Plate carrier X-axis 
(left/right) 

CARX Plate carrier X-axis 
(left/right) 

CARY Plate carrier Y-axis 
(front/back) 

CARY Plate carrier Y-axis 
(front/back) 

6 After selecting the device, select a run position: ASPIR (aspiration), DISP 
(dispense), or FIRST COLUMN or LAST COLUMN. Only one position may be 
viewed at a time.  

7 At the AXIS screen, choose an axis, Z, X or Y. The top line of the display 
indicates which axis is active, and the offset position of that axis.  

8 Closely observe the position of the hardware. Press the ◄ (reverse) key to 
single-step the offset in a negative direction, and the ► (forward) key to 
single-step the offset in a positive direction.   

9 When the desired offset position is found, record the position number for 
later use when defining a wash, dispense, or aspirate step. 

10 To quit the Adjust Utility, press Main Menu. The carrier and manifolds 
return to their default positions. 

BioStack Settings and Utilities (Keypad only) 

Setup Menu >  > BIOSTACK 

From the Setup Menu, select BIOSTK to set the EL406 to operate with the Stacker: 

 CONF (Configuration): to set the mode to BioStack or Manual. 

 ALIGN (Alignment): to use the BioStack’s alignment utility to align the robot’s 
wrist to deliver and retrieve plates. 

 VERIFY (Verification): to test the accuracy of the BioStack-instrument interface.  

Refer to the BioStack Operator’s Manual for detailed instructions.  

 Note: When using the LHC to control the Stacker, set the 
configuration mode to Manual and use the Tools>BioStack Utilities 
menu options instead of the keypad. 

AutoPrime 

 Learn about AutoPrime™ and how to enable it on page 88.  
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Sensors  

The EL406 is equipped with four sensors to facilitate operation and prevent problems: 

 Vacuum Detection: verifies sufficient vacuum to function properly. 

 Waste Detection: monitors fluid level in waste bottles before beginning a 
run. Make sure the waste sensor cable is plugged into the correct port. 

 Fluid Detection: verifies sufficient fluid level to begin and at completion of 
the run. Washer must be primed to fill the tubes prior to a run. An error at 
the end of the run indicates an insufficient volume of fluid was dispensed. 

 Flow Detection: monitors fluid flow during the run. Issues a warning 
when the pump is interrupted. An error indicates a problem with the 
pump. 

Using the  Description 

Keypad 1.  Press Setup Menu and select  twice. 

2.  Select SNSRS. 

3.  Enable or disable each sensor individually: VAC, WASTE, 
FLUID, and FLOW. 

LHC  
 

 
 

1. Select Tools> Instrument Utilities. 

2. On the General Settings tab, fill or empty the checkboxes to 
enable or disable Vacuum and Waste detection. Click the 
Send link to execute a change. 

3. Select the Washer tab for Fluid and Flow detection. Click 
the Send link to execute a change. 

When the sensors are triggered, the LHC or the keypad will display an explicit 
message describing the failure or required action.  

 BioTek recommends keeping the detection systems activated. One 
exception is when running very low density fluids like alcohol. If 
doing so causes errors, deactivate the Fluid sensor while using 
these types of fluids. 

Vacuum Dissipation 

About Vacuum Dissipation Delay: Some equipment requires a delay at the end of a 
run to allow air into the fluid containers to prevent the vacuum pump from 
overworking. A delay of 1 second/liter has proven to be reliable in preventing certain 
pumps from blowing an auxiliary 5-amp fuse (PN 46055). When necessary, specify a 
delay of 10 seconds when using a 10-liter bottle, 20 seconds when using a 20-liter 
bottle, and so on. 

Delay: 5 second default value; valid range is 0-50 seconds.  

 For high-throughput plate processing, when using a BioStack and a high 
flow pump, for example, eliminate the delay: set the value to 0 seconds. For 
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standalone use, BioTek does not recommend changing the default setting, 
unless you are troubleshooting. 

Using the  Description 

Keypad 1.  Press Setup Menu and select  twice. 

2.  Select VACDIS. 

3.  Enter between 0 and 50 seconds to delay processing. 

4.  Press ENTER to exit and return to the menu. 

LHC  
 

 
 

1.  Select Tools> Instrument Utilities. 

2. On the General Settings tab, define the Delay under Vacuum 
Dissipate. 

3.  Click the Send link to execute a change. 

 

Downloading Basecode — EL406 IS Utilities Viewer 

Before shipping the instrument, BioTek loads the EL406 with the latest basecode and 
configuration settings specific to your instrument. It may be necessary, however, to 
update the basecode at a later date. If this is necessary, contact BioTek TAC to obtain a 
copy of the latest basecode file. 

LHC users: select Tools>Instrument Utilities 

Keypad users: in addition to obtaining the basecode file, you must install the EL406 
IS Utilities Viewer, and connect the instrument to your PC.  

1 Define the COM port:  The LHC identifies and lists the 
available physical and virtual COM ports. 

2 Retrieve All onboard settings: Click the link to get all the instrument's 
settings simultaneously. It communicates with the EL406 and updates the 
information displayed in this dialog to reflect the instrument’s onboard 
settings. 

3 Under Service Functions click the Download Basecode link and Browse to 
the basecode file. Follow the onscreen prompts. 
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AutoPrime 

About AutoPrime 

The EL406 supports an AutoPrime option that automatically primes the washer and 
the dual syringes, if present, whenever the instrument is idle for a specified time. 
AutoPrime keeps the tubes wet between dispenses and other processes. And, 
AutoPrime's submerge feature provides a method of cleaning the aspirate and 
dispense tubes.  

You can specify the downtime interval for all components and set the parameters for 
each component. Devices are primed consecutively, beginning with the syringe 
dispensers, not concurrently.  

 Any interaction with the instrument resets the AutoPrime interval 
clock, including communication from the LHC. The instrument must 
be at its main menu to run AutoPrime. 

Turn On AutoPrime  

Set the AutoPrime Interval and Parameters: 

Using the  Description 

Keypad 1.  Press Setup Menu and select  twice. 

2.  Select AUTPRM. 

3.  Specify the idle-time interval to trigger AutoPrime: up to 24 
hours in minutes and press Enter. 

4.  At the AutoPrime setup menu, select the device you want to 
enable: the Washer and/or one of the Syringe dispensers.  

5.  For each device, define the AutoPrime parameters: rate, 
volume, and buffer valve, if applicable. Press Enter at each 
screen to advance to the next. 
Parameters match the device’s regular prime step. Enter a time 
period to enable the submerge feature.  

LHC  
 

 
 

1. Select Tools> Instrument Utilities. 

2. On the General Settings tab, under AutoPrime Interval, use 
the spin buttons or enter the downtime interval to trigger 
AutoPrime. 

3. Select the Washer tab and fill the checkbox to enable 
AutoPrime. Specify the priming parameters: rate, volume, and 
buffer valve, if applicable, and submerge duration, if any. 

4. Select the Syringe Dispenser tab and do the same, if desired, 
to enable AutoPrime for these devices. 

5. Click the Send link to execute a change. 
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 Press the STOP button on the keypad to interrupt the AutoPrime 
routine when it is underway. 

Stop AutoPrime 

The keypad displays a message, AutoPrime Running, when it is underway. Press the 
Stop button on the keypad to end the current session. To permanently stop AutoPrime 
from running follow the instructions referenced above, but disable, rather than enable 
it.  

Use AutoPrime to clean the Syringe Dispenser Manifolds 

 Be sure to use the priming trough inserts when the AutoPrime 
submerge feature is enabled. 

It is especially important when using the 32-tube SB dispense manifolds to keep the 
tubes wet to prevent clogs. One option is to modify the AutoPrime parameters used for 
idle periods during a regular work day to soak the tubing for longer periods overnight 
and on the weekends. 

 

Define the AutoPrime values to fill the 
priming-trough-inserts and then 
submerge the tubes for several hours.  

When the EL406 is set up for 1536-well 
washing, you can disable AutoPrime for 
the washer; the 128-tube aspirate 
manifold does not require the same 
level of soaking as dispense manifolds. 
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Step Parameter Reference Tables  

Wash Step Parameters 

>DEFINE>ADD or EDIT>WASHR>WASH (keypad path) 

Minimally, a wash step includes an aspirate step followed by a dispense step. Select 
and define each option to customize the parameters for your assay. 

Keypad 
name 

Option Description/Values range  Default 
values 

CYCLES Cycles Each wash cycle first aspirates and then 
dispenses fluid to and from the plate. 

3 

Aspirate   

Travel Rate: The rate at which the washer manifold travels 
down into the wells. The selection range is 1 to 
5 for non-cell-based assays, from slowest to 
fastest. With these rates, the tubes slow their 
descent as they approach the defined aspirate 
height (Z Position) to aid complete evacuation 
of the well. 
For delicate, cell-based assays, the range is 
1CW (cell wash) to 4CW and 6CW. These rates 
minimize turbulence in the wells. The tubes 
descend at a constant rate to the specified 
height. Rate 6CW creates the least disturbance 
and performs fastest. 

3 

Delay:  Amount of time the tubes stay at the aspirate 
height before lifting out of the wells. Define a 
delay between 0 - 5000 ms. Increasing the 
delay may improve evacuation of the wells. 

0 

Positioning: X- and Y- horizontal axes, Z- height (vertical) 
axis can be adjusted to improve performance. 
Default Z-axis for 1536-well plates is 40 steps. 

Z = 30  
X & Y = 0 

ASPIR 

Secondary 
aspirate: 

(except 128-
tube for 1536-

well plates) 

Also called Crosswise Aspiration. First the wells 
are aspirated using the position defined above. 
The aspirate tubes rise and then descend to the 
secondary position to aspirate again. This 
option is not available for 1536-well plates. 

No 

Dispense   

Flow Rate: 

96-tube & 192-
tube manifolds 

The rate at which the fluid is dispensed from 
the tubes. For cell-based assays, use rate 1 or 
2 for gentle washing with the 96-tube manifold 
only. For normal dispensing, the range is 3-11, 
3 is slowest and 11 is fastest. 

7 

32-tube 
dispenser: 

For 1536-well plate processing, flow rates 1-5. 3 

DISP 

Volume: µL/well dispensed range:  

◙ 96-tube manifold: 50-3000 

◙ 192-tube manifold: 25-3000 

◙ 1536-well (32-tube dispenser): 03-3000  

µL/well  
96 = 300 
384 = 100 
1536 = 10  
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Keypad 
name 

Option Description/Values range  Default 
values 

Buffer: Buffer bottle selection. A 

Positioning: X- and Y- horizontal axes, Z- height (vertical) 
axis can be adjusted to improve performance.  

Z = 120 

Vacuum Delay Suspends the vacuum pump until a certain 
volume is dispensed. This feature is applicable 
to cell wash operations only. It delays normal 
aspiration until the specified volume has been 
dispensed to the wells. The range is 10 to 350 
µL/well. 

10 

OPTS Options   

PRE Pre-wash options: Pre-dispense, Bottom 
wash (if applicable) 

 

MIDCYC Mid-cycle options: Shake, Soak, Pre-
dispense between cycles,  

 

POST Post-wash option: Final Aspirate  

 

FORM Format for washing 384- and 1536-well 
plates: Plate or Sector 

 

Pre-wash Actions performed before the wash cycles begin  

Pre-dispense Quick, small prime to condition the tips before 
dispensing. 

 

Flow Rate: 96-tube & 192-tube manifolds: The range is 3-
11, 3 is slowest and 11 is fastest. 

9 

Volume: µL/tube dispensed range:  

◙ 96-tube manifold: 50-3000 

◙ 192-tube manifold: 25-3000 

◙ 1536-well (32-tube dispenser): 03-3000  

µL/tube  
96 = 50 
192 = 25 
32 = 10  

Number: For 1536-well- 32-tube dispenser: the number 
of pre-dispenses to perform. 

2 

Bottom wash Bottom washing adds an initial wash cycle to 
the specified number of cycles. Fluid is 
simultaneously dispensed and aspirated to 
create cleaning turbulence (at the specified 
height). The manifold descends to aspirate 
again and ends with a final dispense to fill the 
wells. Not available for 1536-well plates. 

 

Rate: Valid range is 3-11. The cell wash rates, 1 CW 
and 2 CW, which use low-flow tubing, are 
available but not recommended. Cell wash 
options are designed for gentle washing, while 
bottom wash is designed for vigorous washing. 

 

Wash Volume: 25-3000 µL/well dispense  250  

PRE 

Positioning: X- and Y- horizontal axes, Z- height (vertical) 
axis can be adjusted. Repositioning the tubes to 
harder-to-reach areas of the wells may the 
improve results. 
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Keypad 
name 

Option Description/Values range  Default 
values 

Between cycles   

Shake To mix the contents of the plate. No 

Duration From 1 second to one hour. 5 sec. 

Slow       Medium Fast Variable Intensity 

3.5 Hz 5 Hz 8 Hz  

Med 

Soak Delays wash for the duration to allow fluids in 
the plate to steep or bathe. 

No 

Duration From 1 second to one hour. 30 

Home carrier To perform the shake or soak in the home 
position or not. However, the plate carrier is 
moved home when the total time of the shake 
and soak durations exceeds 1 minute. The 
vacuum pump is turned off in this scenario, so 
this action prevents drops from the manifold 
contaminating the plate. 

No 

MIDCYC 

Pre-dispense 
between 

cycles  

To wet or condition the manifold tubes between 
cycles, which is only needed after a long soak. 
Same parameters as regular pre-dispense. 

No 

Post wash When all cycles are completed.  POST 

Final 
Aspirate 

A final aspiration is performed to completely 
evacuate the wells. Same parameters as 
regular aspirate step. 

Yes 

Plate format Manner of processing large-format plates Plate 

Sector Performs the entire wash step on one sector of 
the plate before it moves to the next sector.  
 

 

FORM 

Plate Performs each cycle to the entire plate before it 
starts the next cycle. 

 

 

>DEFINE>ADD or EDIT>WASHR>PRIME 

Keypad  Option Description/Values range Default values 

PRIME Prime Flush tubing to remove air bubbles.  

 Prime Rate: Same as washer flow rate. 9 

 Volume: 5-999 mL 40 mL 

 Low-Flow 
Volume: 

Some fluid must be primed through 
low-flow tubing to prevent air 
bubbles from forming. 

5 mL 

 Submerge 
Tips: 

To soak the tubes in the priming fluid 
for a specified duration for cleaning 
or maintenance purposes. If yes, set 
duration, up to 24 hours, in minutes. 

No 
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>DEFINE>ADD or EDIT>WASHR>AUTOCLEAN 

Keypad  Option Description/Values range Default values 

ACLEAN AutoClean Fills the priming trough with fluid, 
submerges the tips and runs the 
ultrasonic cleaner for the specified 
duration. 

 

 Buffer: Buffer bottle selection, if applicable.  A 

 Duration: 0-24 hours in minutes. 60 min. 

Peri-pump Step Parameters 

>DEFINE>ADD or EDIT>PERIP>  

 Priming and purging the cassette can also be accomplished using the 
Setup Menu>Peri: press and hold the PRIME key to flush fluid through 
the cassette or hold the PURGE key to reverse the fluid direction. 

Keypad 
name 

Option Description/Values range  Default 
values 

PRIME Volume: 1-3000 µL To remove air from the tubing. 300 

Dispense The per-well volume to dispense. 

◙ 1 µL cassette = 1 - 50 µL 

◙ 5 µL cassette = 5 - 2500 µL 

◙ 10 µL cassette = 10 - 3000 µL 

10  

Flow rate: The rate, μL/second/tube, that fluid is 
ispensed for each cassette type: d 

Cassette Type  1 μL  5 μL  10 μL 
 (μL/sec/tube) 
Low  56  120  140 
Medium  60  140  160 
High  64  160  180 

HIGH 

Cassette 
type: 

To require a specific cassette type for this 
protocol. If yes, select the type, if no, select 
ANY. 

ANY 

Plate type: Select the plate type, and optionally, limit 
the columns dispensed to. 

96 

Positioning: X- and Y- horizontal axes, Z- height 
(vertical) axis can be adjusted to improve 
performance. Default Z-axis for 1536-well 
plates is 254 steps. (11.61 mm) 

Z = 336 steps 
(15.362 mm) 

DISP 

Pre-
dispense: 

When enabled, dispenses into the priming 
trough immediately before filling the plate. 
Pre-dispense is recommended for most 
applications. It normalizes the tips to ensure 
precise fluid distribution. Set volume and 
number of pre-dispenses. 

10 µL 

2 cycles 
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Keypad 
name 

Option Description/Values range  Default 
values 

PURGE Volume: 1-3000 µL To preserve fluid in the tubing by 
pumping it back into the supply vessel, i.e. 
reverses the flow direction. 

300 

 

Syringe Dispenser Step Parameters 

>DEFINE>ADD or EDIT>SYRNG>  

Keypad 
name 

Option Description/Values range  Default 
values 

Flow rate: 1-5 (See dispense step description) 5 

Volume: 80-8000 µL. To remove air from the tubing. 5000  

Syringe:  A or B A 

Cycles: Number of prime cycles to perform 2 

Pump 
delay: 

0-5000 msec. When dispensing highly 
viscous fluids, the tubing's check valves 
perform more slowly, i.e. it takes longer to 
open and close them. Delaying the syringe 
pump sufficiently to allow the specified 
amount of fluid to pass through the check 
valves before being pumped into the syringe 
has been shown to improve dispense 
accuracy.  
Begin by setting the delay to 500 msec. 
Experiment with different settings to 
determine the optimal value for your fluid. 

0 

PRIME 

 

Submerge 
tips: 

To soak dispense tubes in the priming fluid 
for a specified duration for cleaning or 
maintenance purposes. If yes, set duration, 
up to 24 hours, in minutes. 

0 

Flow rate: Rates 1-5 are dependent on the volume and 
plate type, except for 1536-well plates. See 
below. 

2 

Dispense 
Volume: 

5-3000 µL depending on the plate type. 10  

Syringe:  A or B, or Both, when processing 1536-well 
plates.  

A 

Columns: Select the plate type, and optionally, limit 
the columns dispensed to. 

96 

Pump 
delay: 

(Same as Prime step description above.)  

DISP 

Positioning: X- and Y- horizontal axes, Z- height 
(vertical) axis can be adjusted to improve 
performance. Default Z-axis for 1536-well 
plates is 254 steps. (11.61 mm) 

Z = 336 steps 
(15.362 mm) 

Be sure to use 
the prime 
trough inserts 
to submerge 
the tips in fluid. 
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Keypad 
name 

Option Description/Values range  Default 
values 

Pre-
dispense: 

When enabled, dispenses into the priming 
trough immediately before filling the plate. 
Pre-dispense is recommended for most 
applications. It normalizes the tips to ensure 
precise fluid distribution. Set volume and 
number of pre-dispenses. 

10 µL 

2 cycles 

 

Syringe dispenser flow rates: 

Rates are volume and plate-type dependent: For example, rate 1 must be used when 
dispensing between 10-19 µL to a 96-well plate. When dispensing 20-49 µL to a 96-well 
plate, you can use rates 1 or 2. And, when dispensing 50-59 µL to a 96-well plate, you 
can use rates 1, 2, or 3. And so on, as shown in the tables above. 

96-well plate: 

Volume 
(µL) 

Rate µL/sec/well 

10-19 1 450 
20-49 1-2 600 
50-59 1-3 750 
60-79 1-4 900 

 80-3000 1-5 1000 

384-well plate: 

Volume 
(µL) 

Rate µL/sec/well 

5 -9 1 225 
10-24 1-2 300 
25-29 1-3 375 
30-39 1-4 450 

 40-1500 1-5 500 

 Note: the µL/sec/well rate accounts for 2 tubes/well when 
addressing 96-well plates and one tube/well for 384-well plates. 

1536-well plate: 

Flow rates for the 32-tube dispense manifold do not 
have minimum volumes. 

Volume (µL) Rate 
The default rate is 2. 

3-3000 1-5 
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Shake Step Parameters 

Keypad 
name 

Option Description/Values range  Default 
values 

SHAKE Yes or No Yes to shake the plate for a defined period. No 

Duration: Up to 1 hour in seconds. 5 

Intensity: Slow, medium, fast or variable, which cycles 
through the other levels of intensity.  

Intensity Herz RPM 
Slow 3.5 210 
Medium 5 300 
Fast 8 480  

Medium 

 

Soak: Yes or No. To allow buffer/dispense fluid to 
remain (steep) in wells for the specified 
duration. If yes, set the duration, up to one 
hour. 30 second default duration. 

No 

 Move 
carrier to 

home: 

Regardless of user selection, the plate 
carrier is moved home when the total time 
of the shake and soak durations exceeds 1 
minute. The vacuum pump is turned off in 
this scenario ; moving the plate home 
prevents drops from the manifold 
contaminating the plate. 

Yes 
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Pre-defined Protocols 

The Maintenance and QC protocols are referenced in the Recommended Maintenance 
and Instrument Verification Schedules. The "Sample" protocols are provided to 
facilitate learning. When using the LHC software, you may need to customize these 
protocols to match your instrument's settings. 

 No Buffer Switching module? Copy the protocol and modify it for your 
instrument. See page 69. 

 Please read the important information about running maintenance 
protocols when the BioStack is under keypad control in the 
Maintenance chapter. 

 Copy the protocol to modify it or to create a duplicate. When using: 
 ● LHC: select File>Save As, 
 ● Keypad:  >DEFINE>COPY 
and assign a unique name to the copy. 

Maintenance Protocols 

Daily Maintenance # 

W-DAY_RINSE Simple one-step protocol to fully flush the system with 
water or reagent to keep the manifold tubes clog-free. 
Defined for use with Buffer A; 500 mL total volume. 

01 

S-DAY_RINSE_A&B Two-step protocol to flush tubing for both syringe 
pumps (A & B). 16000 µL total volume. 

02 

P-1UL_CASS_RINSE Simple one-step protocol to flush Peri-pump tubing for 
1 µL cassette.  

03 

P-5UL_CASS_RINSE Simple one-step protocol to flush Peri-pump tubing for 
5 µL cassette.  

04 

P-10UL_CASS_RNSE Simple one-step protocol to flush Peri-pump tubing for 
10 µL cassette.  

05 

W-OVERNIGHT_LOOP 
(for LHC users only*) 

Protocol designed to keep the manifold in a wetted 
condition overnight or for a long downtime period; 
manifold tubes are submerged in fluid for 4-hour 
intervals between primes in this virtually endless loop. 
Defined to use Buffer A.  

n/a 

*Keypad-Stand alone 
operation 

If you are not using the LHC software to control your 
EL406, use the AutoPrime feature or the alternative 
procedure described in the Maintenance chapter as a 
substitute for the Overnight_Loop protocol.  

 

W-RINSE_AND_SOAK Identical to W-DAY_RINSE with one addition, the 
manifold tubes are submerged and soaked for 5 
minutes in the fluid. 

06 

W-Decontaminate 
W-DECON (onboard) 

Aids implementation of the recommended 
decontamination routine. This protocol expects to first 

07 

Keypad 
protocol 
number 
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flush the system with disinfectant from Buffer A and 
later rinse with water using Buffer B.  

S-Decontaminate 
S-DECON (onboard) 

This protocol requires first running disinfectant and 
later running water through the system; for Syringe A 
only. It can be easily modified to suit any major 
cleaning effort. 

08 

W-LONG_SHUTDOWN Helps implement the routine recommended for 
preparing the instrument for storage. This protocol 
expects to run disinfectant from Buffer A, then water 
from Buffer B, and lastly, air through the system - 
remove bottle from Buffer C valve. 

09 

S-LONG_SHUTDOWN Prepares the instrument for long-term storage. This 
protocol requires first running disinfectant, then 
running water through the system, and lastly, air 
through the system.  Defined to use Syringe A. 

10 

S-DAY_RINSE_A Identical to S-DAY_RINSE_A&B except only Syringe A 
is defined. 

11 

W-CLEAN_w-BUFFER 

 
Combines priming and AutoClean steps to clean and 
rinse the wash manifold. It is defined to obtain 
cleaning fluid from Buffer B, and rinse fluid from 
Buffer A. The protocol must be modified to run on 
instruments without Buffer Switching. 

12 

W-PRIME_200 Simple prime routine; defined for Buffer valve A only. 13 

W-PRIME_ALL_BFRS Consecutively primes each of the Buffer Switching 
valves beginning with D. 

14 

 

QC (Quality Control) Protocols # 

W-96_DISP_TEST Dispense precision test protocol for 96-tube manifold.  15 

W-96_EVAC_TEST Evacuation efficiency test protocol for 96-tube 
manifold. 

16 

W-192_DISP_TEST Dispense precision test protocol for 192-tube 
manifold.  

17 

W-192_EVAC_TEST Evacuation efficiency test protocol for 192-tube 
manifold. 

18 

W-1536_EVAC_TEST Evacuation efficiency test protocol for 128-tube 
manifold. 

19 

SA-1536_DISP_TST Dispense precision test protocol for 32-tube Syringe A 
manifold. 

20 

SB-1536_DISP_TST Dispense precision test protocol for 32-tube Syringe B 
manifold. 

21 

P-1536_DISP_TEST Dispense precision test protocol for Peri-pump 1 µL 
cassette and 1536-well plate. 

22 
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Sample Protocols (LHC Only) 

Serial dilutions Description 

P-96_DILUTION Peri-pump serial dilution protocol dispenses 20 µL 
to 240 µL in 20 µL increments to each column of 
the plate. 20 µL to column 1; 40 µL to column 2; 
60 µL to column 3; and so on till 240 µL to column 
12. 

P-384_DILUTION Serial dilution protocol dispenses 2 µL to 94 µL in  
2 µL increments to each column of the plate. 2 µL 
to column 1; 4 µL to column 2; and so on till 94 µL 
to column 24. 

S-96_DILUTION Syringe dispenser serial dilution protocol dispenses 
240 µL to 20 µL in 20 µL increments to each 
column of the plate. 240 µL to column 1; 220 µL to 
column 2; 200 µL to column 3; and so on till 20 µL 
to column 12. Defined for Syringe A. 

S-384_DILUTION Serial dilution protocol dispenses 98 µL to 6 µL in  
4 µL increments to each column of the plate. 98 µL 
to column 1; 94 µL to column 2; 90 µL to column 
3; and so on till 6 µL to column 24. Defined for 
Syringe A.  

Cell Wash 

W&P-
96_CELL_WASH 

Cell wash-dispense protocol uses the special  
low-flow tubing, optimal dispense and aspirate 
heights, and vacuum delay during the wash step. 
Following the wash, the Peri-pump dispenses 200 
µL to each well. 

Microplate Manufacturers 

W-COSTAR_FLAT 

W-COSTAR_ROUND 

Standard wash protocols modified to best position 
the manifold tubes for dispensing and aspirating to 
Costar® flat-bottomed and round-bottomed wells.  

W-NUNC_384 

W-NUNC_FLAT 

W-NUNC_ROUND 

Standard wash protocols modified to best position 
the manifold tubes for dispensing and aspirating to 
Nunc® flat-bottomed wells, round-bottomed wells, 
and 384-well plates. 
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Overview 

A Preventive Maintenance (PM) regimen for the EL406 includes rinsing and 
soaking the fluid path and cleaning and/or autoclaving the various components.  The 
level of maintenance required to keep the instrument performing as expected is 
dependent on several factors, including the type of fluid dispensed, the frequency of 
use, and the work habits employed. 

The chart on the next page summarizes BioTek’s recommended maintenance tasks, 
and indicates approximately how often each task should be performed. Daily and 
periodic routines and minimal guidelines for frequency are listed. Beyond that, it is 
difficult for BioTek to recommend a fixed frequency for each task to be performed. The 
frequency of conducting these tasks must be based on the risk and performance factors 
of your assays.  

Develop a maintenance schedule for your EL406 based on the characteristics of the 
fluids used and the activity level. Here are some guidelines for each component: 

Washer 

 When using fluids prone to dry and harden quickly, the washer’s dispense 
and aspirate tubes can clog quickly, and must be rinsed frequently and 
cleaned regularly. Run AutoClean ultrasonic cleaning regularly.  

 If the washer will be idle for several hours or days at a time, the tubes 
should be soaked to keep them in a “wetted” state. Enable the AutoPrime 
program if the washer is idle for more than 3 hours. 

 Wash solutions affect the rinse frequency. If the solution does not contain 
surfactant, consider rinsing (or running AutoPrime) at least once an hour. 

Peri-pump 

 Purge the fluid at the end of a dispense run and flush the tubing with water 
(or buffered saline and then water). This is a good practice whenever the 
dispenser will be idle for more than an hour, and at the end of the day. 

 When using the 1 µL cassette, filter fluids to 50 microns to reduce the 
chance of the tips clogging. 

 When dispensing fluids that can crystallize or harden after use, increase the 
frequency of maintenance activities.  Autoclave the cassette as needed. 

 Keep track of the number of plates processed with a cassette to determine 
when the cassette has reached its expected lifetime and is due for 
replacement or recalibration. 
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Syringe Dispenser 

 Perform the daily maintenance routines. Flush the dispenser with an 
appropriate reagent at the beginning of the day (e.g., deionized water in the 
morning) and at the end of a run. 

 When dispensing fluids that can crystallize or harden after use, increase the 
frequency of maintenance activities. This is especially important for the 32-
tube small bore (SB) dispensers. 

 Autoclave the Syringe heads and pistons, and the 16-tube manifolds as 
needed. 

 Important: Do NOT autoclave the 32-tube Syringe dispense manifolds. 

 Enable AutoPrime with a soaking period for overnight, especially for the 
32-tube SB models, and perform the special cleaning procedures as needed 
to keep the tubes clog-free. 

Schedule 

The following chart recommends preventive maintenance tasks, the frequency with 
which each task should be performed, and the pre-defined onboard Maintenance 
program that should be run (if applicable).  

 It is important to note that the risk and performance factors associated 
with your assays may require that some or all of the procedures be 
performed more frequently than presented in this schedule. 
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Recommended Maintenance Schedule 

Frequency 

Tasks 
Daily 

Overnight/
Multi-Day Weekly 

Periodic/ 
Monthly 

Before 
storage/ 
shipment 

Washer  

Run W-DAY_RINSE      

Run AutoPrime      

Run W-OVERNIGHT_LOOP (LHC only)      

Run W-RINSE_AND_SOAK      

Run AutoClean      

Peri-pump Dispenser 

Flush dispense cassette       

Record approximate number of 
plates processed with cassette 

     

Syringe Dispenser  

Run S-DAY_RINSE_A&B      

Run AutoPrime        

Clean Components 

Remove protein residuals and fungi 
growth, (if necessary)  

     

Check/empty waste bottles      

Clean bottles      

Clean plate carrier system and 
transport arm 

     

Clean washer manifold       

Clean aspirate and dispense tubes      

Clean exterior surfaces and mist 
shield 

     

Clean fluid inlet filter      

Clean Syringe dispenser manifold       

Clean Syringe dispenser tubes      

Autoclave Syringe pumps      

Decontaminate  

Decontaminate external surfaces      

Run W-DECONTAMINATE (LHC) 

Run W-DECON (Keypad) 
     
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Run S-DECONTAMINATE (LHC) 

Run S-DECON (Keypad) 
     

Prepare for Storage or Shipment 

Run W-LONG_SHUTDOWN      

Run S-LONG_SHUTDOWN      

Replace/Repair Components 

Replace washer manifold o-rings and 
channel-end seals 

Annually 

Recalibrate Peri-pump cassette As Needed 

Replace Peri-pump dispense tips As Needed 

Replace Peri-pump cassette tubing As Needed 

Replace Syringe manifold check 
valves and plugs 

As Needed 
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Required Materials 

For rinsing/soaking the fluid path, and for cleaning the components: 

 Deionized or distilled water 

 Buffered saline solution or enzyme-active detergent for protein or cell-based 
assays 

 Sodium hypochlorite (NaClO or bleach) 

 70% isopropyl alcohol (or ethanol) 

 Dispense and aspirate tube styluses (supplied with the instrument) 

 Phillips head screwdriver  

 9/64” (3.57 mm) hex wrench (supplied with the instrument) 

 3/32” (2.39 mm) hex wrench (supplied with the instrument) 

 Lint-free disposable towels 

 Dish soap or other mild cleaner 

 Soft-bristled brush 

 Protective gloves, biohazard trash bags, lab coat, safety glasses, surgical mask 

For replacing washer manifold o-rings and channel-end seals: 

 O-rings (PN 49941) 

 Channel-end seals (PN 49486)  

 Not applicable to the 128-tube aspirate manifold. 

For replacing Syringe dispenser manifold plugs and check valves: 

 Manifold plugs (PN 45090) 

 Autoclavable check valves for use with non-organic substances (PN 68083) or 
check valves recommended for use with organic substances (PN 68073), which 
cannot be autoclaved.  

 

 In the cleaning procedures, when not otherwise specified, “water” 
means either deionized or distilled water. 

 Unless otherwise instructed, always connect a supply bottle containing 
deionized or distilled water to the washer before running the 
Maintenance programs. 
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Warnings & Precautions 

Please read the following before performing any Maintenance procedures: 

 

 

Warning! Internal Voltage. Turn off and unplug the instrument 
for all maintenance and repair operations. 

 

Caution! Chemical Compatibility with Washers. Some 
chemicals may cause irreparable damage to washers. The following 
chemicals have been deemed safe for use in washers: buffer 
solutions (such as PBS), saline, surfactants, deionized water, 70% 
ethyl, isopropyl, or methyl alcohol, 40% formaldehyde, and 20% 
sodium hydroxide.  
 
Never use DMSO or other organic solvents. These chemicals may 
cause severe damage to the instrument. See Appendix C, 
Chemical Compatibility, for more information. Use of wash 
buffers containing acetic acid is limited to washers upgraded with 
BioTek part number 68098 Teflon® valves.  
 
Contact BioTek for upgrade information and prior to using other 
questionable chemicals. 

 

Warning! Wear protective gloves when handling contaminated 
instruments. Gloved hands should be considered contaminated at 
all times; keep gloved hands away from eyes, mouth, nose, and 
ears. 

 

Warning! Mucous membranes are considered prime entry routes 
for infectious agents. Wear eye protection and a surgical mask 
when there is a possibility of aerosol contamination. Intact skin is 
generally considered an effective barrier against infectious 
organisms; however, small abrasions and cuts may not always be 
visible. Wear protective gloves when handling contaminated 
instruments. 

 Important! Do not immerse the instrument, spray it with liquid, 
or use a “wet” cloth on it. Do not allow water or other cleaning 
solution to run into the interior of the instrument. If this happens, 
contact BioTek’s Technical Assistance Center. 
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Maintenance Protocols 

BioTek provides the following pre-defined Maintenance protocols:   

Daily Maintenance 
W-DAY_RINSE Simple one-step protocol to fully flush the system with 

water or reagent to keep the manifold tubes clog-free. 
Defined for use with Buffer A; 500 mL total volume. 

01 

S-DAY_RINSE_A&B Two-step protocol to flush tubing for both syringe 
pumps (A & B). This protocol fully primes each Syringe 
system, with 40 mL total volume per pump.  

02 

P-1UL_CASS_RINSE Simple one-step protocol to flush Peri-pump tubing for 
1 µL cassette.  

03 

P-5UL_CASS_RINSE Simple one-step protocol to flush Peri-pump tubing for 
5 µL cassette.  

04 

P-10UL_CASS_RNSE Simple one-step protocol to flush Peri-pump tubing for 
10 µL cassette.  

05 

W-OVERNIGHT_LOOP 
(LHC only*) 

Protocol designed to keep the manifold in a wetted 
condition overnight or for a long downtime period; 
manifold tubes are submerged in fluid for 4-hour 
intervals between primes in this virtually endless loop. 
Defined to use Buffer A.  

N/A 

 * Keypad users can use AutoPrime as an alternative.   
W-RINSE_AND_SOAK Identical to W-DAY_RINSE with one addition, the 

manifold tubes are submerged and soaked for 5 
minutes in the fluid. 

06 

 
Periodic Maintenance 
W-DECONTAMINATE 
W-DECON (onboard) 

Aids implementation of the recommended 
decontamination routine. This protocol expects to first 
flush the system with disinfectant from Buffer A and 
later rinse with water using Buffer B. 

07 

S-DECONTAMINATE 
S-DECON (onboard) 

This protocol requires first running disinfectant and 
later running water through the system; for Syringe A 
only. It can be easily modified to suit any major 
cleaning effort. 

08 

W-LONG_SHUTDOWN Helps implement the routine recommended for 
preparing the instrument for storage. This protocol 
expects to run disinfectant from Buffer A, then water 
from Buffer B, and lastly, air through the system - 
remove bottle from Buffer C valve. 

09 

S-LONG_SHUTDOWN Prepares the instrument for long-term storage. This 
protocol requires first running disinfectant, then 
running water through the system, and lastly, air 
through the system.  Defined to use Syringe A.  

10 

S-DAY_RINSE_A Identical to S-DAY_RINSE_A&B except only Syringe A 
is defined. 

11 

W-CLEAN_w-BUFFER Combines priming and AutoClean steps to clean and 12 
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EL406 Washer Dispenser 

Periodic Maintenance 
 rinse the wash manifold. It is defined to obtain cleaning 

fluid from Buffer B, and rinse fluid from Buffer A. The 
protocol must be modified to run on instruments 
without Buffer Switching. 

W-PRIME_200 Simple prime routine; defined for Buffer valve A only. 13 
W-PRIME_ALL_BFRS Consecutively primes each of the Buffer Switching 

valves beginning with D. 
14 

To Run a Maintenance Protocol: 

 LHC users: follow the recommendation on page 108 to customize the 
protocol for First-time Use. 

BioTek provides numerous pre-defined protocols for maintaining the instrument in top 
condition. Protocols are stored onboard the instrument and installed on your PC by the 
EL406 Interface Software (IS) installation wizard. The files are stored in the LHC's 
default file location. Review the LHC’s Help for more details. 

Using the  Description 

Keypad 1.  At the main menu, press RUN. 

2.  Press Options to scroll to the desired protocol or use the 
arrow and number keys to enter its number. 

3.  Press ENTER and follow the prompts. 

LHC  
1. Select Open and locate the EL406 folder. 

2.  Open the EL406 folder to access the Maintenance 
Protocols folder. 

3. Select the desired protocol. 

 To halt a maintenance program in progress, press the STOP key. 

Important info for those using the BioStack under keypad control: 

The EL406 does not distinguish between protocols designed to process plates and 
maintenance protocols. When the instrument is configured to use the BioStack, every 
protocol tells it to deliver plates for processing, and the protocol is run repeatedly until 
all the plates in the input stack have been processed. 

When you have the BioStack under keypad control (rather than LHC control), to 
perform the required maintenance protocols and/or to prime the system with fluid 
prior to processing plates, you must choose one of these methods to perform 
maintenance activities: 
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Maintenance options with the BioStack configured for keypad control: 

1 2 

Quick Wash/Quick Dispense: Use the 
PRIME option of the Quick Wash and 
Quick Dispense menus instead of 
running the pre-defined protocol. 

 Quick Wash: set the prime volume 
to 500 mL.  

 Quick Dispense: for each dispenser, 
PRIME the tubing till all visible air 
bubbles are removed. 

Use this option to prime the tubing just 
before processing plates and whenever 
it is most convenient.  

Disengage the BioStack: Change the 
BioStack operating mode on the 
instrument to run the pre-defined 
protocols:  

1.  Press Setup Menu. 

2.  Select  

3.  Select BIOSTK. 

4.  Select CONF. 

5.  Select Manual. 

Restore the BioStack mode when you 
want to process plates. 

 

LHC First-time Use: 

When using the LHC, you may have to modify the pre-defined protocols to meet your 
assay requirements and to match your instrument configuration. In addition to action 
steps, every protocol file contains Instrument Settings, including COM port, 
manifold type, and so on. Edit the protocol to match your instrument's COM Port and 
other configuration details. 

With the EL406 connected to and communicating with the host computer: 

1. Click Open, locate the EL406 folder and click Open.  

2. Open the Maintenance Protocols folder and select the desired protocol. 

3.  Change the COM port if necessary: click the Port link and enter the 
correct value. 

4.  Click the Settings link, which opens the Instrument Settings dialog. 

5. Under Get settings from: click the instrument link.  

6.  Save the protocol. 
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Rinse/Soak the Fluid Path 

Daily Maintenance 

Daily maintenance involves flushing the washer and dispensers with an appropriate 
reagent or deionized water throughout the day.  Routine rinsing helps to prevent the 
aspirate and dispense tubes from clogging between runs.  

The recommended rinsing frequency depends on the solutions currently in use:   

 If a solution containing surfactant is used throughout the day, the rinsing 
procedure should be performed if the device is idle for more than 3 hours.   

 If the solution does not contain surfactant, consider rinsing at least once an 
hour. 

 The type of hardware also affects rinsing frequency. The 32-tube 
dispense manifolds require more diligence to keep them clog-free.   

Run these protocols and enable AutoPrime to satisfy daily maintenance requirements: 

 W-DAY_RINSE 

 S-DAY_RINSE_A&B 

 P-#UL_CASS_RINSE (# represents the cassette type) 

Make sure the supply bottles contain sufficient rinse solution and that the waste bottles 
are empty before running the protocols.    

        See the additional maintenance procedures on page 112 when dispensing protein 
solutions. 

AutoPrime 

Enable AutoPrime to automatically wet or soak the washer’s and Syringe dispenser’s 
tubes after a user-specified amount of idle time. Learn about AutoPrime, including 
how to enable it in Chapter 3, Operation.  

 Press the STOP button on the keypad to interrupt the AutoPrime 
routine when it is underway. 

 Any interaction with the instrument via the keypad or the LHC resets 
the interval clock. 

 The instrument must be at its main menu to run AutoPrime. 

EL406 Washer Dispenser 
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Overnight/Multi-Day Maintenance 

Overnight/multi-day maintenance involves flushing all solutions out of the 
instrument, and then periodically rinsing and soaking the tubes to keep them moist. 
Here are three recommendations for accomplishing the task. Employ the method that 
best suits your work flow: 

 AutoPrime 

 Overnight Loop (LHC only) for wash manifold 

 Submerge and shutdown 

Maintaining 1536-well Hardware 

At the end of the day run W-DAY_RINSE to flush the 128-tube aspirate manifold. The 
aspirate tubes cannot completely empty the priming trough when the run is finished. 
Remove the fluid manually with a pipette or paper towel. 

The 32-tube-SB dispense manifolds can become easily clogged. It is especially 
important to enable AutoPrime with the suggested soaking periods (next page) to 
ensure trouble free startup at the beginning of the next day.  

AutoPrime 

AutoPrime can be used to keep the manifold tubes wetted during idle periods 
throughout the day and then modified to soak the tubing for longer periods overnight 
and on the weekends. Learn about AutoPrime, including how to enable it in Chapter 
3, Operation.  

Washer AutoPrime Parameters  
AutoPrime Interval = 15 minutes 
Device = Washer 
AutoPrime = Yes 
Volume = 60 µL/tube 
Rate = 09 
Buffer = Any 

 
To repeatedly soak both devices, make 
sure the AutoPrime interval is less than 
the total combined submerge duration. 

Duration: 120 minutes  

Syringe AutoPrime Parameters 
 

 

For overnight maintenance, define the 
AutoPrime values to fill the priming-
trough-inserts and then submerge the 
tubes for several hours.  

When the EL406 is set up for 1536-well 
washing, you can disable AutoPrime for 
the washer; typically the 128-tube 
aspirate manifold does not require the 
same amount of soaking as dispense 
manifolds. 
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32-tube Syringe Dispenser 

When using the 32-tube dispense manifolds, especially the small bore (SB) model, use 
the following AutoPrime parameters to keep the manifold clog-free: 

Volume: 1000 µL 
Flow rate: 3 

Submerge duration: 3 hours (requires priming trough inserts) 

 Enable AutoPrime for both Syringe manifolds and disable AutoPrime for 
the Washer. 

Overnight/Multi-day practice: After modifying the AutoPrime parameters to 
submerge the tubes for several hours: 

1 Put the priming-trough-inserts into the priming trough.  

2 Use Quick Dispense to fill both inserts (prime cups): DISP>PRIME (for 
both Syringe A and B). Run the Prime two or three times to fill the cups. 

3 When the priming troughs are filled, press Main Menu. 

Overnight Loop 

To keep the wash manifolds in a wetted condition, you can run these pre-defined 
protocols to soak the tubes for several hours at a time:  

 W-OVERNIGHT_LOOP: requires the washer to remain turned on; available 
for LHC users only. 

 W-RINSE_AND_SOAK: alternatively, run this protocol, number 06 on the 
keypad, and turn off the instrument after the soak begins. The tubes will 
soak in the priming trough until the instrument is turned on again. 

 

Submerge Tips and Shutdown for Overnight Soaking 

You can simultaneously soak the EL406 dispense manifolds by filling the priming 
troughs and turning off the instrument after the soak begins. The tubes will soak in the 
priming troughs until the instrument is turned on again.  

First run S-DAY_RINSE_A&B but do not empty the priming trough inserts, then run 
W-RINSE_AND_SOAK. When the manifold is submerged, turn off the instrument. The 
syringe dispenser manifolds will lower into their troughs. 

EL406 Washer Dispenser 
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Removing Protein Residuals 


Important! Solutions containing proteins, such as 
bovine serum albumin (BSA), will compromise the 
EL406’s performance over time unless a strict 
maintenance regime is adhered to.  
Do not use alcohol to flush out BSA.   

 
When dispensing protein solutions or similar fluids with the washer and the 
Syringe dispenser, perform these additional procedures to thoroughly flush out 
protein particles and other contaminants from the fluid path.  

 Four-liter volumes specified in the following are approximate amounts. 

 S-DECONTAMINATE (S-DECON): this pre-defined protocol specifies 
Syringe A. Make a copy of the protocol to execute for Syringe B.  

Daily Practice with buffer or deionized water: 
If the washer or dispenser will be idle between plates for longer than 45 minutes, 
flush the proteins from the washer: 

1 Fill a supply bottle with deionized water. Connect the bottle to the washer 
or dispenser. (Buffer valve “A” if the Buffer Switching module is 
connected.)  

2 Run the applicable DAY_RINSE protocol. 

3 Enable AutoPrime for 60-minute intervals. 
 

At the end of the day: 

1 Fill a supply bottle with deionized water. Connect the bottle to the washer 
dispenser (Buffer valve “A” if the Buffer Switching module is connected.)  

2 Run the applicable DAY_RINSE protocol three times.  

3 Perform your regular Overnight/Multi-Day Maintenance routine.  

Weekly or As Needed use NaOH and HCl to remove proteins:   

1 Flush the system with 0.1-0.5 N* NaOH (sodium hydroxide), followed by 
neutralization with an equivalent normality (0.1-0.5 N) of HCl 
(hydrochloride).  

2 Rinse well with deionized water to remove the HCl. 

3 Run the applicable DAY_RINSE protocol three times with deionized water 
if you plan to use the device immediately. 

 * N = Normal solution, which contains 1 ‘gram equivalent weight’ (gEW) of solute per liter 
of solution. The gram equivalent weight is equal to the molecular weight expressed as 
grams divided by the ‘valency’ of the solute. 
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Alternatively use an Enzyme-Active Detergent: 

1 Mix an enzyme-active detergent according to the manufacturer’s directions 
to fill a four-liter supply bottle. Connect the bottle to the washer’s Buffer 

of DI water to Buffer valve 

Continue.  

valve A or one of the Syringes.  Connect a bottle 
B to rinse the tubing. 

2 Run the W-DECONTAMINATE (W-DECON (07)) or S-DECONTAMINATE 
(S-DECON (08)) protocol, as appropriate. 

3 LHC users: Respond to the Delay messages, “Connect a bottle of water…”, 
leave the detergent bottle connected and click 
For the Syringes: connect a bottle with DI water to the pump and REPEAT 
the protocol. 

4 When the protocol is completed, connect a bottle containing four liters of 
deionized water and run W-DAY_RINSE or S-DAY_RINSE three times to 
flush the system. 
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Periodic Maintenance 

Periodic maintenance involves cleaning the components on a regular basis to keep the 
instrument running efficiently and in compliance with performance specifications.  The 
recommended frequency for cleaning components is at least monthly. The risk and 
performance factors associated with your assays may require that some or all of the 
procedures be performed more frequently. 

 

 

Warning! Internal Voltage. Turn off and unplug the 
instrument for all cleaning operations. 

 

Important! Do not apply lubricants to manifold o-rings, 
channel-end seals, bottle cover seals, any tubing connection, 
or any surface that is a part of the fluid path. The use of any 
lubricant on the fluid handling components will interfere with 
the aspirate and dispense performance, and may cause 
irreparable damage to these components. 

 Important! When cleaning components: 
 
Do not immerse the instrument, spray it with liquid, or use a 
“wet” cloth on it. 
 
Do not allow the cleaning solution to run into the interior of the 
instrument. (If this happens, contact the BioTek Service 
Department.) 
 
Do not expose any part of the instrument to the recommended 
diluted sodium hypochlorite solution (bleach) for more than 20 
minutes. Prolonged contact may damage the instrument 
surfaces. Be certain to rinse and thoroughly wipe all surfaces. 
 
Do not soak the keypad. Instead, moisten a clean cloth with 
deionized or distilled water and wipe the keypad. Dry it 
immediately with a clean, dry cloth. 

 

Clean the Bottles 

 Clean and rinse the supply bottles with deionized water before the first use, 
before each refill, and, periodically, as necessary, to prevent bacteria 
growth. 

 Empty the waste bottle often (at least daily), and firmly seat the waste 
bottle stopper.  

 Rinse the covers every time the wash or rinse bottles are filled.  
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 Accumulated algae, fungi, or mold may require decontamination.  
Decontamination is described on page 131. 

 To ensure that fluid does not back up into the vacuum pump during 
operation, always operate the instrument with the waste sensor 
cable installed and the waste detection sensor enabled (the 
sensor is enabled by default; see EL406 Settings and Utilities in 
Chapter 3, Operation).   
If fluid collects in the overflow bottle, thoroughly rinse the level-
switch assembly and bottle. 

 Check the hex nuts securing the quick-disconnects to the bottle cap to 
ensure they are not loose or corroded. 

 

Clean the Plate Carrier 

If liquid has overflowed onto the plate carrier, transport rail, or glide strips, some 
buildup may occur and prevent the microplate from seating correctly on the 
carrier. This can interfere with plate transport. Weekly cleaning is recommended. 

1. Turn the instrument off.  

2. Lift the carrier up and off the transport rail.  

3. Clean the carrier, rails, and glide strips, using mild detergent and hot 
water, 70% isopropyl alcohol, or ethanol. Clean the priming trough, too. 

4. If detergent was used, wipe the components with a cloth moistened 
with water. Use a clean, dry cloth to dry the components.  

5. To replace the carrier, place it on the transport rail so the slot on its base 
fits into the Y-axis Carrier Arm. If necessary, release the spring-loaded 
microplate clamp in the back left corner of the carrier to level the carrier 
on the base. 
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Washer Maintenance 

The EL406’s washer manifold, mist shield, and tubing require periodic cleaning. 
Regular rinsing helps to keep the washer manifold clean, the aspiration and dispense 
tubes clear, and it increases the life of the tubing.     

If you suspect a particular problem is related to the manifold (for example, clogged 
tubes can result in poor or uneven aspiration or dispensing), you should perform a 
thorough cleaning of the dispense and aspirate tubes and channels. When necessary, 
follow the decontamination procedure that begins on page 131 to disinfect the 
manifold and tubing. 

Clean the manifold, mist shield, and tubing 

1 Run the system “dry”: 
 Disconnect the fluid supply from the instrument,  

 Run W-DAY_RINSE 

2 Turn off the instrument and disconnect the power cable. 

3 Moisten a lint-free disposable towel with water, or with water and mild 
detergent. Do not soak the cloth. 

4 Remove the mist shield if it is attached. Wipe the inside and outside 
surfaces of the mist shield with the towel. Wipe the top surface of the 
instrument base, and all exposed surfaces of the instrument. 

5 If detergent was used, wipe all surfaces with a cloth moistened with water. 

6 Use a clean, dry cloth to dry all wet surfaces. 0 
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Remove and clean the washer manifold 

 Hold the two manifolds together as a single unit when removing or 
replacing. 

1 Using the 9/64” (3.57 mm) hex wrench, remove the screws, washers, and 
springs that hold the manifolds in place. Carefully remove the manifolds 
and end plates. 

 Avoid pressing the stylus against the sides of the tubes during 
cleaning. This can cause the tubes to bend, which may negatively 
affect dispense precision. 

2 Using a soft-bristled brush, thoroughly clean the outside of the manifolds.  
Clean the insides of each tube with the appropriate stylus 
(aspirate/dispense). Flush hot water through the cross channels. 

3 Rinse the manifold with deionized or distilled water.  Check to see if water 
comes out of all dispense and aspirate tubes. If not, soak the manifold in 
hot, soapy water and repeat. 

 

 

Caution. When reinstalling the manifold, only tighten 
the screw-washer-spring assembly that holds it in 
place until you feel the mechanical stop. Tightening 
past this point will damage the instrument and will 
void your warranty. 

4 When satisfied, reassemble the manifold and end plates, making sure that 
the two o-rings are in place prior to reassembly. Do not overtighten the 
manifold screws. 

5 Install the mist shield.  

6 Reconnect the power cable and turn on the instrument. 

7 Prime the system with deionized water by running W-DAY_RINSE or a 
similar protocol. Watch for leaks. If fluid leaks out of the back of the 
instrument, firmly seat the tubing. If fluid leaks from the manifold, try 
disassembling and carefully reassembling.  

8 Verify aspirate/dispense performance visually or by performing the tests 
in Chapter 5, Qualification. 

 Replace the o-rings on an annual basis. Replace the channel-end seals 
(rubber plugs) if they show signs of cracking or drying out. See 
Washer O-Rings and Channel-End Seals on page 139. 

 For additional cleaning, run AutoClean™ with Ultrasonic Advantage™. 

 DO NOT AUTOCLAVE the manifold! 
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AutoClean™ the Washer  

 

Warning! Ultrasonic energy is present in the 
cleaning reservoir when AutoClean is running. Do 
not put your fingers in the bath! Ultrasonic 
energy can be destructive to human tissue.  


Important! Ensure that adequate room exists in the 
waste bottle and adequate volume is available in the 
supply bottle before running AutoClean!  

 
The Ultrasonic Advantage™ feature is a built-in ultrasonic cleaner that 
provides enhanced periodic maintenance capabilities by using ultrasonic pulses in 
a water bath to clean residuals from the manifold tubes. Ultrasonic energy causes 
cavitation forces within the water bath, which in turn cause tiny vapor bubbles to 
be created. The formation and subsequent collapse of these bubbles is the 
mechanism that cleans manifold tubes submerged in the bath.  

The cleaner consists of a stainless steel reservoir with an ultrasonic transducer 
bonded to the bottom of the reservoir. The reservoir is mounted on the washer and 
also functions as the priming trough.  

 Do not remove the ultrasonic cleaner! Only BioTek authorized 
service personnel should remove the ultrasonic cleaner for 
maintenance or repair. 

 or WASHR>ACLEAN 

Running the AutoClean routine requires defining a protocol that includes a prime 
step and specifies the duration. Approximately 93 mL of fluid fills the reservoir 
during each run.  

While the program is running, the ultrasonic cleaner will pulse on and off 
approximately every ten seconds, and you will hear a periodic “hissing” sound 
that indicates the ultrasonic energy is present.   

 Tip: Detergent such as Terg-A-Zyme® added to deionized water in the supply 
bottle helps to break down the water’s surface tension and enhances the cleaning 
process. Terg-A-Zyme also contains protease enzyme to digest protinaceous 
residue such as bovine serum albumin (BSA). 

 General Recommendation: Run AutoClean for 1 hour. Follow with a 
full prime protocol using deionized water to remove the detergent from 
the system, or with a wash buffer to leave the instrument primed and 
ready for use. See the recommended prime volumes Chapter 3, 
Operation. 
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 1536-well hardware: If you intend to AutoClean the 32-tube Syringe 
dispenser manifolds, we recommend cleaning them first, and then 
cleaning the 128-tube aspirate manifold. See below. 

 With the BioStack configured for keypad control: Before running 
an AutoClean protocol when you have the BioStack connected to and 
controlled by the EL406, disable the BioStack until the process is 
complete. Review the details of this maintenance issue on page 107. 

To run AutoClean: 

1. Empty the waste bottle. 

2. Make sure supply bottles have sufficient volume of detergent and deionized 
water. 

3. Create an AutoClean protocol, with these parameters: 

 First a Prime step to flush the lines with the cleaning agent. 

  Add an AutoClean step. WASHR>ACLEAN 

 Set the duration to 1 hour. 

  Save the protocol and assign a unique name, e.g., AutoClean. 

4. Click Run. 

Special Procedures for 1536-well Hardware: 

EL406 models for processing 1536-well plates require your intervention to run 
AutoClean: 

 Connect a bottle of cleanser or water to the Dispense Fluid In port on the 
rear of the instrument to use the single priming tube in the 128-tube 
aspirate manifold to fill the priming trough (ultrasonic bath).  

 The 128-tube aspirate manifold cannot completely evacuate the priming 
trough. When AutoClean is finished, you must manually remove the 
residual liquid using a pipette, paper towel or other method. Be sure to 
follow the manufacturer’s handling instructions for the cleaning fluid you 
are using. 
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AutoClean 32-Tube Dispense Manifolds: 

With a little manual intervention, you can use the ultrasonic cleaner on the hard-to-
clean dispense tubes, especially the SB – small bore models.  

 

Before running AutoClean for the aspirate manifold, run it for the 32-tube Syringe 
dispenser manifolds:  

1 First, remove the Peri-pump cassette and put it aside. 

2 Grasp both Syringe dispenser manifolds, and keeping them together, slide 
them off the dispense arm. The magnets help keep them together. 

3 Gently release their tubing from the black bracket above the wash manifold 
and position them on the left side of the wash manifold, ready to put into 
the ultrasonic bath. 

4 Run the AutoClean protocol described in the previous procedure.  

5 When the AutoClean step begins, lift the wash manifold with your right 
hand and place the dispense manifolds into the bath with your left hand.  

6 Make sure the tubes are in the fluid and the edges of the manifolds are 
resting on the edges of the priming trough. Then, gently lower the wash 
manifold down on top of the dispense manifolds. The wash manifold will 
hold them in place. 

Important: the aspirate manifold will be unable to evacuate the fluid from the priming 
trough when the run ends because the dispense manifolds will be in the way. To 
complete the process: 
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7 Reinstall the dispense manifolds on the dispense arm. 

8 Run the AutoClean protocol for the aspirate manifold.  

9 When AutoClean is finished, remove the residual liquid in the priming 
trough using a paper towel or other method. Be sure to follow the 
manufacturer’s handling instructions for the cleaning fluid you are using. 

Cleaning the Fluid Inlet Filter 

 
Warning! Internal Voltage. Turn off and unplug 
the instrument for all cleaning operations. 

 
Periodically clean the fluid inlet filter (PN 49943): 

1. Unscrew the Dispense Fluid In fitting from the back of the instrument.  

2. Note the orientation of the filter in the fitting (the cone-shaped end of the 
filter points “in” toward the instrument) and then remove the filter from 
the fitting. 

3. Wash the filter with hot water and a soft-bristled brush. 

4. Rinse the filter, then replace it in the fitting and reinstall. 
 

 

Fluid inlet filter 

Vacuum port 
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Peri-pump Dispenser Maintenance 

The level of the maintenance required to keep the Peri-pump performing as expected is 
dependent on several factors, including the type of fluid dispensed, the frequency of 
dispensing, and the work habits employed. For example, when dispensing fluids that 
can crystallize or harden after use, maintenance activities are required more frequently. 
Similarly, when using the 1 µL cassette, fluids should be filtered to 50 microns to 
reduce the chance of tips clogging.   

Daily maintenance includes purging the fluid at the end of a dispense run and flushing 
the tubing with water (or buffered saline and then water). This is a good practice 
whenever the dispenser will be idle for more than an hour, as well as at the end of the 
day.  

Another important daily requirement is keeping track of the number of plates 
processed with a cassette. This is necessary to determine when the cassette has reached 
its expected lifetime and is due for replacement or recalibration. Replacement Tubing 
Kits, as well as new cassettes are available from BioTek Instruments.  

Monthly maintenance requires overall cleaning of the dispenser and its accessories, 
and verifying performance to determine if the cassette needs recalibration. Autoclaving 
or decontaminating the cassette is also recommended. 

Flush the Tubing Cassette 

Daily Maintenance involves priming the tubing with an appropriate reagent at the 
beginning of the day, and, flushing the tubing to effectively remove all contaminants at 
the end of the day.  

The type of rinse fluid to use is determined by the type of fluid you are dispensing. 
Some dispense fluids require the use of enzyme-active detergent, buffered saline, 
ethanol or isopropyl alcohol, rather than deionized water alone. 

Tools and Supplies 

 Deionized or distilled water 

 Buffered saline solution or enzyme-active detergent for protein or cell-based 
assays 

At the start of the day: 

Prime the tubing to prepare for a dispense run. 

1. Reload the cassette and fill the supply vessel: 

BioTek Instruments, Inc. 



Peri-pump Dispenser Maintenance  |  123 

 When dispensing solutions not effected by water, simply prime with 
the dispense fluid. 

 When dispensing protein solutions, first prime the tubing with a 
buffered saline solution to remove any traces of water in the tubing, 
then, prime with the dispense fluid. 

2. Hold the Prime button on the keypad until fluid flows into the priming trough 
and all visible air bubbles have been removed.0 

At the end of the day: 

Purge the tubing to reclaim the dispense fluid, then prime the tubing to flush it clean. 

1. Hold the Purge button on the keypad until the tubing appears empty. 

2. Replace the supply vessel with the appropriate rinse fluid: 

 When dispensing water soluble solutions, use DI water. 

 When dispensing protein solutions, first prime the tubing with a 
buffered saline solution to remove protein particles, then, prime with DI 
water. 

3. Hold the Prime button on the keypad:0. 

 1 µL cassette = 5 seconds 

 5 µL cassette = 7 seconds 

 10 µL cassette = 10 seconds. 

Unclog the Dispense Tips 

The small diameter of the dispense tips makes them susceptible to clogging. You may 
be able to visually identify a clogged tip, or an inaccurate dispense performance may 
signal a problem. Good work habits can prevent clogging or reduce its occurrence: 

 When using 1 µL cassettes, filter fluids to 50 microns before dispensing.  
 Thoroughly flush the tubing after/in-between usage, especially when using 

liquids that crystallize or harden.  

In case the need arises, BioTek ships a 10 cc plastic syringe with special tubing and 
fitting for use in unclogging tips. Installation instructions recommend storing it in the 
pouch on the back of the instrument. The remedy involves removing the dispense tip 
and flushing it with water. Depending on the type of clog, soaking the tip holder in hot 
water with mild detergent is recommended.   

  This task may be easier if you use the cassette’s shipping container to hold the 
unaffected cassette parts, keeping them out of your way.  
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Required Materials 

 10 cc syringe with tubing and fitting attachment shipped with dispenser 

  Screwdriver shipped with dispenser 

 A sufficient quantity of deionized (DI) water in a beaker 

Procedure 

1. Fill the 10 cc syringe with water and set aside. 

2. Remove the cassette from the dispenser. 

3. Use the screwdriver to open the Tip Holder. Put the top of the holder aside. 

4. Lift the affected dispense tube from the holder and pull its tip off the tube. 

5. Slide the tip, tapered end first, into the tubing on the end of the syringe. 

6. With the tip poised to expel the clog and the water into the beaker or a sink, 
discharge the syringe. 

7. Fill and discharge the syringe as many times as needed to flush the tip. 

8. Reassemble the cassette:0. 

 Put the straight end of the tip into the bottom of the tube (the tapered 
end of the dispense tip is exposed). 

 Reinsert the tube into the Tip Holder. Seat the flared edges of the tip 
into the molded slots. 
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 Replace the Tip Holder cover with its two screws. The etched BioTek 
label identifies the top of the cover (except for 1536 cassettes’ steel cover 
plate). 

Record the number of plates processed 

To determine when a tubing cassette has reached the end of its expected lifetime, make 
a habit of counting and recording the approximate number of plates and volume 
dispensed per cassette. 

Create a form similar to the example table below or estimate your usage of the cassette 
and project a date for replacement or recalibration. 

Cassette Types Cassette Life Total Volume 

1 µL 1000 384-well plates @ 5 µL/well 2,000 mL 

5 µL 1000 96-well plates @ 50 µL/well 5,000 mL 

10 µL 1000 96-well plates @ 100 µL/well 10,000 mL 

Example table for recording cassette usage: 

You may want to create a form similar to this table to keep track of the volume 
dispensed with each cassette: 

Cassette serial #: 2178 

Date # Plates Plate Type Volume/Well Total Daily Vol. Total Cassette Vol 

10/10/08 26 384 5 µL  49920 µL 50 mL 

10/11/08 33 96 10 µL 31680 µL 82 mL  
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Syringe Dispenser Maintenance 

32-tube small bore (SB) dispense manifold: If you observe 
the fluid streaming from a dispense tube to be awry or skewed, 
it is most likely caused by minute particles of debris on the end 
of the tube. Brush away any particles from the end of the tube 
using a piece of silicon tubing. Silicon will not flake off and leave 
particles behind like other materials. 

Also see AutoClean the Dispense Manifolds on page 120.  

Clean the Bottles and Tubes  

 Clean the bottles and tubing with deionized water before the first use, before each 
refill, and if they have been idle for any length of time. 

 Accumulated algae, fungi, or mold may require decontamination; see page 131. 

Clean the Syringe Dispenser Manifolds  

Regular rinsing helps to keep the manifold clean and the dispense tubing clear, and 
will increase the life of the tubing. Follow the Decontamination procedure starting on 
page 134 to disinfect the manifold and tubing. 

If you suspect a particular problem is related to the manifold (for example, clogged 
tubes can result in uneven dispensing), you should perform a thorough cleaning of the 
manifold. To clean the manifold: 

1. Turn off and unplug the instrument. 

2. Pull each manifold off the dispense arm and disconnect the tubing from the 
syringe pump.  

3. Using a lint-free disposable towel, thoroughly clean the outside of the 
dispense tubes.  

4. Remove the plugs from the ends of the manifold. 
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5. Run hot water through the inlet fitting. Check to see if water comes out of 
all of the dispense tubes (except when working with the 32-tube SB 
manifold: there will be insufficient pressure to push water through the 
tubes). If not, soak the manifold in hot soapy water and repeat.  

If additional cleaning is necessary, follow the procedure to clean the dispense tubes. 

Clean the Dispense Tubes 

Unless there is a problem, the manifold dispense tubes do not need special cleaning. 
Periodic rinsing is usually sufficient to keep the tubes clean. However, if the previous 
steps are not completely successful, try the following: 

 16-tube manifolds: clean the tubes with the stylus; 

 32-tube manifolds: flush the tubing with the 10 cc syringe or clean the tubes 
with the stylus. 

 Note: The 16-tube autoclavable manifold has removable dispense 
tubes. We do not recommend routinely removing these tubes. In the 
case of a particularly difficult problem with any one channel, however, a 
tube may be removed and cleaned individually, or replaced. 

 Do not autoclave the 32-tube dispense manifolds! 
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1. Remove the two plugs from the ends of the manifold. 

2. Tip the manifold on end and flush hot water through this open channel. 

3. Using the supplied tool, clean the insides of the dispense tubes: 

 16-tube manifold: use the stylus, PN 2872304 

 32-tube manifold: use the 10 cc syringe and tubing or the appropriate 
stylus. 

Let water flow through the open channel while you probe or flush each 
tube, forcing any particles to be washed away.  

4. Rinse the manifold with deionized or distilled water. Check to see if water 
comes out of all of the dispense tubes (except when working with the 32-
tube SB manifold). Reinsert the plugs into the ends of the manifold.  

5. Replace the tubing and remount the manifold.  

6. Run a prime protocol, e.g. S_DAY_RINSE, using 40 mL of deionized water. 

7. Verify dispense performance visually, or by performing the appropriate 
Dispense Precision and Accuracy Tests in Chapter 5, Qualification. 
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Clean/Replace the Check Valves  

 Note: The check valves do not twist open. 

If the check valves leak or become clogged, you can either clean or replace them.  
Contact BioTek Customer Service to order replacement check valves. 

To clean a check valve: 

1. Pull the tubing off the check valve. 

2. Insert the stylus into the feed end of the valve to hold it open (observe 
arrow on valve indicating flow direction). 

3. Flush with hot water.  

4. Replace the valve and the tubing.  
 


After replacing a check valve, if you observe a 
decline in accuracy, recalibrate the backlash 
(see page 142) to ensure optimum performance. 

Autoclave the Syringe Head  

 

1. Use the supplied 3/32” (2.39 mm) hex wrench to remove the two mounting 
screws that hold the syringe head in unit. 

2. Pull the syringe head straight back and off of the piston. 
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3. Use the hex wrench to loosen the setscrew on top of the sleeve that holds the 
piston and then remove the piston. 

 


Important! Autoclave the piston and syringe head 
separated from one another. Keep the piston and syringe 
head unattached to each other when autoclaving.   

4. Autoclave at 134°C and 216 kPa for 3 minutes, or 121°C and 115 kPa for 30 
minutes. The manifold, tubing, autoclavable check valves, and supply bottles 
may also be sterilized in the autoclave. 

 Check valves (PN 68073) recommended for use with organic 
substances cannot be autoclaved. 

5. Replace the components by reversing the steps: 

1 With the flat side of the shaft facing up, slide the syringe piston shaft 
into the piston holder until it stops. 

2 Use the 3/32” (2.39 mm) hex wrench to tighten the setscrew. 

3 Push the syringe head over the piston until it is flush with the unit 
and use the hex wrench to attach the two mounting screws.   
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Decontamination  

Any laboratory instrument that has been used for research or clinical analysis is 
considered a biohazard and requires decontamination prior to handling.   

Decontamination minimizes the risk to all who come into contact with the instrument 
during shipping, handling, and servicing. Decontamination is required by the U.S. 
Department of Transportation regulations. Persons performing the decontamination 
process must be familiar with the basic setup and operation of the instrument. 

The recommended frequency for decontamination is at least monthly, and before 
shipment of the instrument to BioTek for calibration or repair. 

 


Important! BioTek Instruments, Inc. recommends the use 
of the following decontamination solutions and methods 
based on our knowledge of the instrument and 
recommendations of the Centers for Disease Control and 
Prevention (CDC). Neither BioTek nor the CDC assumes any 
liability for the adequacy of these solutions and methods.  
Each laboratory must ensure that decontamination 
procedures are adequate for the Biohazard(s) they handle. 

 

Warning! Internal Voltage. Turn off and unplug the 
instrument for all decontamination operations. 


Do not immerse the instrument, spray it with liquid, or use 
a “wet” cloth. Do not allow the cleaning solution to run into 
the interior of the instrument. If this happens, contact the 
BioTek Service Department. Do not soak the keypad.  


Wear prophylactic gloves when handling contaminated 
instruments. Gloved hands should be considered 
contaminated at all times; keep gloved hands away from 
eyes, mouth, nose, and ears.  Eating and drinking while 
decontaminating instruments is not advised. 


Mucous membranes are considered prime entry routes for 
infectious agents. Wear eye protection and a surgical mask 
when there is a possibility of aerosol contamination. Intact 
skin is generally considered an effective barrier against 
infectious organisms; however, small abrasions and cuts 
may not always be visible. Wear protective gloves when 
performing the decontamination procedure. 
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Tools and Supplies  

 0.5% sodium hypochlorite (NaClO, or bleach)  Surgical mask 

 70% isopropyl alcohol (as a bleach alternative)  Protective gloves 

 Deionized or distilled water  Lab coat 

 Priming plate  Biohazard trash bags 

 Safety glasses  Clean cotton cloths 
 

Autoclavable Components 

Autoclaving is an efficient method of sterilizing instrument components. For qualified 
items, it is a good alternative to some of the following decontamination procedures.  

Do autoclave: Do NOT autoclave: 

Peri-pump cassettes Washer manifolds 

16-Tube Syringe dispenser manifolds 32-Tube Syringe dispenser manifolds 

Syringe pump head Plate carrier 

All Syringe module tubing and bottles  

Priming trough inserts   

 

Decon Procedure for External Surfaces of the Instrument 

 

 

The bleach solution is caustic; wear gloves and eye 
protection when handling this solution.   

 

Caution!  Be sure to check the percent NaClO of the bleach 
you are using; this information is printed on the side of the 
bottle. Commercial bleach is typically 10% NaClO; if this is 
the case, prepare a 1:20 dilution. Household bleach is 
typically 5% NaClO; if this is the case, prepare a 1:10 
dilution. 

 

1 Turn the instrument off and disconnect the power cord. Empty the waste 
bottle. 

2 Unload the Peri-pump cassette and the prime trough inserts, and remove 
the Syringe dispenser manifold and tubing, if applicable.  

3 Autoclave the cassette and Syringe dispenser components, including the 
priming trough inserts.  

BioTek Instruments, Inc. 



Decontamination  |  133 

 Do not autoclave the 32-tube dispense manifolds. Review 
the list of non-autoclavable components above. 

4 Prepare an aqueous solution of 0.5% sodium hypochlorite (NaClO, or 
bleach). As an alternative, 70% isopropyl alcohol (or 70% ethanol) may be 
used if the effects of bleach are a concern.  

 Isopropyl alcohol is not recommended for removing proteins 
(such as bovine serum albumin).      

5 Moisten a cloth with the bleach solution or alcohol. Do not soak the 
cloth. 

 Wipe the keypad (do not soak). Wipe again with a clean cloth moistened 
with deionized or distilled water. Dry immediately with a clean, dry 
cloth. 

 Remove the mist shield if it is attached.  Wipe the inside and outside 
surfaces of the mist shield. Wipe the plate carrier, top surface of the 
instrument’s base, supply bottles and tubing, and all exposed surfaces of 
the instrument.  

6 Wait 20 minutes. Moisten a cloth with DI or distilled water. 

 Wipe the inside and outside surfaces of the mist shield. Wipe the plate 
carrier, top surface of the instrument’s base, supply bottles, tubing, bottle 
covers and all exposed surfaces of the instrument that have been cleaned 
with the bleach solution or alcohol. 

7 Use a clean, dry cloth to dry all wet surfaces. 

8 Reassemble the instrument as necessary.   

9 Discard the used gloves and cloths using a Biohazard trash bag and an 
approved Biohazard container. 
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Decon Procedure for Tubing and Manifold 

Two pre-defined protocols are provided. These protocols flush and soak the supply 
tubing and manifolds with disinfectant, then flush the system with rinse fluid.  

When using the LHC to control the instrument and with the Buffer Switching module 
installed, the washer protocols can be modified to run unattended. Otherwise, when 
using the LHC without the Buffer Switching module or when controlling the 
instrument from the keypad, manual intervention is required.   

Using the  Description 

Keypad: 

Protocols are 
loaded 
onboard at the 
factory. 

 W-DECON (07) – for the washer 

 S-DECON (08) – for the Syringe dispenser 
1.  At the main menu, press RUN. 

2.  Press Options to scroll to the desired protocol or use 
number keys to enter its number. 

3.  Press ENTER and follow the prompts. 

LHC: 

Protocols are 
installed on 
the host 
computer 
during 
installation. 

 

 W-DECONTAMINATE – for the washer 

 S-DECONTAMINATE – for the Syringe dispenser 

1. Select Open and locate the EL406 folder. 

2.  Open the EL406 folder to access the Maintenance folder. 

3. Select the desired protocol. 

When storing or shipping the instrument, the pre-defined LONG_SHUTDOWN 
protocols prime and soak the instrument, and end by pushing air through the system. 
The parameters can be edited for optimum cleaning. For example, consider using 
ethanol instead of air to complete the decontamination process. 

 Two supply bottles are required for this procedure: one for disinfectant, 
and one for rinse. Likewise for decontaminating the Syringe dispenser 
manifolds, the two supply bottles can be used for disinfectant and 
rinse.  

1. Turn the instrument off and disconnect the power cord.  

2. Empty the waste bottle. 

3. Prepare an aqueous solution of 0.5% sodium hypochlorite (NaClO, or 
bleach). 

4. Fill one supply bottle with at least 400 mL of bleach solution (disinfectant). 

5. Fill another supply bottle with at least 800 mL of deionized water (rinse). 
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Preparing to run W-DECON or W-DECONTAMINATE: 

Using the  Description 

Keypad with 
Buffer Switching 

Connect the supply bottles this way: 

 Buffer valve A: Disinfectant bottle 
 Buffer valve B: Rinse solution bottle 

Keypad without 
Buffer Switching 

Connect the disinfectant bottle to the Fluid In port. When the 
protocol is finished, connect the rinse bottle to the inlet port, 
and press REPEAT to rerun the protocol. 

  

LHC with Buffer 
Switching 

 

Connect the supply bottles this way: 

 Buffer valve A: Disinfectant bottle 
 Buffer valve B: Rinse solution bottle 

For unattended operation, change the Delay steps, make the 
delay a fixed time rather than indefinite.  

LHC without 
Buffer Switching 

 

Connect the disinfectant bottle to the Fluid In port.  

At the prompt, when the protocol is delayed, connect the rinse 
bottle to the inlet port, and press Continue to complete the 
protocol. 

Preparing to run S-DECON or S-DECONTAMINATE: 

Using the  Description 

Keypad  Connect the disinfectant bottle to the Syringe A port. When 
the protocol is finished, connect the rinse bottle to the port, 
and press REPEAT to rerun the protocol. 

Make a copy of the protocol and modify the copy for Syringe 
B, e.g. SB-DECON, and repeat the above procedure.  

  

LHC without 
Buffer Switching 

 

Connect the disinfectant bottle to the Syringe A port. At the 
prompt, when the protocol is delayed, connect the rinse bottle 
to the inlet port, and press Continue to complete the protocol. 

Copy the protocol, select File>Save As, assign it a unique 
name, e.g. SB-DECONTAMINATE, and modify it for Syringe 
B. Then, replicate the procedure. 

6. Reconnect the power cord and turn on the instrument. 

7. Run the decontamination protocols. 

 While the protocols are running, you will need to periodically check for 
prompts on-screen and follow the instructions. 

Alternate Decontamination Procedure for Tubing and Manifold 

If you are unable to run the decontamination protocols due to a system failure, 
perform the following alternate decontamination procedure to disinfect the 
internal tubing and manifolds. 
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Caution!  Be sure to check the percent NaClO of the bleach 
you are using; this information is printed on the side of the 
bottle. Commercial bleach is typically 10% NaClO; if this is 
the case, prepare a 1:20 dilution. Household bleach is 
typically 5% NaClO; if this is the case, prepare a 1:10 
dilution. 

 

1. Turn off the instrument and disconnect the power cord. 

2. Remove the mist shield, if it is attached.  

3. Using the 9/64” (3.57 mm) hex wrench, remove the screws, washers, and 
springs that hold the washer manifolds in place. Remove the manifolds.    

 Hold the two manifolds (and end plates) together as a single unit when 
removing and replacing them (except for the 128-tube model). 

4. Prepare an aqueous solution of 0.5% sodium hypochlorite (bleach). As an 
alternative, 70% isopropyl alcohol (or ethanol) may be used if the effects of 
bleach are a concern.  

 Isopropyl alcohol is not recommended for removing proteins (such 
as bovine serum albumin). 

5. Soak the tubing and manifold in the bleach or alcohol solution.   

6. Wait 20 minutes. Rinse the tubing and manifold with DI or distilled water. 

7. Use a clean, dry cloth to dry all wet surfaces of the tubes and manifold. 

8. Reassemble the washer manifold, making sure that the two o-rings are in 
place prior to reassembly. Do not over-tighten the manifold screws. 

9. Re-attach the mist shield.  

10. Prime the system by running W-DAY_RINSE or a similar Maintenance 
protocol. Watch for leaks. If fluid leaks out of the back of the instrument, 
firmly seat the tubing. If fluid leaks from the manifold, try disassembling 
and carefully reassembling. 

11. Discard the used gloves and cloths using a Biohazard trash bag and an 
approved Biohazard container. 

 

 

Caution: When reinstalling the manifold, only tighten 
the screw-washer-spring assembly that holds it in 
place until you feel the mechanical stop. Tightening 
past this point will damage the instrument and void 
your warranty. 
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Prepare for Storage or Shipment 

Before the EL406 is shipped or stored, the entire system should be rinsed and soaked with 
disinfectant and then purged of all fluid. Perform these steps when leaving the instrument 
unused for a long period of time. 

Long_Shutdown 

Two pre-defined protocols are provided: 

 W-LONG_SHUTDOWN (09)– for the washer 

 S-LONG_SHUTDOWN (10) – for the Syringe dispenser 

These LONG_SHUTDOWN protocols flush and soak the supply tubing and manifolds 
with disinfectant, then flush with rinse, and finally purge the system of fluid.   

 Three supply bottles are required for this procedure: one for 
disinfectant, one for rinse, and one for air. 

 

Caution!  Be sure to check the percent NaClO of the bleach 
you are using; this information is printed on the side of the 
bottle. Commercial bleach is typically 10% NaClO; if this is 
the case, prepare a 1:20 dilution. Household bleach is 
typically 5% NaClO; if this is the case, prepare a 1:10 
dilution. 

 

1 Turn the instrument off and disconnect the power cord.  

2 Unload the Peri-pump cassette and the prime trough inserts. Clean and 
store them separately. 

3 Empty the waste bottle. 

4 Prepare an aqueous solution of 0.5% sodium hypochlorite (NaClO, or 
bleach). 

5 Fill one supply bottle with at least 400 mL of bleach solution (disinfectant). 

6 Fill another supply bottle with at least 800 mL of deionized water (rinse). 

7 Keep the third supply bottle empty (air). 

When using the external Buffer Switching module, connect the supply 
bottles this way: 

 Valve A: Disinfectant bottle 

 Valve B: Rinse solution bottle 

 Valve C: Empty bottle 
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 When not using the Buffer Switching module, modify the protocol and 
connect the bottle containing disinfectant to the Fluid In port. 

8 Turn on the washer and run W-LONG_SHUTDOWN (09). 

9 When the washer has been cleaned and purged, repeat the process to clean 
and purge the Syringe dispensers, if applicable:  

 Prepare the supply bottles with disinfectant, rinse and air; 

 Run S-LONG_SHUTDOWN (10) three times for each manifold, one for 
each supply bottle.  

Storing the Washer Dispenser 

After performing the Long_Shutdown protocols: 

 Turn off the instrument and disconnect the power cord. 

 Store it on a flat surface that is relatively free of vibration, in a dust-free and 
particle-free environment. 

 Protect the instrument from temperature extremes that can cause 
condensation within the unit and from corrosive fumes and vapors. 

 Store the instrument under the following environmental conditions:  

Temperature:  –20° to 50°C (-4° to 122°F) 

Relative humidity: 10% to 85% (non-condensing) 

 Important: Allow the instrument to reach room temperature before 
use after storage. 
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Replace Components 

Some components of the EL406 must be replaced periodically to maintain specified 
performance levels.  

Washer Components 

Find instructions for changing the manifold in Appendix B. 

Replace Vacuum Pump Fuse 

 

Spare fuses (PN 46055) are shipped with the instrument in case the 
pump blows a fuse. To change the fuse: 

1. Locate the Accessory Fuse port on the rear panel below 
the Accessory Outlet for the vacuum pump. 

2. Use a screwdriver to open the port and release the fuse. It 
has a spring action. 

3. Replace the fuse and reinstall. 

 

Washer O-Rings and Channel-End Seals 

 Important: This is not applicable to the 128-tube aspirate manifold. 
The plugs in its aspirate manifold are the same as those used in the 
Syringe dispenser manifolds: PN 45090. 

For optimal performance and to extend the life of the washer, replace the manifold 
o-rings once a year and replace the 12 (or 24) rubber plugs (seals) on the channel ends 
if they show signs of cracking or drying out. Order the replacement o-rings and seals 
from BioTek: 

 O-rings: PN 49941 

 Channel-end seals: PN 49486 

You must remove the washer manifold to change the o-rings and seals, so these tasks 
work best in conjunction with the Washer Maintenance procedure on page 116.  

Replacing the O-Rings 

After cleaning and rinsing the manifold: 

1. Using your fingers or an appropriate tool, such as a very small, flat 
screwdriver, remove the two o-rings that are exposed when the 
manifold is removed. 

2. Replace the used o-rings with new ones by fitting them into the 
grooved slots. 
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3. If you are NOT replacing the channel end-seals at this time, reinstall the 
manifold. Do not over-tighten the manifold screws. 

 

Caution: When reinstalling the manifold, only tighten the 
screw-washer-spring assembly that holds it in place until 
you feel the mechanical stop. Tightening past this point 
will damage the instrument and void your warranty. 

 
 

Replacing/Cleaning the Channel-End Seals 

 Important: This is not applicable to the 128-tube aspirate manifold.  

If the channel-end seals do not need to be replaced, they should be washed 
with mild detergent or alcohol. 

1. Remove the manifold end plates to access the channel-end seals. 
 

 
Channel-end seals 

Manifold end plate 

Manifold screws, 
washers, springs 

Front facing of manifold 

              Replacing the Channel-End Seals 

The manifold end plate sits in front of the manifold and holds the 
screws, washers, and springs that hold the manifold in place. The 
channel-end seals sit in bored holes in the backside of the plate, facing 
the manifold’s channels. The manifold end plate has markings to 
indicate its position relative to the manifold, e.g., Top or Bottom. 

2. Using an appropriate tool, such as a very small, flat screwdriver or a 
paper clip, remove the seals from the manifold end plate.  

 

 

Caution: Do not grease any parts of this mechanism. 
Lubricate the seals and the bored holes with alcohol to 
assist with reinsertion. 

3. Clean the seals if you are not replacing them with new ones. 
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4. Lubricate both the seals and the bored holes with 70% isopropyl alcohol 
to facilitate insertion of the seals. Make sure the seals sit firmly in the 
bored holes in the manifold end plate. 

 The 9/64” (3.57 mm) hex wrench shipped with the instrument is useful 
for reinserting the seals into the bored holes. 

5. When all of the seals are in place, reinstall the manifold end plates and 
the manifold. Do not over-tighten the manifold screws. 

 

 

Caution: When reinstalling the manifold, only tighten the 
screw-washer-spring assembly that holds it in place until 
you feel the mechanical stop. Tightening past this point 
will damage the instrument and void your warranty. 

Peri-pump Components 

Replace Peri-pump Tubing 

BioTek provides replacement tubing kits as an alternative to buying a new 
cassette. Purchase the replacement tubing kits from BioTek and follow the 
instructions shipped with the kit or on the Operator’s Manual CD in the PDF 
folder, titled: 7171017_(current Rev)_Replacing the tubing_8x14.PDF. For 
the best experience with these instructions print them on legal size paper (8½” x 
14”). 

Recalibrate the Peri-pump Dispense Cassette 

Calibration Kit 

BioTek offers an accessory for recalibrating dispense cassettes. The Calibration Kit 
speeds up the recalibrating process and is useful for verifying performance, one of the 
recommended monthly maintenance routines. 

Follow the instructions shipped with the kit or find them on the Operator’s Manual CD 
in the PDF folder, titled: 7171009_(current Rev)_Calibration Kit 
Instructions.PDF.  

Gravimetric Method  

The alternative and most precise method for calibrating a cassette is the gravimetric 
method. Find the instructions on the Operator’s Manual CD in the PDF folder, titled: 
7171024_(current Rev)_Calibrating Gravimetrically.PDF 

EL406 Washer Dispenser 



142  |  Chapter 4: Maintenance 

Syringe Dispenser Components 

Replace Syringe Dispenser Check Valve 

You can order replacement check valves from BioTek Customer Care if your check 
valves become clogged and cleaning them does not solve the problem: 

 PN 68083 – Autoclavable valves for use with non-organic substances.  

 PN 68073 – Check valves recommended for use with organic substances.  

 If you observe a decline in performance after changing the check 
valves, recalibrate the backlash, as described below. 

Recalibrate the Backlash 

 Important Prerequisite: The EL406 Interface Software (IS) is 
required to update the instrument’s backlash setting. You must be 
controlling the EL406 with the LHC software or obtain a copy of the 
EL406 IS Utility from BioTek’s customer resource center: 
https://customer.biotek.com.  

 1536-well models: All Syringe dispensers are calibrated for use with 
their 16-tube dispense manifolds. When dispensing with the 32-tube 
dispensers, use this procedure to determine if a backlash adjustment 
improves dispense accuracy.  

Equipment Required 

 Precision balance with minimum capacity of 100 g and readability of 0.001 g 
resolution  

 Supply bottle with deionized water 

 384-well plate for 16-tube manifolds or 1536-well plate for 32-tube manifolds 
(acceptable substitute: cover of 96-well microplate) 

Setup 
While calibrating and testing, try to maintain a steady liquid level in the supply 
bottle, keeping it half full. Start with more fluid to allow for priming. Connect the 
supply bottle to the Syringe under test. Make sure the supply bottle is at the 
same level as the dispenser.  

Create a Dispense Protocol 

Create a protocol that dispenses the correct volume for the manifold under test: 

 16 tube manifold: 20 L per well to a 384-well plate at Flow Rate 2.  

 32 tube manifold: 6 L per well to a 1536-well plate at Flow Rate 2.  
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Prime and Dispense 

1. Run a prime protocol, for example, S-DAY_RINSE, or S-DAY_RINSE_A&B 
when both Syringe pumps need calibration, to remove air bubbles from the 
tubing. 

2. Place the plate on the balance, and tare the balance. 

3. Place the plate onto the carrier and run the dispense protocol created above. 

4. Upon completion, carefully remove and reweigh the plate to determine the 
Actual Weight.  

5. The Expected Weight is: 

 16-Tube =  7.680 grams 

 32-Tube =  9.216 grams 

6. Calculate the volume (weight) error and the backlash adjustment that needs to 
be made:  

16-Tube: 7.680 – Actual Weight ÷ 24 ÷ .0033 = backlash setting 

32-Tube: 9.216 – Actual Weight ÷ 48 ÷ .0033 = backlash setting 

 Subtract the Actual Weight from the Expected Weight and divide by the 
number of columns dispensed to.  

 Divide the result by 0.0033 and round to the nearest whole number.  

Example: 7.680 - 7.550 = 0.130, 0.130/24 = 0.00542, 0.00542/0.0033 = 1.64 
rounded to 2. The backlash setting needs to be adjusted by 2. 

7. Adjust the backlash as necessary: select Tools>Instrument Utilities> 
Syringe Dispenser and enter the number of steps in the corresponding 
Backlash fields in the Calibration Data group box. 

8. Repeat steps 1 through 4 until the volume dispensed is within one backlash 
unit of being exact: ± 0.119 grams. 
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Overview 

Instrument verification for the EL406™ involves three activities:  qualification of 
installation and setup, qualification of routine capability, and qualification of long-term 
stability.  This chapter refers to these activities as Installation Qualification (IQ), 
Operational Qualification (OQ), and Performance Qualification (PQ), respectively.  

Verification testing includes:  

 The System Self Test verifies system components, such as the vacuum, 
manifold, and carrier positioning. The Checksum Test verifies the basecode 
software against internal checksum values to ensure that no corruption has 
occurred.  

Washer 

 Evacuation Efficiency: This test measures the residual volume per well after 
aspiration. The lower the residuals per well, the better the evacuation efficiency of 
the washer.   

 Dispense Precision: This test measures the variability of volumes dispensed 
from tube to tube across the manifold.    

 Buffer Switching Valve Module: This annual test measures the variability of 
volumes dispensed from tube to tube across the manifold when using the buffer 
switching module.  

Peri-pump and Syringe Dispensers  

 Dispense precision is a measure of the variability of volumes dispensed from 
tube to tube across the manifold or tip holder. The optical density of the solution in 
a well is proportional to the total volume of the solution in the well. When the % 
Coefficient of Variation (%CV) is calculated, the result is a measure of the 
uniformity of the distribution of dispensed volumes across the manifold. It is the 
ratio, expressed in percent, of the standard deviation of the distribution of fluid 
volumes in the wells to the mean value of volume per well. The uniformity of 
distribution across the manifold improves as the %CV is lowered.    

 Dispense accuracy is a measure of the average volume dispensed per well. It is 
independent of precision. The volume per well may vary greatly over a plate, yet 
the accuracy may be exact because it is an average of the volumes. 

 

Verification Schedule 

The following schedule defines the factory-recommended intervals for verification tests for 
an instrument used two to five days a week.  The schedule assumes that the EL406 is 
properly maintained as outlined in Chapter 4, Preventative Maintenance.  
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 Note: An instrument qualification package (PN 7180527) is available 
for purchase. The package contains thorough procedures for 
performing Installation Qualification, Operational Qualification and 
Performance Qualification (IQ-OQ-PQ) and preventative maintenance 
(PM). Extensive Checklists and Logbooks are included for recording 
results. Contact your local dealer for more information. 

Recommended Instrument Verification Schedule  

IQ OQ PQ 
Tests  

Initially Initially Annually Monthly 

Unpacking, Installation, and Setup     

Verify/Enable System Sensors     

System Self Test and  
Checksum Test  

    

Shake Test     

Ultrasonic Cleaner Test      

Washer Evacuation Efficiency Test     

Washer Dispense Precision Test     

Buffer Switching Dispense Test      

Peri-pump Dispense Precision and 
Accuracy Test     

Syringe Dispense Precision and 
Accuracy Test     

Run Assay     

 
 


Important!  The risk factors associated with your assays 
may require that the Operational and Performance 
Qualification procedures be performed more or less 
frequently than shown above. 

IQ/OQ/PQ 

Installation Qualification (IQ) confirms that the EL406 and its components have been 
supplied as ordered and ensures that they are assembled and configured properly for your 
lab environment.  
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 The recommended IQ procedure consists of setting up the instrument as 
described in Chapter 2, Installation and then performing the System  
Self-Test and the Checksum test. 

 The IQ procedure should be performed initially (before the washer is used for 
the first time).  

 The successful completion of the IQ procedure verifies that the instrument is 
installed correctly. The Operational Qualification procedure (see below) should 
be performed immediately following the successful IQ. 

 

Operational Qualification (OQ) confirms that the EL406™ operates according to 
specification initially and over time. 

 The recommended OQ procedure consists of performing the System Self-Test 
and the Checksum, Evacuation Efficiency, and Dispense Precision and 
Accuracy tests.  

 Your facility’s operating policies may also require you to perform an actual 
assay prior to accepting the instrument for routine use. Do not use the data 
obtained from the first assay until you have confirmed that the assay kit criteria 
have been met.   

 The OQ procedure should be performed initially (before first use) and then 
routinely; the recommended interval is annually. It should also be performed 
after any major repair or upgrade to the hardware or software. 

 Although out-of-tolerance failures will be detected by the OQ tests, results 
should be compared with those from the monthly Performance Qualification 
tests and previous OQ tests to monitor for trends. 

 The successful completion of the OQ procedure, in combination with results 
that are comparable to previous PQ and OQ tests, confirms that the instrument 
is performing consistently over time. 

 

Performance Qualification (PQ) confirms that the EL406 consistently meets the 
requirements of the tests performed at your laboratory. 

 The recommended PQ procedure consists of performing the System Self-Test 
and the Checksum, Evacuation Efficiency, and Dispense Precision tests.  

 Your facility’s operating policies may also require that you routinely perform 
an actual assay, to confirm that the instrument will consistently give adequate 
results for the assays to be run with it. 

 These tests should be performed routinely; the recommended interval is 
monthly. This frequency may be adjusted depending on the trends observed 
over time. 

 The successful completion of the PQ procedure confirms that the instrument is 
performing consistently under normal operating conditions. 
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Important Recommendations for All Liquid Tests 

Test Solutions 

 Using pure deionized water in place of the test solutions, e.g., Solution #1, is 
not recommended and will likely result in the failure to meet specifications. 

 Prepare the solutions the day before you plan to run the tests. This will allow 
any foam caused by the agitation of solutions containing Tween® 20 to settle. 

 BioTek determined the pass/fail specifications for the instrument tests using 
the recommended test solutions. You may use your own buffer solution 
instead, but if any tests fail using your own buffer, retry the tests using the 
recommended solutions. 

Plate Reading 

 If you are using one of BioTek’s keypad-based readers, such as the ELx800 or 
ELx808, ensure that the reader is not running in Rapid mode. To check the 
setting, select UTIL  READ and cycle through the options until READ IN 

RAPID MODE? appears. Set it to NO.  

 The absorbance of blue dye solutions should be measured at 630/450 (or 405) 
nm. The BioTek blue dye solution part number is 7773001. 

 The absorbance of yellow dye solutions should be measured at 450 (or 405)/630 
nm. The BioTek yellow dye solution part number is 7120782. 

 The final absorbance for all dye solution concentrations should be in a range 
between 0.700 and 1.300 OD. 

Recording Test Results 

 Liquid Test Worksheet templates can be found at the end of each test’s 
instructions for recording data reduction results. If your tests are failing, this 
information will be useful for BioTek TAC to help diagnose any problems. 
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System and Checksum Tests 

 The information from the System and Checksum Tests is 
important if you need to contact BioTek. 

 

The System Self-Test is performed automatically whenever the instrument is powered 
on. They can also be run manually. 

System Self-Test 

The System Self-Test checks the vacuum (when run manually), manifold, and 
manifold-to-carrier positioning.  

Using the Description 

Keypad 1.  Press Setup Menu. 

2.   Select the arrow.  

3.  Select TESTS. 

4.  Select SLFCHK. 

LHC 1. Select Tools > Instrument Utilities. 
2.  Under “General Settings,” click Perform Self-check. 

If the test passes, a passing message is displayed.  

If the test fails, an error message is displayed. Look up the error code in 
Appendix A, Error Codes, to determine its cause. If the problem is something you 
can fix, turn off the EL406, fix the problem, and then turn instrument back on. If 
the cause is not something you can fix, contact BioTek’s Technical Assistance 
Center. 

Checksum Test 

The Checksum Test compares the on-board software with an internally recorded 
checksum value to ensure the program has not become corrupted.  

To run the Checksum Test: 

Using the  Description 

Keypad 1.  Press Setup Menu. 

2.    Select the arrow (for more options) twice. 
3.  Select TESTS. 
4.  Select CHKSUM. 
5.  Reveal and record the values one at a time, UI and MC. 

 Setup 
 Menu 

 Setup
 Menu
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LHC 1. Select Tools > Instrument Utilities. 
2. Under “General Settings,” find the EL406 Basecode Software 

Information group box and record the 
 Software version and part number (e.g. PN 7180201), 

 Data version, 

 UI and MC Checksum values.  

Shake Test 

Perform this test to verify that the instrument’s plate shaker is operating properly. 

1. Create a simple protocol with a Shake step. Define a brief Shake Duration and 
choose any intensity. 

2. Run the protocol. While it is running, visually verify that the plate shakes for the 
specified duration.  

3. Verify that the program completes without error.  

 If the plate shaker does not operate as expected, contact BioTek for assistance. 

Ultrasonic Cleaner Test 

Perform this test to verify that the cleaner is operating properly. 

1. Fill the supply bottle with one liter of deionized water.  

2. Create a protocol with an AutoClean step. Set the Duration to 00:02 (2 
minutes). 

3. Run the protocol.  

4. While the AutoClean program is running, the ultrasonic cleaner should pulse on 
and off approximately every ten seconds (a 50% duty cycle). While the program is 
running, listen for the periodic “hissing” sound that indicates the ultrasonic 
energy is present. Detecting the sound is all that is required to verify that the 
ultrasonic cleaner is operating properly. After two minutes, the washer will 
aspirate the fluid and the program will be complete. 

 Special Procedures for 1536-well Hardware:  
~ Connect a bottle of cleanser or water to the Dispense Fluid In port 
on the rear of the instrument to use the single priming tube in the 
128-tube aspirate manifold to fill the priming trough (ultrasonic bath); 
~ The 128-tube aspirate manifold cannot completely evacuate the 
priming trough. When AutoClean is finished, manually remove the 
residual liquid using a pipette, paper towel or other method.  

 If the ultrasonic cleaner does not operate as described above, contact BioTek for 
assistance. 
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Washer Liquid Tests 

Evacuation Efficiency Test 

The Evacuation Efficiency test measures the residual volume (mean residual weight) 
per well after aspiration is performed. The lower the residual per well, the better the 
evacuation efficiency of the washer. A known solution is dispensed into all wells of a 
previously weighed microplate. Aspiration is performed and the plate is reweighed. 
The total residual fluid is calculated based on the weight difference, and this value is 
divided by 96, 384 or 1536, as appropriate, to obtain the mean residual weight.  

If further testing is necessary (to identify “problem” wells), the supplemental test is 
performed. A known dye concentration is dispensed to and evacuated from the wells, 
and the plate is weighed. Buffer is then pipetted to all wells to bring the volume of 
fluid to a more optically measureable volume. The optical density (OD) of each well is 
measured and the background is subtracted to account for scratches on the plate or 
particulates in a well. Each well’s residual volume is calculated using its OD and a 
calibration factor derived from the mean residual weight and the mean OD of all wells 
on the plate. It is assumed that 1 mg = 1 µL of fluid for this calculation.  

Dispense Precision Test 

The Dispense Precision Test measures the variability of the volumes dispensed 
from tube to tube across the manifold. In this test, a blue dye solution is dispensed into 
a microplate. The optical density of each well is measured at 630 nm and the 
background at 450 nm is subtracted to account for scratches on the plate or particulates 
in the well. The average error percentage is calculated and the amount dispensed to 
each well is calculated. Acceptance is based on the %CV (%Coefficient of Variation), or 
the ratio of the standard deviation of the distribution of fluid volumes in the wells to 
the mean value of volume per well. The lower the %CV, the better the uniformity 
across the manifold.   

Annual Buffer Switching Module Test: The Dispense Precision test is conducted 
for the external buffer module to ensure that each valve (A, B, C, D) is calibrated to 
deliver the same volume of fluid.  
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Manifold-Specific Tests 

Perform the tests applicable to the installed manifold type. And, for washers 
equipped with the external buffer switching module, there is an annual test for each 
valve:  

Manifold Type  Liquid Tests to Perform Page 

Evacuation Efficiency Test (96) 157 
96-tube 

Dispense Precision Test (96) 157 

Evacuation Efficiency Test (192) 160 
192-tube 

Dispense Precision Test (192) 160 

128-tube Evacuation Efficiency Test (1536) 164 

 

Buffer Switching Module Annual Buffer Valve Test 163 

Pre-defined Test Protocols 

Several EL406 protocols are shipped onboard the instrument and with the EL406 
Interface Software (IS), which installs them on your computer during LHC 
installation. They include the protocols required to perform the Liquid Tests: 

Pre-defined Protocols Keypad Number 
W-DAY_RINSE  01 
W-96_EVAC_TEST  16 
W-192_EVAC_TEST 18 
W-1536_EVAC_TEST 19 
W-96_DISP_TEST 15 
W-192_DISP_TEST 17 

 1536-well washing using the 32- tube Syringe dispenser to dispense 
fluid. Perform the Syringe dispenser tests to verify dispense 
accuracy and precision. Then, use the same plate to test Evacuation 
Efficiency.  
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Default Parameters for the Liquid Test Protocols 
 

Evacuation Efficiency Tests 

 W-96_EVAC_TEST W-192_EVAC_TEST W-1536_EVAC_TEST 

Aspirate 
Height (Z) 

  28  (3.556 mm)   16  (2.03 mm) 40 (5.08 mm) 

X Position   -50  (-2.29 mm)   00 (0 mm)   00 (0 mm) 

Y Position    2  (0.15 mm)   00 (0 mm)   00 (0 mm) 

Travel 
Rate 

   2  (3.4 mm/sec)   3  (4.0 mm/sec)   3  (4.0 mm/sec) 

Delay   0   0   0 

Secondary 
Aspirate  

  No   No   No 

 

Dispense Precision Tests 

 W-
96_DISP_TEST 

W-
192_DISP_TEST 

S-
1536_DIS_TEST 

Buffer Valve A A 

Dispense Volume 300 µL/well 80 µL/well 

Flow Rate 6 7 

Dispense Height 
(Z) 

120 120 

X Position 00 00 

Y Position 00 00 

Pre-dispense No No 

See Syringe 
dispenser tests 
beginning on 

page 185.  
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Required Materials  

 One new microplate per test to be performed: 
 

Microplate Type Liquid Tests 

Evacuation Efficiency Test (96) 

Dispense Precision Test (96) 
Flat-bottom 96-well plates, 
Corning® Costar #3590 or 
equivalent 

Annual Buffer Valve Test 
 

Evacuation Efficiency Test (192) 

Dispense Precision Test (192) 
Flat-bottom 384-well plates, 
Corning Costar or equivalent 

Annual Buffer Valve Test 
 

Standard 1536-well plates, 
Nunc® #264710 or equivalent 

Evacuation Efficiency Test (128) 

 Precision balance with minimum capacity of 100 g and readability of 0.001 g 
resolution 

 Pipettes and graduated beakers 

 Microplate absorbance reader capable of dual wavelength reading at  
630/450 nm  

 Liquid Test Worksheets at the end of this chapter for recording data and results  

 Deionized water 

 Test solutions: 
   

Prepare these solutions, using  
the instructions on the next page: 

If this 
manifold is 
installed: Sol. #1 Sol. #2 Sol. #3 Sol. #4 

96-Tube  
1 batch 

(1000 mL) 
1 batch 

(100 mL) 
1 batch 

(1200 mL) 
n/a 

192-Tube 
1 batch 

(2000 mL) 
1 batch 

(100 mL) 
n/a 

1 batch 
(1440 mL) 

128-Tube 
1 batch 

(100 mL) 
   

 

 These volumes are sufficient for performing the Dispense Precision 
Test, the Evacuation Efficiency Test, and the additional Evacuation 
Diagnostic Procedure (if necessary). In most cases, enough fluid will 
be left over to re-run a test, if necessary. 
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 If you will be performing the Annual Buffer Switching Test, you will 
need several additional liters of DI water. 

Test Solutions 
 
 

SOLUTION #1:  Buffer Solution 

Pipette 1 mL Tween 20 into  
1 liter (1000 mL) of deionized 
water and mix well. 

or 
Pipette 10 mL of BioTek Wetting Agent* 
into 1 liter of deionized water and mix 
well. 

    * BioTek Solution #1 100X Concentrate Wetting Agent 125 mL (PN 7773002) contains  
      10% Tween 20 in deionized water and 0.01% Sodium Azide as a preservative. 
 

SOLUTION #2:  Residual Test Solution 

Mix 100 mL of Solution #1 
with 0.050 grams of FD&C #1 
blue dye. 

or 
Mix 90 mL of Solution #1 with 10 mL  
of BioTek Blue Test Dye*. 

    * BioTek Solution #2 10X Concentrate Blue Test Dye 125 mL (PN 7773001) contains 5 g 
      per liter FD&C Blue #1, 0.1% Tween 20 in deionized water and 0.01% Sodium Azide as 
      a preservative. 
 

SOLUTION #3:  Dispense Precision Solution for 96-Tube manifolds 

Mix 1180 mL of deionized water with 20 mL of Solution #2. 

 

SOLUTION #4:  Dispense Precision Solution for 192-Tube manifolds 

Mix 1420 mL of Solution #1 with 20 mL of Solution #2. 
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Dispense Precision Test (96) 

 This test is designed for 96-Tube manifolds. See page 160 if you’re 
looking for the Dispense Precision Test for the 192-Tube manifold. 

 See page 155 for a list of required materials.  

 When this test is complete, the dispensed plate can be used to 
perform the Evacuation Efficiency Test (see page 158). 

1. Fill a supply bottle with 2 liters of DI water; Buffer Switching units use 
Buffer valve A. Run the W-DAY_RINSE protocol two or three times to 
prime the fluid lines and manifold. 

2. Fill a supply bottle with 1200 mL of Solution #3; Buffer Switching units 
use Buffer valve A. 

3. Run W-DAY_RINSE again to prime the washer with the solution. 

4. Place a new 96-well microplate on the carrier and run the 
W-96_DISP_TEST.  This protocol dispenses 300 L of solution to each 
well of the plate.  It does not evacuate the solution. 

5. When the program is completed, carefully remove the plate. 

6. Read the plate in an optical reader (blank on air), using the 
dual-wavelength method (630 nm - 450 nm), then print or export the 
results. 

7. Using the Dispense Precision Test Worksheet on page 166, perform data 
reduction: 

a. Calculate the Standard Deviation.  

Tip: If you have a spreadsheet software program, enter/export all  
96 values into a spreadsheet and apply your program’s Standard 
Deviation function (e.g., Microsoft® Excel’s STDEV). 

b. Calculate the sum of the OD values for all 96 wells, then divide by 96 to 
determine the Mean OD for the plate.  

c. Calculate the %CV: (Standard Deviation / Mean OD) * 100. 

The %CV should be <= 3.0. 

If the %CV is greater than 3.0, one or more dispense tubes may need to 
be cleaned. Run AUTOCLEAN, and/or remove the manifold and use the 
stylus to clean the dispense tube(s) giving lower-than-average 
absorbance readings. When finished, re-prime the washer and retry the 
test. 

8. When finished, prime with deionized water to flush out the dye solution. 
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Evacuation Efficiency Test (96) 

 This test is designed for 96-Tube manifolds. See page 160 if you’re 
looking for the Evacuation Efficiency Test for the 192-Tube manifold. 

 If you tared the balance at the start of the Dispense Precision Test 
(96), the plate from that test can be used here; skip steps 1-3. 

1. Fill a supply bottle with 2 liters of DI water. Run the Maintenance program 
W-DAY_RINSE two or three times to prime the tubing and manifold. 

2. Place a new 96-well microplate on the balance and zero the balance. 

3. Pipette or dispense 300 L of Solution #1, 2, or 3 (your choice) into each 
well of the microplate. 

4. Place the plate on the carrier and run the W-96_EVAC_TEST protocol.  This 
protocol evacuates the wells, leaving a small amount of residual fluid. 

5. When the program is completed, remove the plate and weigh it immediately 
because evaporation will affect the results.  This is the Total Residual 
Weight, in grams. 

6. Visually inspect the plate and note if any wells appear to have considerably 
more liquid than others. 

7. Using the worksheet on page 167, perform initial data reduction: 

 Divide the Total Residual Weight by 96 to find the Mean Residual Weight. 

 The Mean Residual Weight should be <= 0.002 g. 
 
If the Mean Residual Weight is greater than 0.002 g, or if one or more wells appear to 
have much more liquid than the others, the washer failed the test.  

If the test fails once, Troubleshoot as follows:  

 If the problem appears to be related to particular wells, clean those aspiration 
tubes: run AutoClean, and/or remove the manifold and thoroughly clean the 
tubes with the stylus (see Chapter 5, Maintenance for instructions.) When 
finished, retry the test. 

 Failure of this test is commonly caused by improper aspiration tube 
positioning, usually because a microplate other than the recommended 
Corning Costar® 96 was used. If you prefer to use a different plate, modify the 
Aspirate Positioning, i.e., Z-axis to fix the height, or X- or Y-axes 
parameters in a copy of the W-96_EVAC_TEST protocol.  After making 
needed changes, retry the test using a new microplate. 

If you are using the Corning Costar 96 microplate, run AutoClean and/or 
remove the manifold and clean the aspiration tubes with the stylus. When 
finished, retry the test using a new microplate. 

 If the test fails a second time: perform the diagnostic procedure below. 
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Evacuation Diagnostic Procedure 

Perform these steps if the Evacuation Efficiency Test fails twice. This test will confirm which 
aspirate tube(s) may be clogged, or if the plate’s alignment or position is the problem. 

1. If you have not already done so, repeat steps 2 through 7 of the previous 
test, using Solution #2 for the dispense fluid. Be sure to recalculate the 
Mean Residual Weight. 

2. Pipette or dispense 300 L of Solution #1 into each well, on top of the 
residual solution. 

3. Shake the plate to achieve uniform distribution of the remaining dye in each 
well. 

4. Read the plate in an optical reader (blank on air), using the 
dual-wavelength method (630 nm - 450 nm), then print or export the 
results. 

5. Using the worksheet on page 167, perform data reduction: 

 Calculate the sum of the OD values for all 96 wells, then divide by 96 to 
determine the Mean OD for the plate. 

 Divide the Mean OD by the Mean Residual Weight (from step 1), to 
find the Residual Factor. 

 For each well, divide its OD value by the Residual Factor to find its 
Residual Weight. 

Each well’s Residual Weight should be <= 0.002 g. 

If one or more wells have a Residual Weight greater than 0.002 g, review the 
data to determine which well, or wells, is causing the problem.  

 If the problem appears to be related to particular wells, clean the 
associated aspiration tubes: run AutoClean and/or remove the 
manifold and thoroughly clean the tubes with the stylus. See Chapter 4, 
Maintenance for complete instructions. When finished, retry the test.  

 If the problem appears to be related to a particular region, edge, or 
corner of the plate, review the alignment and flatness of the plate on the 
carrier.   

 Please do not adjust the carrier adjustment screws! Contact your 
BioTek dealer if you suspect an alignment problem. 

 For additional suggestions, see Chapter 6, Troubleshooting.  

 If the test continues to fail, contact BioTek Instruments. 



160  |  Chapter 5: Qualification 

Dispense Precision Test (192) 

 This test is designed for the 192-Tube manifold. See page 157 if 
you’re looking for the Dispense Precision Test for 96-Tube manifolds. 

 See page 155 for a list of required materials.  

 When this test is complete, the dispensed plate can be used to 
perform the Evacuation Efficiency Test (see page 161). 

1. Fill a supply bottle with 2 liters of DI water; Buffer Switching units use 
Buffer valve A. Run the W-DAY_RINSE protocol two or three times to 
prime the fluid lines and manifold. 

2. Fill a supply bottle with 1440 mL of Solution #4; Buffer Switching units 
use Buffer valve A. 

3. Run W-DAY_RINSE again to prime the washer with the solution. 

4. Place a new 384-well microplate on the carrier and run the 
W-192_DISP_TEST protocol.  This protocol dispenses 80 L of solution to 
each well of the plate.  It does not evacuate the solution. 

5. When the program is finished, carefully remove the plate. 

6. Read the plate in an optical reader (blank on air), using the 
dual-wavelength method (630 nm - 450 nm), then print or export the 
results. 

7. Using the Dispense Precision Test Worksheet on page 169, perform data 
reduction: 

a. Calculate the Standard Deviation.  

Tip: If you have a spreadsheet software program, enter/export all 384 
values into a spreadsheet and apply your program’s Standard Deviation 
function (e.g., Microsoft Excel’s STDEV). 

b. Calculate the sum of the OD values for all 384 wells, then divide by 384 
to determine the Mean OD for the plate.  

c. Calculate the %CV: (Standard Deviation / Mean OD) * 100. 

The %CV should be <= 4.0. 

If the %CV is greater than 4.0, one or more dispense tubes may need to 
be cleaned. Run AutoClean and/or remove the manifold and use the 
stylus to clean the dispense tube(s) giving lower-than-average 
absorbance readings. When finished, re-prime and retry the test. 

8. When finished, prime with deionized water to flush out the dye solution. 
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Evacuation Efficiency Test (192) 

 This test is designed for the 192-Tube manifold. See page 157 if you’re 
looking for the Evacuation Efficiency Test for 96-Tube manifolds. 

 See page 155 for a list of required materials.  

 If you tared the balance at the start of the Dispense Precision Test, the 
plate from that test can be used here; skip steps 1-3. 

1. Fill a supply bottle with 2 liters of DI water. Run the W-DAY_RINSE protocol 
two or three times to prime the fluid lines and manifold. 

2. Place a new 384-well microplate on the balance and zero the balance.  

3. Pipette or dispense 80 μL of Solution #1 into each well of the microplate. 

4. Place the plate on the carrier and run the W-192_EVAC_TEST.  This protocol 
evacuates all of the wells, leaving a small amount of residual fluid. 

5. When the program is completed, remove the plate and weigh it immediately 
because evaporation will affect the results.  This is the Total Residual 
Weight, in grams. 

6. Visually inspect the plate and note if any wells appear to have considerably 
more liquid in them than others. 

7. Using the Evacuation Efficiency Test Worksheet on page 170, perform initial 
data reduction:  

a. Divide the Total Residual Weight by 384 to find the Mean Residual 
Weight. 

b. The Mean Residual Weight should be <= 0.002 g. 

If the Mean Residual Weight is greater than 0.002 g, or if one or more wells appear to 
have much more liquid than the others, the washer failed the test.  

If the test fails once, Troubleshoot as follows:  

 If the problem appears to be related to particular wells, clean those aspiration 
tubes: run AutoClean, and/or remove the manifold and thoroughly clean the 
tubes with the stylus (see Chapter 5, Maintenance for instructions.) When 
finished, retry the test. 

 Failure of this test is commonly caused by improper aspiration tube 
positioning, usually because a microplate other than the recommended 
Corning Costar® 384 was used. If you prefer to use a different plate, modify 
the Aspirate Positioning, i.e., Z-axis to fix the height, or X- or Y-axes 
parameters in a copy of the W-192_EVAC_TEST protocol.  After making 
needed changes, retry the test using a new microplate. 

If you are using the Corning Costar 384 microplate, run AutoClean and/or 
remove the manifold and clean the aspiration tubes with the stylus. When 
finished, retry the test using a new microplate. 
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 If the test fails a second time: perform the diagnostic procedure below. 

Evacuation Diagnostic Procedure (192) 

Perform these steps if the Evacuation Efficiency Test (192) fails twice. This test will confirm 
which aspirate tube(s) may be clogged, or if the plate’s alignment or position is the problem. 

1. If you have not already done so, repeat steps 2 through 7 of the previous 
test, using Solution #2 for the dispense fluid. Be sure to recalculate the 
Mean Residual Weight. 

2. Pipette or dispense 80 L of Solution #1 into each well, on top of the 
residual solution. 

3. Shake the plate to achieve uniform distribution of the remaining dye in each 
well. 

4. Read the plate in an optical reader (blank on air), using the dual-
wavelength method (630 nm - 450 nm), then print or export the results. 

5. Using the Evacuation Diagnostic worksheet on page 170, perform data 
reduction: 

a. Calculate the sum of the OD values for all 384 wells, then divide by 384 
to determine the Mean OD for the plate. 

b. Divide the Mean OD by the Mean Residual Weight (from step 1) to 
find the Residual Factor. 

c. For each well, divide its OD value by the Residual Factor to find its 
Residual Weight. 

Each well’s Residual Weight should be <= 0.002 g. 

If one or more wells have a Residual Weight greater than 0.002 g, review the 
data to determine which well, or wells, is causing the problem.  

 If the problem appears to be related to particular wells, clean the 
associated aspiration tubes: run AUTOCLEAN and/or remove the 
manifold and thoroughly clean the tubes with the stylus (all models). See 
Chapter 4, Preventive Maintenance for complete instructions. When 
finished, retry the test. 

 If the problem appears to be related to a particular region, edge, or 
corner of the plate, review the alignment and flatness of the plate on the 
carrier.  

 Please do not adjust the carrier adjustment screws! Contact your 
BioTek dealer if you suspect an alignment problem. 

 For additional suggestions, refer to Chapter 6, Troubleshooting.  

 If the test continues to fail, contact BioTek Instruments. 
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Annual Buffer Switching Module Test 

 This procedure tests all the Buffer valves. 

 Perform this test during the annual OQ only. 

 The Dispense Precision test must pass before the annual test for 
Valves A-D can be performed. 

1. Empty the waste bottle now, and then as needed throughout this 
procedure. 

2. Fill each of the supply bottles connected to Buffer valves A, B, C, and D 
with three liters (3000 mL) of deionized water. Place the bottles on a surface 
level with the EL406, i.e., the adjacent (lab bench) area. 

3. Run the Maintenance protocol W-PRIME_ALL_BFRS two or three times to 
prime the fluid lines, manifold, and the valves. 

Repeat the following steps for each valve: 

4. Edit the applicable pre-defined protocols: W-96_DISP_TEST or 
W-192_DISP_TEST to use the Buffer valve currently being tested. 

5. Place a new 96- or 384-well microplate on the balance and zero the balance. 

6. Place the microplate on the carrier and run the Dispense protocol.  

7. When the program is finished, carefully remove the plate and weigh it. This 
is the Total Dispense Weight in grams. 

 The Total Dispense Weight should be: 

 28.8 grams ± 10% (between 25.92 g and 31.68 g) for the 96-Tube 
test. 

 30.72 grams, ± 10% (between 27.65 g and 33.79 g) for 192-Tube 
test. 

 If the weight falls above this range, the valve may be defective. Contact 
BioTek. 

 If the weight falls below this range, the valve may be contaminated with 
fungi or proteins and must be cleaned using an appropriate enzyme, 
alcohol, or a diluted bleach solution, depending on the contaminant. See 
Removing Protein Residuals and Fungi Growth in the Maintenance 
section for suggestions. After cleaning the valve and tubing, retry the 
test. If the test continues to fail, contact BioTek. 

8. Record the results in the applicable Dispense Precision Test Worksheet. 
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Evacuation Efficiency Test (128) 

Begin this test by dispensing the test solution with Syringe A or B to a 1536-well plate 
using one of the pre-defined QC protocols provided: 

SA-1536_DISP_TST Dispense precision test protocol for 32-tube Syringe 
A manifold. 

20 

SB-1536_DISP_TST Dispense precision test protocol for 32-tube Syringe 
B manifold. 

21 

1. Fill the Syringe dispenser’s supply bottle with 100 mL of Solution 1 (see page 
156) and PRIME the tubing and manifold. 

2. Place a new 1536-well microplate on the balance and zero the balance. 

3. RUN the appropriate pre-defined protocol (listed above) to dispense 6 µL to 512 
wells of the plate. 

4. After performing SA-1536_DISP_TST or SB-1536_DISP_TST, run the W-
1536_EVAC_TEST.  This protocol evacuates all of the wells, leaving a small 
amount of residual fluid. 

5. When the program is completed, remove the plate and weigh it immediately 
because evaporation will affect the results.  This is the Total Residual 
Weight, in grams. 

6. Visually inspect the plate and note if any wells appear to have considerably 
more liquid in them than others. 

7. Using the Evacuation Efficiency Test Worksheet on page 172, perform initial 
data reduction:  

a. Divide the Total Residual Weight by 512 to find the Mean Residual 
Weight. 

b. The Mean Residual Weight should be <= 0.0001 g. 

If the Mean Residual Weight is greater than 0.0001 g, or if one or more wells appear to 
have much more liquid than the others, the washer failed the test.  

If the test fails, Troubleshoot as follows:  

 If the problem appears to be related to particular wells, clean those aspiration 
tubes: run AutoClean, and/or remove the manifold and thoroughly clean the 
tubes with the stylus (see Chapter 5, Maintenance for instructions.) When 
finished, retry the test. 

 Failure of this test is commonly caused by improper aspiration tube 
positioning, usually because a microplate other than the recommended 
Nunc® #264710 was used. If you prefer to use a different plate, modify the 
Aspirate Positioning, i.e., Z-axis to fix the height, or X- or Y-axes 
parameters in a copy of the W-1536_EVAC_TEST protocol.  After making 
needed changes, retry the test using a new microplate. 
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If you are using the Nunc 1536-well microplate, run AutoClean and/or 
remove the manifold and clean the aspiration tubes with the stylus. When 
finished, retry the test using a new microplate. 

 For additional suggestions, refer to Chapter 6, Troubleshooting.  

 If the test continues to fail, contact BioTek Instruments. 
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Dispense Precision Test Worksheet 

  96-Tube Manifold 
 

Serial Number:  

 

Calculations 

Standard Deviation:  
(calculate using spreadsheet program) 

 

Mean OD:  
(sum of all wells  number of wells) 

 

% Coefficient of Variation:  
((Standard Deviation  Mean OD) x 100) 

 

% CV <= 3.0?  Pass      Fail 

 

Date:  

Test Performed By:  
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Washer Liquid Tests  |  167 
 

Evacuation Efficiency Test Worksheet 

96-Tube Manifold 
 

Serial Number:    

 

Standard Test 

Total Residual Weight:  g 

Verification that wells are consistent in appearance:  Pass      Fail 

Mean Residual Weight (Total Residual Weight  96):  g 

Mean Residual Weight <= 0.002 g?  Pass      Fail 

 

Evacuation Diagnostics Test (check here  if not performed) 

Mean OD for the plate (Sum of all wells  96):  

Residual Factor (Mean OD  Mean Residual Weight):  

Calculate the Residual Weight for each well: well OD  Residual Factor 

Every Residual Weight per well <= 0.002 g?  Yes    No 

 

Date:  

Test Performed By:  
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Dispense Precision Test Worksheet 

     96-Tube Manifold 
    Annual Buffer Switching Test 

 

Serial Number:  

 

Calculations for Valve A 

Standard Deviation:  

Mean OD (Sum of all wells  Number of wells):  

% CV (Standard Deviation  Mean OD x 100):  

% CV <= 3.0?  Pass      Fail 

 

Calculations for Valves A-D   
(Annual OQ only, check here  if not performed) 

 
Total Dispense Weight 

28.8 g ±10%? 

(25.92 g - 31.68 g) 

Valve A                            grams  Pass      Fail 

Valve B                            grams  Pass      Fail 

Valve C                            grams  Pass      Fail 

Valve D                            grams  Pass      Fail 

 

Date:  

Test Performed By:  

BioTek Instruments, Inc. 
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Dispense Precision Test Worksheet 

  192-Tube Manifold 
 

Serial Number:  

 

Calculations 

Standard Deviation:  
(calculate using spreadsheet program) 

 

Mean OD:  
(sum of all wells  number of wells) 

 

% Coefficient of Variation:  
((Standard Deviation  Mean OD) x 100) 

 

% CV <= 4.0?  Pass      Fail 

 

Date:  

Test Performed By:  
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Evacuation Efficiency Test Worksheet 

    192-Tube Manifold 
 

Serial Number:  

 

Standard Test 

Total Residual Weight:  g 

Verification that wells are consistent in appearance:  Pass      Fail 

Mean Residual Weight (Total Residual Weight  384):  g 

Mean Residual Weight <= 0.002 g?  Pass      Fail 

 

Evacuation Diagnostics Test (check here  if not performed) 

Mean OD for the plate (sum of all wells  384):  

Residual Factor (Mean OD  Mean Residual Weight):  

Calculate the Residual Weight for each well: well OD  Residual Factor 

Every Residual Weight per well <= 0.002 g?  Yes      No 

 

Date:  

Test Performed By:  

BioTek Instruments, Inc. 



Washer Liquid Tests  |  171 
 

Dispense Precision Test Worksheet 

    192-Tube Manifold 
   Annual Buffer Switching Test 

 

Serial Number:  

 

Calculations for Valve A 

Standard Deviation:  

Mean OD (Sum of all wells  Number of wells):  

% CV (Standard Deviation  Mean OD x 100):  

% CV <= 4.0?  Pass      Fail 

 

Calculations for Valves A-D   
(Annual OQ only, check here  if not performed) 

 
Total Dispense Weight 

30.72 g ± 10%? 

(27.65 g – 33.79 g) 

Valve A                            grams  Pass      Fail 

Valve B                            grams  Pass      Fail 

Valve C                            grams  Pass      Fail 

Valve D                            grams  Pass      Fail 

 

Date:  

Test Performed By:  
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Evacuation Efficiency Test Worksheet 

    128-Tube Aspirate Manifold 
 

Serial Number:  

 

Standard Test 

Total Residual Weight:  g 

Verification that wells are consistent in appearance:  Pass      Fail 

Mean Residual Weight (Total Residual Weight  512):  g 

Mean Residual Weight <= 0.0001 g?  Pass      Fail 

 
 

Date:  

Test Performed By:  

BioTek Instruments, Inc. 
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Peri-pump Dispense Precision and Accuracy Tests 

Dispense Precision and Accuracy Specifications 

Cassette  Precision Accuracy 

< 10%CV  @ 1 L per well ± 10% @ 1 L per well 
1µL 

< 5%CV  @ 2 L per well* ± 5% @ 2 L per well* 

< 10%CV  @ 1 L per well ± 10% @ 1 L per well 
1µL 1536 

< 5%CV  @ 2 L per well* ± 5% @ 2 L per well* 

< 5%CV  @ 5 L per well ± 4% @ 5 L per well 
5µL 

< 2.5%CV  @ 10 L per well* ± 2% @ 10 L per well* 

< 4%CV  @ 10 L per well ± 4% @ 10 L per well 
10µL 

< 2%CV  @ 20 L per well* ± 2% @ 20 L per well* 

 * These specifications are for these dispense volumes and higher. 

 Note: The above specifications are for typical performance. For 
IQ/PQ/OQ purposes, add 1.0% additional tolerance to the Precision 
%CV to accommodate various test solutions, off-peak wavelengths, 
reader errors, and pipette errors. 

Liquid Testing Methodology 
Tare an empty plate on a balance.  Use the Peri-pump to dispense a quantity of fluid with a 
known dye concentration to the wells. Weigh the plate to obtain the weight of the fluid 
dispensed.  Pipette deionized water on top of the dye to bring the wells up to a more 
optically measureable volume. Read the wells in a microplate reader and determine the 
percentage Coefficient of Variance (%CV) among all wells, and the accuracy of the volume 
dispensed in each well (% Accuracy Error). 

BioTek recommends performing two tests, one at the volume that matches the cassette 
type and another that best represents the cassette type and dispense volume most common 
to your applications: 

Cassette Types Tests – 
Solutions 1 µL 1 µL 1536 5 µL 10 µL 

1 µL √ √   

5 µL   √  

10 µL √ √  √ 

50 µL   √  
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Cassette Types Tests – 
Solutions 1 µL 1 µL 1536 5 µL 10 µL 

100 µL    √ 

1536 µL  √   

 A single aliquot for a cassette type is the smallest volume unit 
recommended for it. 1 µL for the 1 µL cassette, 5 µL for the 5 µL 
cassette, and 10 µL for the 10 µL cassette.  

1 µL Test:  

 Confirms performance of 1 µL cassettes when dispensing a single aliquot  
(1/4 turn of pump) into each well of the plate.  

 Dispenses 1 µL into each well using the 1 µL Solution, and requires an 
additional 150 µL of DI water to raise the fluid level for optimal reading.  

5 µL Test:  

 Confirms performance of 5 µL cassettes when dispensing a single aliquot  
(1/4 turn of pump) into each well of the plate.  

 Dispenses 5 µL into each well using the 5 µL Solution, and requires an 
additional 150 µL of DI water to raise the fluid level for optimal reading.  

10 µL Test:  

 Confirms performance of 1 µL cassettes when dispensing 10 aliquots  
(2 1/2 turns of pump) and 10 µL cassettes when dispensing a single aliquot 
(1/4 turn of the pump) into each well of the plate.  

 Dispenses 10 µL into each well using the 10 µL Solution, and requires an 
additional 100 µL of DI water to raise the fluid level for optimal reading.  

50 µL Test:  

 Confirms performance of 5 µL cassettes when dispensing 10 aliquots  
(2 1/2 turns of pump) into each well of the plate.  

 Dispenses 50 µL into each well using the 50 µL solution, and requires an 
additional 100 µL of DI water to raise the fluid level for optimal reading.  

100 µL Test:   

 Confirms performance of 10 µL cassettes when dispensing 10 aliquots  
(2 1/2 turns of pump) into each well of the plate.  

 Dispenses 100 µL into each well using the 100 µL solution, and requires an 
additional 50 µL of DI water to raise the fluid level for optimal reading. 
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1536 Test: 

 Confirms the alignment of the tips; that the cassette is firing straight into the 
wells. 

 Dispenses 6L into columns 2, 4, 19-30, 45, 47 of a 1536 well plate using 1536 
solution.  Then, requires performing the 1 µL Test described above.  

Materials 

 Corning® Costar #3590 96-well plates, or equivalent  

 1536-well plates, Nunc #264710 

 Precision balance with readability of 0.0001 g resolution is preferable, 0.001 g 
resolution is acceptable, and capacity of 100 g minimum 

 Pipettes and graduated beakers 

 Microplate absorbance reader capable of dual wavelength reading at 630 and  
450 (or 405) nm  

 BioTek blue dye solution, PN 7773001, or equivalent to create the test solutions 
described on the following page. See also the important notes on page 149. 

Test Solutions 

Unique concentrations of the test fluid are described here, each one corresponds to 
a specific dispense volume. Prepare the solutions you will need to validate the 
cassette types and dispense volumes used most commonly in your applications. 

 The 5 µL Solution is used to make the higher volume test solutions. 

1 µL Solution Using BioTek’s 10X concentrated blue dye solution  
(PN 7773001), mix 5 mL of DI water with 8 mL of  
the blue dye solution. 

5 µL Solution Using BioTek’s 10X concentrated blue dye solution  
(PN 7773001), mix 100 mL of DI water with 10 mL  
of the blue dye solution. 

10 µL Solution Mix 25 mL of DI water with 20 mL of the 5 µL 
Solution. 

50 µL Solution Mix 45 mL of DI water with 5 mL of the 5 µL Solution. 

100 µL Solution Mix 40 mL of DI water with 2 mL of the 5 µL Solution. 

1536 Solution Mix 5 mL of 70% Isopropyl Alcohol with 3 mL of the 5 
µL Solution and 35 mL of DI H2O. 

Performing the Precision and Accuracy Tests 

Prerequisite: 
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 Prepare the test solutions as described above. 

 Make a copy of the applicable worksheet beginning on page 178.  

Procedure: 

1. Install the cassette to be tested.  

2. Turn on the EL406 and make sure the cassette (CASS) type setting is correct. 

3. Turn on the balance. 

4. Fill a beaker or other vessel with the test solution. 

5. Define a protocol and save it for reuse. Set the parameters based on the desired 
test volume: 

 A pre-defined protocol for the 1536 Test is shipped with the instrument 
and installed on your PC when you install the LHC: 
P-1536_DISP_TEST, run number 22 on the keypad.  

  Add a Peri-pump DISPense step to the protocol. 

 Set the Dispense Volume to match the Test: 

 
Test  Volume 

1 µL  1 µL 

5 µL  5 µL 

10 µL  10 µL 

50 µL 50 µL 

100 µL 100 µL 

1536 6 µL 

 

 

 

 

 

 

 

 Set the Flow Rate to: 

 1 µL cassette = Medium 

 5 µL cassette =  High 

 10 µL cassette = High 

 Optionally, choose to Require the specific cassette type under test. 

 Define a Pre-dispense: set the volume to 10 µL and the Number of 
Pre-dispenses (cycles) to 2. 

6. Place a clean/new microplate on the balance and tare the balance.  

7. Put the Tube Organizer into the test fluid vessel and Prime the tubing until 
any large air bubbles are removed. 

8. Run the dispense protocol. 

BioTek Instruments, Inc. 
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9. Place the plate on the balance and record the Total Dispense Weight in the 
worksheet. 

10. Using a calibrated hand pipette, add the specified amount of deionized water 
to each well to raise the fluid level to approximately 150 L.0. 

 
Test  Volume 

1 µL  150 µL 

5 µL  150 µL 

10 µL  100 µL 

50 µL 100 µL 

100 µL 50 µL 

1536 0 µL 

 

 

 

 

 

 

 

11. Read the plate in an absorbance reader using the dual-wavelength method: 
read the plate at 630 nm and 450 nm.  

12. Calculate the Delta OD: (630 nm – 450 nm), Mean Absorbance, Standard 
Deviation, and the %CV for the wells under test. %CV = (Standard Deviation 
 Mean) * 100. 

13. Print the report, obtain required signatures, and store it according to regulatory 
guidelines.0. 

If one or more of your tests are failing, make sure the dispense tubes are not clogged, 
(follow the Unclog the Dispense Tips instructions in the Maintenance chapter). If that 
doesn’t work, recalibrate the cassette and repeat the test(s). If your tests continue to 
fail, contact BioTek’s Technical Assistance Center (TAC). 

Documenting Test Results 

The following pages contain Dispense Precision & Accuracy Test Worksheets. We 
recommend you make copies of the appropriate pages and use them to record your 
calculations and test results.  

Alternatively, you can purchase the instrument qualification package, which contains 
additional tools for conducting test procedures and recording the results, including 
logbooks and Excel® spreadsheets.  
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EL406 Peri-pump Dispense Precision & Accuracy Test Worksheet 
1 µL Cassette Test 

 

1 µL Dispense Precision Test 

Standard Deviation (SD):  

Mean Absorbance (sum of all wells  96)  

% CV (SD  Mean x 100)  % 

% CV must be < 11.0%  Pass      Fail 

 

1 µL Dispense Accuracy Test 

Total Dispense (Actual) Weight: grams 

Expected Weight: 
(mL/well x number of wells dispensed) 

grams 

% Accuracy Error:  
(Actual Weight – Expected Weight)  Expected Weight x 100 

% 

% Accuracy Error must be < 10.0%  Pass      Fail 

Visual verification that no well varies  
considerably from the others 

 Pass      Fail 

 

Cassette Serial Number:  

 Tests Performed By: 

Date:  

 Reviewed/Approved By: 

Date:  

 

BioTek Instruments, Inc. 
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EL406 Peri-pump Dispense Precision & Accuracy Test Worksheet 
5 µL Cassette Test 

 

5 µL Dispense Precision Test 

Standard Deviation (SD):  

Mean Absorbance (sum of all wells  96)  

% CV (SD  Mean x 100)  % 

% CV must be < 6.0%  Pass      Fail 

 

 

5 µL Dispense Accuracy Test 

Total Dispense (Actual) Weight: grams 

Expected Weight: 
(mL/well x number of wells dispensed) 

grams 

% Accuracy Error:  
(Actual Weight – Expected Weight)  Expected Weight x 100 

% 

% Accuracy Error must be < 4.0%  Pass      Fail 

Visual verification that no well varies  
considerably from the others 

 Pass      Fail 

 

 

Cassette Serial Number:  

 Tests Performed By: 

Date:  

 Reviewed/Approved By: 

Date:  
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EL406 Peri-pump Dispense Precision & Accuracy Test Worksheet 
1 µL Cassette Test 

 

10 µL Dispense Precision Test 

Standard Deviation (SD):  

Mean Absorbance (sum of all wells  96)  

% CV (SD  Mean x 100)  % 

% CV must be < 6.0%  Pass      Fail 

 

 

10 µL Dispense Accuracy Test 

Total Dispense (Actual) Weight: grams 

Expected Weight: 
(mL/well x number of wells dispensed) 

grams 

% Accuracy Error:  
(Actual Weight – Expected Weight)  Expected Weight x 100 

% 

% Accuracy Error must be < 5.0%  Pass      Fail 

Visual verification that no well varies  
considerably from the others 

 Pass      Fail 

 

 

Cassette Serial Number:  

 Tests Performed By: 

Date:  

 Reviewed/Approved By: 

Date:  

 

BioTek Instruments, Inc. 
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EL406 Peri-pump Dispense Precision & Accuracy Test Worksheet 
10 µL Cassette Test 

 

10 µL Dispense Precision Test 

Standard Deviation (SD):  

Mean Absorbance (sum of all wells  96)  

% CV (SD  Mean x 100)  % 

% CV must be < 5.0%  Pass      Fail 

 

 

10 µL Dispense Accuracy Test 

Total Dispense (Actual) Weight: grams 

Expected Weight: 
(mL/well x number of wells dispensed) 

grams 

% Accuracy Error:  
(Actual Weight – Expected Weight)  Expected Weight x 100 

% 

% Accuracy Error must be < 4.0%  Pass      Fail 

Visual verification that no well varies  
considerably from the others 

 Pass      Fail 

 

 

Cassette Serial Number:  

 Tests Performed By: 

Date:  

 Reviewed/Approved By: 

Date:  
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EL406 Peri-pump Dispense Precision & Accuracy Test Worksheet 
5 µL Cassette Test 

 

50 µL Dispense Precision Test 

Standard Deviation (SD):  

Mean Absorbance (sum of all wells  96)  

% CV (SD  Mean x 100)  % 

% CV must be < 3.5%  Pass      Fail 

 

 

50 µL Dispense Accuracy Test 

Total Dispense (Actual) Weight: grams 

Expected Weight: 
(mL/well x number of wells dispensed) 

grams 

% Accuracy Error:  
(Actual Weight – Expected Weight)  Expected Weight x 100 

% 

% Accuracy Error must be < 2.0%  Pass      Fail 

Visual verification that no well varies  
considerably from the others 

 Pass      Fail 

 

 

Cassette Serial Number:  

 Tests Performed By: 

Date:  

 Reviewed/Approved By: 

Date:  

 

BioTek Instruments, Inc. 



Peri-pump Dispense Precision and Accuracy Tests  |  183 
 

EL406 Peri-pump Dispense Precision & Accuracy Test Worksheet 
10 µL Cassette Test 

 

100 µL Dispense Precision Test 

Standard Deviation (SD):  

Mean Absorbance (sum of all wells  96)  

% CV (SD  Mean x 100)  % 

% CV must be < 3.0%  Pass      Fail 

 

 

100 µL Dispense Accuracy Test 

Total Dispense (Actual) Weight: grams 

Expected Weight: 
(mL/well x number of wells dispensed) 

grams 

% Accuracy Error:  
(Actual Weight – Expected Weight)  Expected Weight x 100 

% 

% Accuracy Error must be < 2.0%  Pass      Fail 

Visual verification that no well varies  
considerably from the others 

 Pass      Fail 

 

 

Cassette Serial Number:  

 Tests Performed By: 

Date:  

 Reviewed/Approved By: 

Date:  
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EL406 Peri-pump Dispense Precision & Accuracy Test Worksheet 
1536 Cassette Test 

 

1536 Dispense Precision Test 

Standard Deviation (SD):  

Mean Absorbance (sum of all wells  96)  

% CV (SD  Mean x 100)  % 

% CV must be < 6.0%  Pass      Fail 

 

 

1536 Dispense Accuracy Test 

Total Dispense (Actual) Weight: grams 

Expected Weight: 
(mL/well x number of wells dispensed) 

grams 

% Accuracy Error:  
(Actual Weight – Expected Weight)  Expected Weight x 100 

% 

% Accuracy Error must be < 5.0%  Pass      Fail 

Visual verification that no well varies  
considerably from the others 

 Pass      Fail 

 

 

Cassette Serial Number:  

 Tests Performed By: 

Date:  

 Reviewed/Approved By: 

Date:  

 

 

BioTek Instruments, Inc. 
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Syringe Dispenser Precision and Accuracy Tests 

Dispense Precision and Accuracy Specifications 

 Note: The specifications listed here are for typical performance.  
For IQ/PQ/OQ testing purposes, add 1.0% additional tolerance to the 
Precision %CV to accommodate various test solutions, off-peak 
wavelengths, reader errors, and pipette errors. 

 Precision Accuracy 

< 3 %CV @ 80 L/well ± 1.25% @ 80 L/well 
384-well dispense 

< 6 %CV @ 20 L/well ± 5% @ 20 L/well 

< 3 %CV @ 160 L/well ± 1.25% @ 160 L/well 
96-well dispense 

< 6 %CV @ 40 L/well ± 5% @ 40 L/well 

1536-well dispense < 12% CV @ 6 µL/ well  5% @ 6 µL/well 

Materials 

 Plates: 384-well plates for testing the 16-tube dispensers (which can be replaced 
with 96-well plates if more applicable for your lab); 1536-well plates for testing the 
32-tube dispensers. 

 Precision balance with capacity of 100 g minimum and readability of 0.01 g 
resolution 

 Pipettes and graduated beakers 

 Microplate absorbance reader capable of dual wavelength reading at 630 and  
405 (or 450) nm  

 The test solutions described below. See also the Important Recommendations 
for All Liquid Tests on page 149. 

Test Solutions 

20 µL Solution Mix 10 mL of BioTek’s blue dye solution with 100 mL of 
deionized water to create a dilution of the concentrate.  
Mix 160 mL of deionized water with 20 mL of the diluted 
concentrate. 

80 µL Solution Mix 120 mL of deionized water with 40 mL of the 20 µL 
Solution. 

1536 Solution  Mix 21 mL of 70% Isopropyl Alcohol with 13 mL of the 20 
µL Solution and 150 mL of DI H2O. 
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Two pre-defined QC protocols are provided for qualifying the 32-tube dispensers: 

SA-1536_DIS_TEST Dispense precision test protocol for 32-tube 
Syringe A manifold. 

20 

SB-1536_DIS_TEST Dispense precision test protocol for 32-tube 
Syringe B manifold. 

21 

 

Perform the Syringe Dispense Precision & Accuracy Test 

Perform two tests for each syringe: use two 384-well plates (unless only 96-well plates are 
used in your lab) with two dye solutions.  

1. Prepare the syringe dispenser to be tested: 

Tests 1: Use the 20 l solution 

Tests 2: Use the 80 l solution 

Tests 3: Use the 1536 µL solution 

2. Create and save protocols, two for each Syringe, for the tests as follows (except 
when testing the 32-tube dispensers, skip to step 3):  

 

1. Define a Prime step: 
 Volume = 5000 µL 

 Flow Rate = 5 

 Number of cycles = 2 

2. Define a Dispense step for each test:  

Test 1: Plate Type 384, Volume = 20 L/well; (Alternatively, Plate Type 
96, Volume = 40 L/well) 

Test 2: Plate Type 384, Volume = 80 L/well; (Alternatively, Plate Type 
96,  Volume = 160 L/well)  

Set Flow Rate to 2 for all tests. 

3. Place a clean, empty 384-well or 1536-well (or 96-well) microplate on the 
balance and tare the balance.   

4. Place the microplate on the carrier and run the protocol created in step 2 or 
shipped with the instrument: 

SA-1536_DIS_TEST Test protocol for 32-tube Syringe A. 20 

BioTek Instruments, Inc. 
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SB-1536_DIS_TEST Test protocol for 32-tube Syringe B. 21 

Important: Fully prime the Syringe tubing to remove any air bubbles before 
running these pre-defined protocols.  

5. Place the plate on the balance and record the Total Dispense Weight.  
This value will be used to calculate the % Accuracy Error in step 10. 

6. For Test 1 Only: Use a calibrated hand pipette to dispense deionized water on 
top of the dye solution in the wells.  

384-well: Pipette 60 L/well (resulting in 80 L/well) 

96-well: Pipette 120 L/well (resulting in 160 L/well) 

Shake the plate on an orbital shaker or in a microplate reader for 15 seconds, or 
lightly tap the side of the plate with your finger to agitate the contents of the 
wells.  

7. Read the plate in an absorbance reader using the dual-wavelength method, to 
reduce the influence of scratches and foreign particles that could be in the well.  
See the recommended wavelengths on page 149.  Print or export the results.   

 For steps 8 and 9, enter the results in copies of the test Worksheets 
beginning on page 189. 

8. Calculate and report the Mean absorbance, Standard Deviation, and the %CV 
for the wells under test. %CV = (Standard Deviation  Mean) * 100. 

9. The % Accuracy Error calculation is:   

(Actual Weight – Expected Weight)  Expected Weight x 100 

Subtract the expected dispense weight (see below) from the Actual (Total) 
Dispense Weight (from step 6), and divide the result by the expected weight. 
Multiply the result by 100. 

The Expected Dispense Weight is the volume dispensed per well in mL 
multiplied by the number of wells dispensed. For example, if 40 μL is 
dispensed to 96 wells, the expected weight is 0.040 x 96 = 3.84 grams. We have 
calculated some expected dispense weights for you: 

Test # of wells Volume Expected Weight 

Test 1: 384 wells 20 μL/well 7.68 grams 

 96 wells 40 μL/well 3.84 grams 

Test 2: 384 wells, 80 μL/well 30.72 grams 

 96 wells 160 μL/well 15.36 grams 

Test 3:  512 wells (of a 
1536-well plate) 

6 µL/well 3.024 grams 
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10. Analyze your test results. The following is the Pass criteria for each test: 

 %CV % Accuracy Error 

Test 1: < 6.0%* ± 5.0% 

Test 2: < 3.0%*  ± 1.25% 

Test 3: < 12.0 % ± 5.0% 

* The specifications listed on page 185 are for typical performance.  
For IQ/PQ/OQ purposes, we have added 1.0% additional tolerance to  
the %CV to accommodate various test solutions, off-peak wavelengths,  
reader errors, and pipette errors. 

If one or more of your tests are failing, clean the dispense tubes with the stylus, 
re-prime the manifold, and repeat the test(s). If your tests continue to fail, contact 
BioTek’s Technical Assistance Center. 

Documenting Test Results 

The following pages contain Dispense Precision & Accuracy Test Worksheets. We 
recommend you make copies of the appropriate pages and use them to record your 
calculations and test results. 

Each Worksheet records calculations and pass/fail test results for an individual test.  

 

 

 

BioTek Instruments, Inc. 
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EL406 Syringe Dispenser Precision & Accuracy Test Worksheet 
Test 1 / 384-Well Microplate / 20 µL Dispense 

 

 

20 µL Dispense Precision Test 

Standard Deviation (SD):  

Mean Absorbance (sum of all wells  384)  

% CV (SD  Mean x 100)  % 

% CV must be < 6.0%  Pass      Fail 

 

 

20 µL Dispense Accuracy Test 

Total Dispense (Actual) Weight: grams 

Expected Weight: 
(mL/well x number of wells dispensed) 

grams 

% Accuracy Error:  
(Actual Weight – Expected Weight)  Expected Weight x 100 

% 

% Accuracy Error must be < 5.0%  Pass      Fail 

Visual verification that no well varies  
considerably from the others 

 Pass      Fail 

 

 

Serial Number:  

 Tests Performed By: 

Date:  

 Reviewed/Approved By: 

Date:  
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EL406 Syringe Dispenser Precision & Accuracy Test Worksheet 
Test 2 / 384-Well Microplate / 80 µL Dispense 

 

 

80 µL Dispense Precision Test 

Standard Deviation (SD):  

Mean Absorbance (sum of all wells  384)  

% CV (SD  Mean x 100)  % 

% CV must be < 3.0%  Pass      Fail 

 

 

80 µL Dispense Accuracy Test 

Total Dispense (Actual) Weight: grams 

Expected Weight: 
(mL/well x number of wells dispensed) 

grams 

% Accuracy Error:  
(Actual Weight – Expected Weight)  Expected Weight x 100 

% 

% Accuracy Error must be < 1.25%  Pass      Fail 

Visual verification that no well varies  
considerably from the others 

 Pass      Fail 

 

 

Serial Number:  

 Tests Performed By: 

Date:  

 Reviewed/Approved By: 

Date:  

 

BioTek Instruments, Inc. 



Syringe Dispenser Precision and Accuracy Tests  |  191 
 

EL406 Syringe Dispenser Precision & Accuracy Test Worksheet 
Test 1 / 96-Well Microplate/40 µL Dispense 

 

 

40 µL Dispense Precision Test 

Standard Deviation (SD):  

Mean Absorbance (sum of all wells  96)  

% CV (SD  Mean x 100)  % 

% CV must be < 6.0%  Pass      Fail 

 

 

40 µL Dispense Accuracy Test 

Total Dispense (Actual) Weight: grams 

Expected Weight: 
(mL/well x number of wells dispensed) 

grams 

% Accuracy Error:  
(Actual Weight – Expected Weight)  Expected Weight x 100 

% 

% Accuracy Error must be < 5.0%  Pass      Fail 

Visual verification that no well varies  
considerably from the others 

 Pass      Fail 

 

 

Serial Number:  

 Tests Performed By: 

Date:  

 Reviewed/Approved By: 

Date:  
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EL406 Syringe Dispenser Precision & Accuracy Test Worksheet 
Test 2 / 96-Well Microplate/160 µL Dispense 

 

 

160 µl Dispense Precision Test 

Standard Deviation (SD):  

Mean Absorbance (sum of all wells  96)  

% CV (SD  Mean x 100)  % 

% CV must be < 3.0%  Pass      Fail 

 

 

160 µl Dispense Accuracy Test 

Total Dispense (Actual) Weight: grams 

Expected Weight: 
(ml/well x number of wells dispensed) 

grams 

% Accuracy Error:  
(Actual Weight – Expected Weight)  Expected Weight x 100 

% 

% Accuracy Error must be < 1.25%  Pass      Fail 

Visual verification that no well varies  
considerably from the others 

 Pass      Fail 

 

 

Serial Number:  

 Tests Performed By: 

Date:  

 Reviewed/Approved By: 

Date:  
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EL406 Syringe Dispenser Precision & Accuracy Test Worksheet 
Test 3 / 1536-Well Microplate / 6 µL Dispense 

 

 

6 µL Dispense Precision Test 

Standard Deviation (SD):  

Mean Absorbance (sum of all wells  512)  

% CV (SD  Mean x 100)  % 

% CV must be < 12.0%  Pass      Fail 

 

 

6 µL Dispense Accuracy Test 

Total Dispense (Actual) Weight: grams 

Expected Weight: 
(mL/well x number of wells dispensed) 

grams 

% Accuracy Error:  
(Actual Weight – Expected Weight)  Expected Weight x 100 

% 

% Accuracy Error must be < 5.0%  Pass      Fail 

Visual verification that no well varies  
considerably from the others 

 Pass      Fail 

 

 

Serial Number:  

 Tests Performed By: 

Date:  

 Reviewed/Approved By: 

Date:  
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Chapter 6 

Troubleshooting 

This section contains guidelines for error recovery and troubleshooting 
performance problems. 
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Error Recovery 

First Response: Run a System Test (restart) to give the instrument an 
opportunity to restore its initial settings and computer communication 
capability.  

 Generally an error tone from the instrument will announce an 
error condition and an error message will be displayed on-screen. 
The tone will cease when you respond to the message. Sometimes 
this requires pressing Enter on the keypad. 

Reboot your Computer and Instrument: When you cannot run a system test, 
e.g., LHC is not responding, or when running a system test doesn't resolve the 
issue, turn off your computer and EL406, check all the cabling, i.e., make sure 
your serial or USB cable is in good condition and is properly connected to the 
PC and instrument, and then, power them on. This should refresh the devices 
and reset communication parameters. 

Error Codes 

Most error conditions generate an error message that is displayed on the 
computer screen or keypad. The most common errors for new EL406 users are 
easily fixed: 

6045 Serial write error 

A "serial write" error is easily fixed by correcting the COM port setting defined 
in the protocol. Be sure to customize the Pre-defined Protocols when running 
them with the LHC to avoid this error in future. 

810D To communicate, instrument must be at main menu. 

The 810D message appears when the instrument is busy, for example when 
AutoPrime is running. The LHC can only talk to the instrument when its main 
menu is displayed. Press the Stop button on the keypad, if desired, to end the 
current process and return to the main menu. 

306 Peri-pump pump cover is open. Close the pump cover and re-run protocol. 

To run the Peri-pump, its pump cover must be closed, protecting both the 
pump and the operator. 

401 Carrier Y motor failed positional verify 

If the plate carrier is not installed correctly, this instrument error will be 
displayed. Make sure the back right corner of the carrier is correctly seated in 
the little black knob attached to the transport rail. A slit on the bottom of the 
carrier allows it to fit into place.   

See also: Appendix A: Error Codes 

BioTek Instruments, Inc. 
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Communication Errors: EL406 to Computer 

Here are some guidelines for troubleshooting communication errors. 

 

A potentially common error, especially when using the Pre-defined Protocols, a 
"serial write" error, is easily fixed by correcting the COM port setting. 

Safety first 

 To prevent damage to the instrument, always turn OFF the EL406 or the 
computer before removing or inserting a communications (serial or 
USB) cable. 

When the computer (PC) won't communicate with the EL406 

1 Confirm that the instrument passes its system self-test. All BioTek 
instruments perform a self-test when turned on. The EL406 will not 
communicate if it fails an internal system test. An error message will 
be displayed when a test fails. Refer to the Operator's Manual to 
resolve the failure or contact BioTek TAC.  

2 Make sure the serial or USB cable is in perfect condition and 
properly attached to the port defined in the Instrument Settings 
dialog (e.g. COM 1). Review the LHC Help Topic "About COM 
Ports" to learn about virtual COM ports when using a USB cable. 
Correct and reboot both PC and instrument. Test communication. 

3 Confirm that the serial/USB cable was obtained from BioTek. 
Serial/USB cables are not universal. Contact BioTek customer 
service to purchase a factory-tested cable. After installing a known, 
good cable, reboot both PC and instrument. Test communication. 

4 Confirm with your computer supplier or a local PC technician that 
the serial port has been enabled. For example, the IBM Thinkpad® 
was originally shipped with the serial port disabled. Correct and 
reboot both PC and EL406. Test communication. 

EL406 Washer Dispenser  



198  | Chapter 6: Troubleshooting 

Troubleshooting 

Potential problems and solutions are listed by device: Washer, Peri-pump on page 
204, and Syringe dispenser on page 205. 

Washer Problems 

START-UP 

Problem Possible Cause What To Do 

Keypad display (LCD) not 
on. 

Power cord not plugged in. Check power connection. 

Vacuum pump is not 
turned on. 

Flip the switch on the side of the vacuum 
pump to turn it on.  

Vacuum pump accessory 
cable not installed 
correctly. 

Plug the vacuum pump accessory cable into 
the back of the instrument, Accessory 
Outlet.  

Too much residual vacuum 
force for pump. 

Release the vacuum by loosening the waste 
bottle stopper. Reconnect and start again. 

Plug the vacuum pump accessory cable into 
the back of the instrument, Accessory 
Outlet, not into a wall outlet.  

Increase vacuum dissipation delay. 
LHC: Tools>Instrument Utilities>Vacuum 
Dissipation Delay. 
Keypad: Setup Menu>  VACDIS  

Vacuum pump does not 
start, or shakes when 
turned on. 

Blown fuse in accessory 
outlet. 

Replace fuse (PN 46055) as described in 
Chapter 4. 

Vacuum Dissipate Delay is 
set too low for the volume 
of the waste bottle. 

See Solution above. If not enough time is 
allowed for the vacuum to dissipate, the pump 
will try to start while it is under a vacuum. The 
pump draws excessive current and blows the 
fuse. 

Repeated blown fuses. 

Pump has been flooded. Remove the head from the pump and inspect 
it for corrosion, crystalline buildup or liquid. 
Contact BioTek TAC for information on pump 
rebuilding kits. 

Manifold or carrier is being 
obstructed. 

Remove obstruction. 

Motor, sensor, or electrical 
problem. 

Turn instrument off, wait at least 15 seconds, 
and turn it back on. If the self-test does not 
pass, contact BioTek TAC. 

Carrier/manifold position 
error. 

Misaligned carrier or 
manifold. 

Contact BioTek TAC. 

BioTek Instruments, Inc. 



Troubleshooting  |  199 

EL406 Washer Dispenser  

START-UP 

Problem Possible Cause What To Do 

Incorrect manifold setting.  
 

Make sure the washer manifold setting 
matches the installed manifold (96-tube or 
192-tube). 
LHC: Tools>Instrument 
Utilities>Washer>Manifold Selection. 
Keypad: Setup Menu>WASH>MAN 

 

FLUID ASPIRATION 

Problem Possible Cause What To Do 

Firmly seat the waste bottle covers.  Ensure 
tubing is connected properly. Check all external 
tubing and in-line filter for kinks or clogs. If you 
are using an in-line vacuum filter, it may need 
to be replaced. 

Insufficient or no vacuum. 

With the vacuum pump on, remove the vacuum 
pump tubing from the back of the instrument. 
Put your finger over the port; if there is no 
vacuum, contact BioTek TAC. 

Remove and clean the manifold as described in 
Chapter 4. 

Clogged aspiration tubes on 
the washer manifold. 

Make sure the microplate carrier is level and the 
waste valve is not touching the bench.  

Aspirate height adjustment 
too high or too low. 

Change the aspiration height (Z-axis position) in 
the protocol. 

Poor or uneven 
aspiration. 

Vacuum pump failure. Contact BioTek TAC. 

No surfactant in the buffer, 
such as Tween® 20. 

Add surfactant to the buffer. If this is not 
possible, continue below. 

Insufficient vacuum. BioTek offers a high-flow pump for assays using 
only water for the wash fluid. Contact BioTek for 
more information. 

Protocol settings not 
optimized. 

Try these changes in this order and in 
combination, if necessary: 
 Enable secondary aspiration. 
 Increase aspiration Delay to 800 ms. 
 Slow Travel Rate to 1 or 2.  

Aspiration tubes not 
properly positioned 
horizontally in wells. 

If none of the tubes are bent, try adjusting the 
horizontal aspirate position (X-/Y-axis) in the 
protocol. 

Uneven aspiration of 
water buffer. Some 
wells left full. 

Microplate not level in 
carrier, or strips not level in 
holder. 

Reseat microplate in carrier or strips in holder. 
Make sure the carrier is clean. 
Try a different microplate or strip holder.  
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FLUID ASPIRATION 

Problem Possible Cause What To Do 

If the problem is unresolved, the carrier may 
have to be realigned. Contact BioTek TAC. 

Clogged vacuum filter. If you are using an in-line vacuum filter  
(PN 49943), the filter may need to be cleaned 
or replaced. 

Waste bottle cover not 
properly sealed or fittings 
not properly connected. 

Firmly seat the waste bottle stopper.  Make sure 
tubing is connected properly. 

Manifold out of alignment or 
not moving freely.  

Check for obstructions. If none are found, 
contact BioTek TAC. 

Protocol requires 
optimization. 

To minimize the residuals, add a secondary (or 
crosswise) aspiration. 
Other options include decreasing the Travel 
Rate or adding a Delay on the final aspiration. 

Too much residual left 
in wells after 
aspiration. 

Aspirate tubes are bent. Contact BioTek TAC. 

 

FLUID DELIVERY 

Problem Possible Cause What To Do 

Clogged fluid inlet filter. Clean the fluid inlet filter as described in 
Chapter 4. 

Supply tube inside the supply 
bottle is kinked or 
disconnected. 

Straighten or connect supply tube.  Make 
sure the end is cut; see Optimize 
Performance in Chapter 3. 

Inlet tube not connected. Make sure all tubing is connected properly. 
Check all external tubing for kinks or clogs. 

Clogged dispense tubes on the 
washer manifold. 

Remove and clean the manifold as 
described in Chapter 4. 

No wash or rinse fluid. Fill bottles with appropriate fluid. Ensure 
bottles are clean and do not contain 
particles or organic material. 

System not primed. Large air 
pockets in tubing. 

Run W-DAY_RINSE multiple times.  

Unable to dispense 
fluid—units without 
the external Buffer 
Switching module. 

Insufficient suction, clogged 
tubing, or faulty valve. 

Perform Maintenance as described in Ch. 4. 
If the problem persists, contact BioTek TAC. 

System not primed.  Large air 
pockets in tubing. 

Run W-DAY_RINSE multiple times.  Unable to dispense 
fluid—models with the 
external Buffer 
Switching module. External valve module not 

connected to washer, or supply 
tubing set up incorrectly. 

Check valve module cable and tubing. 
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EL406 Washer Dispenser  

FLUID DELIVERY 

Problem Possible Cause What To Do 

Solenoid valve not opening. Ensure module cable is plugged into the 
Valve Control port on the instrument’s back 
panel. If plugged in, contact BioTek TAC. 

Dispense height too high. The 
aspirate tubes are too far 
above the microwells to 
prevent overflow. 

Change the dispense height (Z-axis 
position) in the protocol. 

Dispense flow rate too low.  Define a higher dispense Flow Rate in the 
protocol. 

Cell wash flow rate 1 or 2 is 
used with 384-well plates. 

Specify a non-CW dispense Flow Rate when 
using 384-well plates. 

Aspiration tubes hit bottom of 
trough during Prime or 
Maintenance. 

Manifold may not be properly seated or 
mounted. Contact BioTek TAC. 

In-line vacuum filter plugged. Replace or remove the in-line vacuum filter. 

Loose covers on waste bottles. Firmly tighten waste bottle covers. 

Dispense rate too fast for 
volume selected. 

Specify slower dispense Flow Rate or lower 
volume. 

Faulty vacuum pump. Contact BioTek TAC. 

Plate overfills (floods). 

Insufficient or no vacuum. Firmly seat the waste bottle covers. 
Check all external tubing for kinks or clogs. 
When the program begins, you should be 
able to hear the vacuum pump turn on. If it 
is not turning on, contact BioTek TAC. 
If the vacuum pump turns on, remove the 
vacuum tubing from the back of the 
instrument and put your finger over the 
port. If there is no vacuum, contact BioTek 
TAC. 

Clogged dispense tubes on the 
washer manifold. 

Remove and clean the manifold as 
described in Ch. 4. 

Manifold or tubing not 
adequately primed. 

Run W-DAY_RINSE multiple times.  

Dispense flow rate too low. 
Low flow rate 1 or 2 CW is 
used with 384-well plates. 

Define a higher dispense Flow Rate.  

Uneven dispensing of 
fluid; wells not filled. 

Microplate aspiration height 
adjustment too high or too 
low. 

Change the aspirate height (Z-axis position) 
in the protocol. 

 
 



202  | Chapter 6: Troubleshooting 

FLUID LEAKAGE 

Problem Possible Cause What To Do 

Defective seals. Replace the manifold’s channel-end seals or 
o-rings as described in Ch. 4. Contact 
BioTek TAC. 

Fluid leaking from 
manifold. 

Aspiration tubes only: vacuum 
too low. 

Check waste connector tubes; make sure 
they are properly connected. 

If you are using an in-line vacuum filter, 
check the filter for clogging, and replace if 
necessary. 

Check seal of waste bottle covers. 

Check for air leaks in the waste tubing and 
bottles. 

Use a slower Aspiration Travel Rate. 

Defective tubing connector or 
inlet tubing. 

Contact BioTek TAC. Fluid leaking from 
underneath the 
instrument. 

Leaking valve. Contact BioTek TAC. 

Defective connector. Replace connector. 

Worn tubing. Replace tubing or cut back tubing one inch 
(to remove worn section). 

Fluid leaking from 
external tubing 
connector. 

Worn seal (inlet or vacuum 
fitting). 

Replace filter or seal. 

 
 

MICROPLATE CARRIER MOVEMENT 

Problem Possible Cause What To Do 

Microplate not properly seated 
or strips not level. 

Reseat microplate in carrier or strips in 
holder. 

Make sure the carrier is clean. 

Try a different microplate or strip holder. If 
the problem is unresolved, the carrier may 
have to be realigned. Contact BioTek TAC. 

Aspirate tubes position is too 
wide for a movement. 

Change the horizontal, X- or Y-axis aspirate 
position in the protocol. 

Aspiration tubes not 
entering wells 
correctly. 

Aspirate tubes bent. Contact BioTek TAC. 
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WASHER MANIFOLD MOVEMENT 

Problem Possible Cause What To Do 

Manifold movement is 
blocked. 

Check orientation of microplate; A1 should 
be in the left rear corner of the plate carrier 
as you face the instrument. 

Check for and remove any obstructions. 

Ensure the manifold is installed properly.  

Manifold position 
error. 

Incorrect manifold selected. 

 

Make sure the washer manifold setting 
matches the installed manifold (96-tube or 
192-tube). (Tools>Instrument 
Utilities>Washer>Manifold Selection.) 

 
 

MICROPLATE SCRATCHES 

Problem Possible Cause What To Do 

Microplate dispense or 
aspiration height adjustment 
too low. 

Change the Dispense or Aspirate height, 
the Z-axis position. 

Scratches on 
microplate bottom. 

Microplate not properly seated 
or strips not level. 

Reseat microplate in carrier or strips in 
holder. 

Make sure the carrier is clean. 

Try a different microplate or strip holder. If 
the problem is unresolved, the carrier may 
have to be realigned. Contact BioTek TAC. 
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Peri-pump Performance Issues 

This table lists possible solutions to potential performance issues when using 
the Peri-pump dispenser. 

Problem What To Do 

Fluid stream missing 
wells 

Check Tip Holder, make sure it is properly 
seated in the Dispense Arm. 

Select the correct Plate Type.  

Fluid splashing out of 
the wells 

Select the correct Plate Type. 

Reduce the Flow Rate. 

Lower the Dispense Height. 

Uneven dispensing 

Make sure all cassette components are 
properly seated in their respective positions.   

Tips are clogged. (See the Preventive 
Maintenance chapter.) 

Recalibrate the cassette. 

Replace the tubing.  

(On the Operator’s Manual CD, in the PDF 
folder, find instructions for recalibrating the 
cassette and replacing the tubing.) 

Dispenser skipping 
columns 

Check/define the Plate Map. 

Tips clogging 

Filter the dispense fluid to 50 microns before 
dispensing. 

Replace the tubing. 

Viscous fluids sticking to 
tips 

Vary the Flow Rate: experiment with different 
flow rates to determine which setting best 
forces fluid to break from the tip. 

Cannot communicate 
with computer 

Check the cabling. (See previous section.) 

Select the correct COM Port. 

Turn on dispenser; display Main Menu. 

Foaming in the wells Reduce the dispense step’s Flow Rate. 
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Syringe Dispenser 

START-UP 

Problem Possible Cause What To Do 

Syringe or manifold is being 
obstructed. 

Remove obstruction. 

Motor, sensor, or electrical 
problem. 

Turn instrument off, wait at 
least 15 seconds, and turn it 
back on. If the instrument does 
not pass its self-test, contact 
BioTek TAC. 

Syringe or manifold 
position error.   

Syringe piston not seated all the 
way to the bottom before 
fastening set screw. 

Reinstall the syringe head. 

 

SYRINGE MOVEMENT 

Problem Possible Cause What To Do 

Ensure the 26-pin high-density 
cable shipped with the Syringe 
is connected to the EL406’s rear 
panel. 

Syringe movement is blocked. 

Contact BioTek TAC. 

Syringe position error. 

Syringe piston not seated all the 
way to the bottom before 
fastening set screw. 

Reinstall the syringe piston and 
syringe head. 

 

FLUID DELIVERY 

Problem Possible Cause What To Do 

Inlet tube not connected at 
manifold or at bottle. 

Check all tubing. 

Supply tube inside the supply 
bottle is kinked or disconnected. 

Straighten or connect supply 
tube. Make sure the end is cut 
as shown in the Optimize 
Performance section of Chapter 
3. 

Clogged dispense tubes on the 
manifold. 

Remove and clean the manifold. 

Inlet tube is not connected to 
the bottom port of the syringe. 

Connect the inlet tube to the 
lower port of the syringe pump. 

Unable to dispense 
fluid. 
 
 
 

Outlet tube is not connected to 
the top port of the syringe. 

Connect the outlet tube to the 
top port of the syringe pump. 

EL406 Washer Dispenser  
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FLUID DELIVERY 

Problem Possible Cause What To Do 

Check valve flow direction is 
incorrect. 

Compare the flow direction of 
the check valves in Chapter 2. 
Switch or replace if necessary. 

Check valves are stuck closed. Clean check valves as described 
in Chapter 4. 

No fluid. Fill bottles with appropriate 
fluid. 

System not primed. Run S-DAY_RINSE for once or 
twice for one or both syringes. 

Faulty syringe pump. Contact BioTek TAC. 

Set screw not tightened on the 
syringe pump piston. 

Reinstall the syringe head. 

Dispense height too high.  Change the Dispense Z-axis 
position (height). 

Volume too large for the vessel.  Define a smaller volume. 

Plate overfills (floods). 

Dispense rate too fast for 
volume selected. 

Define a slower dispense rate or 
lower volume. 

Clogged dispense tubes on the 
dispenser manifold. 

Remove and clean the manifold 
as described in Chapter 4. 

Manifold or tubing not 
adequately primed (air in fluid 
lines). 

Run a Prime using 20 mL. 
Follow with a Dispense: 20 L 
per well for 24 strips.  

Dispense flow rate too low. Define a higher flow rate. 

Setscrew not tightened on the 
syringe pump piston. 

Reinstall the syringe head as 
described in Chapter 4 after 
autoclaving the syringe. 

Uneven dispensing of 
fluid; wells not filled. 
 

32-tube dispense manifolds are 
not dispensing accurately. 

“Recalibrate the Backlash” as 
described in Chapter 4 to 
determine the optimal backlash 
setting for the manifolds.   

Dripping dispense 
tubes. 

Dispense tubing routed 
incorrectly. 

The supply bottle tube must 
connect to the Syringe’s bottom 
port. 

Fluid jet is off-center 
or skewed from 32-
tube SB manifold. 

Minute particles of debris on the 
end of the tubes. 

Brush away any particles from 
the end of the tube using a 
piece of silicon tubing. Silicon 
will not flake off and leave 
particles behind like other 
materials. Alternatively, 
AutoClean the dispense 
manifolds as described in Ch 4. 
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FLUID LEAKAGE 

Problem Possible Cause What To Do 

Defective seals. Replace plugs as described in 
Chapter 4. 

Check valves are leaking. Clean or replace check valves as 
described in Chapter 4.  

Fluid leaking from 
manifold. 
 
 

Fittings to manifold are leaking. Reconnect/reseat the fittings. 

Defective syringe cup. 

Leaking syringe seal. 

Fluid leaking from 
underneath the unit. 

Defective syringe piston. 

 
Contact BioTek TAC. 

Worn tubing. Replace tubing. Fluid leaking from 
external tubing 
connector. Defective connector. Contact BioTek TAC. 

  

MICROPLATE CARRIER MOVEMENT 

Problem Possible Cause What To Do 

Reseat microplate carrier, or the 
plate or strips in holder.  

Microplate not properly seated 
or strips not level. 

Make sure the carrier is clean. 

Horizontal dispense position 
does not align the tubes in the 
wells. 

Change the X-axis (horizontal) 
Position in the protocol. 

Dispense tube(s) bent. Push the supplied stylus into the 
tube and then gently attempt to 
straighten the tube using your 
fingers. If it remains bent, 
contact BioTek TAC. 

Dispense tubes not 
entering well 
correctly. 

Manifold tilted. Check tubing for twists. 

Carrier movement is blocked. Check for/remove any 
obstruction. 

Carrier position error. 

Dirty carrier or carrier rail. Clean carrier and/or carrier rail. 
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DISPENSE MANIFOLD MOVEMENT 

Problem Possible Cause What To Do 

Check the dispense height or Z-
axis positioning. Allow at least 1 
mm clearance above plate. 

Check for/remove any 
obstructions. 

Manifold position 
error. 

Manifold movement is blocked. 

Contact BioTek TAC. 

 

 

 



Appendix A 

Error Codes 

A listing of potential error codes and possible solutions for resolving 
them.  

System Error Codes ..................................................................... 210 
EL406 IS Error Codes................................................................... 219 
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System Error Codes 

Most of these error conditions require technical expertise to correct. Error code 
306 and few other exceptions to this rule are listed with remedies in the 
Troubleshooting section. A few other errors may be caused by an obvious 
obstruction to a device's movement or insufficient fluid in a supply vessel. Fix 
these kinds of errors and restart your instrument to give it an opportunity to 
clear the error code. 

Contact BioTek Technical Assistance Center (TAC) for assistance.   

Code Message  What to do 

0100 Task was aborted 
Restart instrument if this message 
is unexpected. 

0210, 
0220 

Carrier X motor didn’t find home 
opto sensor transition 

Carrier X motor didn’t find autocal 
jig opto sensor transition 

Clean the plate carrier, rails, and 
glide strips, using mild detergent 
and hot water, 70% isopropyl 
alcohol or ethanol. Restart the 
instrument. If the error occurs 
again, contact BioTek TAC. 

0211, 
0221 

Carrier Y motor didn’t find home 
opto sensor transition 

Carrier Y motor didn’t find autocal 
jig opto sensor transition 

Run self test. If error reoccurs, 
contact BioTek TAC. 

0212, 
0222 

Dispense head motor didn’t find 
home opto sensor transition, 

Dispense head motor didn’t find 
autocal jig opto sensor transition 

Run self test. If error reoccurs, 
contact BioTek TAC. 

0213, 
0223 

Wash head motor didn’t find home 
opto sensor transition, 

Wash head motor didn’t find 
autocal jig opto sensor transition 

Run self test. If error reoccurs, 
contact BioTek TAC. 

0214 
Syringe A motor didn’t find home 
opto sensor transition 

Run self test. If error reoccurs, 
contact BioTek TAC. 

0215 
Syringe B motor didn’t find home 
opto sensor transition 

Run self test. If error reoccurs, 
contact BioTek TAC. 

0216 
Peri-pump motor didn’t find home 
opto sensor transition 

Run self test. If error reoccurs, 
contact BioTek TAC. 

BioTek Instruments, Inc. 

http://www.biotek.com/contact/
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0220 
Carrier X motor didn’t find autocal 
jig optical sensor transition. 

Service Only. 
Contact BioTek TAC. 

0221 
Carrier Y motor didn’t find autocal 
jig optical sensor transition. 

Service Only. 
Contact BioTek TAC. 

0223 
Wash head motor didn’t find 
autocal jig optical sensor transition. 

Service Only. 
Contact BioTek TAC. 

0300 
Carrier X motor interlock safety 
switch open 

Service Only. 
Contact BioTek TAC. 

0301 
Carrier Y motor interlock safety 
switch open 

Service Only. 
Contact BioTek TAC. 

0302 
Dispense head motor interlock 
safety switch open 

Service Only. 
Contact BioTek TAC. 

0303 
Wash head motor interlock safety 
switch open 

Service Only. 
Contact BioTek TAC. 

0304 
Syringe A motor interlock safety 
switch open 

Service Only. 
Contact BioTek TAC. 

0305 
Syringe B motor interlock safety 
switch open 

Service Only. 
Contact BioTek TAC. 

0306 Peri-pump Pump Cover is open 
Close the pump cover door and 
rerun the protocol. 

0400 
Carrier X motor failed positional 
verify 

Run self test. If error reoccurs, 
contact BioTek TAC. 

0401 
Carrier Y motor failed positional 
verify 

Run self test. If error reoccurs, 
contact BioTek TAC. 

0402 
Dispense head motor failed 
positional verify 

Run self test. If error reoccurs, 
contact BioTek TAC. 

0403 
Wash head motor failed positional 
verify 

Service Only. 
Contact BioTek TAC. 

0404 
Syringe A motor failed positional 
verify 

Service Only. 
Contact BioTek TAC. 

0405 
Syringe B motor failed positional 
verify 

Service Only. 
Contact BioTek TAC. 
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Code Message  What to do 

0406 
Peri-pump motor failed positional 
verify 

Service Only. 
Contact BioTek TAC. 

0500 Carrier X motor not homed 
successfully 

Remove any obstructions and 
restart. If error persists, contact 
BioTek. 

0501 Carrier Y motor not homed 
successfully 

Remove any obstructions and 
restart. If error persists, contact 
BioTek. 

0502 Dispense head motor not homed 
successfully 

Remove any obstructions and 
restart. If error persists, contact 
BioTek. 

0503 Wash head motor not homed 
successfully 

Remove any obstructions and 
restart. If error persists, contact 
BioTek. 

0504 Syringe A motor not homed 
successfully 

Remove any obstructions and 
restart. If error persists, contact 
BioTek. 

0505 Syringe B motor not homed 
successfully 

Remove any obstructions and 
restart. If error persists, contact 
BioTek. 

0506 Peri-Pump motor not homed 
successfully 

Service Only. 
Contact BioTek TAC. 

0600-
0606 

Specified motor currently in use 
Service Only. 
Contact BioTek TAC. 

0700 
-070F 

Invalid motor number specified 
Service Only. 
Contact BioTek TAC. 

0900 
Calibration failed. The measured or 
calculated autocal value is out of 
tolerance. 

Service Only. 
Contact BioTek TAC. 

0A00 Invalid plate type selected 
Service Only. 
Contact BioTek TAC. 

0C01  
Requested config/autocal data 
absent 

Service Only. 
Contact BioTek TAC. 

0C02  
Calculated checksum didn’t match 
saved checksum 

Service Only. 
Contact BioTek TAC. 
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0C03 Config parameter out of range 
Service Only. 
Contact BioTek TAC. 

1001 
Bootcode powerup checksum test 
failed 

Contact BioTek TAC. 

1002 Unknown error in bootcode Contact BioTek TAC. 

1003 Bootcode page program error Contact BioTek TAC. 

1004 Bootcode block size error (not 256) Contact BioTek TAC. 

1005 
Invalid processor signature (not 
1280,1281,2560,2561) 

Contact BioTek TAC. 

1006 Bootcode memory exceeded Contact BioTek TAC. 

1007 Invalid slave port Contact BioTek TAC. 

1008 Invalid response from slave Contact BioTek TAC. 

1009 Invalid processor detected Contact BioTek TAC. 

1010 
Checksum error downloading 
basecode 

Contact BioTek TAC. 

1250 
Internal RAM test error on the UI 
processor 

Contact BioTek TAC. 

1251 
Internal RAM test error on the MC 
processor 

Contact BioTek TAC. 

1260 Stack test error on the UI Contact BioTek TAC. 

1261 Stack test error on the MC Contact BioTek TAC. 

1300 Invalid syringe selection Contact BioTek TAC. 

1301 Syringe module not connected 

1302 Syringe initialization error 

1303 Syringe sensor not cleared error 

Make sure the Syringe module is 
correctly connected using the new 
BioTek-provided serial cable.  

1304 Invalid syringe dispense volume See error 1308 below. 

1305 Invalid syringe operation Contact BioTek TAC. 
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Code Message  What to do 

1306 FMEA error on syringe A Contact BioTek TAC. 

1307 FMEA error on syringe B Contact BioTek TAC. 

1308 
Invalid Syringe pre-dispense 
volume 

1309 Invalid Syringe prime volume 

1310  Invalid Syringe manifold 

Protocol may have been written for 
a different type of dispense 
manifold. Make sure the 
Instrument Settings represent the 
installed hardware. Modify the 
protocol to match.  

1350 
Peri-pump (PP) invalid dispense 
volume 

Contact BioTek TAC. 

1351 PP invalid cassette type 
Change the cassette type to match 
the protocol requirement and rerun 
the protocol. 

1352 PP invalid pre-dispense volume Contact BioTek TAC. 

1353 Multiple required cassettes 

Make sure every Peri-pump step in 
the protocol calls for the same 
cassette type. A conflict was 
found.  

1354 PP pump cover (safety door) open 
Close the pump cover door and 
rerun the protocol. 

1400 
No vacuum pressure detected after 
turning on the vacuum pump 

Make sure the vacuum pump is 
turned on, and not leaking; the 
waste bottle has not overflowed 
and its caps are seated correctly.  
If the pump is not running, the 
fuse may be blown. But, before 
replacing the fuse, first try to 
determine and remedy the cause 
of the failure. If the pump sounds 
strained or runs slowly, it may be 
damaged. Review other related 
Troubleshooting suggestions. 

1401 
The waste bottles should be 
emptied before continuing 

Empty the waste bottles and rerun 
the protocol. 

1402 The requested valve is invalid Contact BioTek TAC. 
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1500 
No buffer fluid detected at the start 
of a wash protocol 

1501 
No buffer fluid detected before the 
washer dispense step 

Fluid detection errors. Make sure 
the supply bottle is full and 
properly connected, the tubing is 
not kinked, blocked, etc., and the 
correct port/valve is selected.   

Note: 

Running very low density fluids, like alcohol, may generate some of these 
fluid detection errors because the fluid prohibits the float detector from 
operating properly. Disable the Fluid sensor (Setup Menu) while using 
such low density fluids, just be vigilant about fluid levels. 

1502 The buffer valve selection is invalid Contact BioTek TAC. 

1503 Dispense volume error Contact BioTek TAC. 

1504 
No buffer detected flowing through 
the manifold during an operation 

1505 
No buffer detected at the end of a 
wash protocol 

Flow detection errors. Make sure 
the supply bottle is full and 
properly connected, the tubing is 
not kinked, blocked, etc., and the 
correct port/valve is selected.  

1506 
The requested carrier Y-axis 
position is out of range 

Contact BioTek TAC. 

1507 Internal valve transition error Contact BioTek TAC. 

1508 Pre-dispense volume error 
The specified Pre-dispense volume 
is invalid for this plate type. Edit 
the protocol. 

1509 Low flow 192-tube manifold error 

The 192-tube manifold does not 
support cell wash or low-flow 
protocols. A wash step mismatch 
has occurred. Edit the protocol. 

1510 Low flow 96-tube manifold error Contact BioTek TAC. 

1511 
External Buffer Switching valve 
module is required 

The current protocol is defined to 
use different valves of the Buffer 
Switching module, which is not 
installed. Edit the protocol.  

1513 Plate type – manifold conflict 

Change the Plate Type to one 
supported by the manifold. Or, 
click the Instrument Settings link 
and make sure they match the 
physical hardware: Get settings 
from instrument. 
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1600-
160C 

The onboard storage space 
allocated for this function has been 
used up. 

Use the LHC “Manage Memory” 
control to reallocate space. 

2400 Parameter limit exceeded Contact BioTek TAC. 

4000 Program locked so operation denied Contact BioTek TAC. 

4010 
Program non-erasable so delete 
denied 

Contact BioTek TAC. 

4020 
Bad checksum when reading 
program from EEPROM 

Contact BioTek TAC. 

4030 Program not found Contact BioTek TAC. 

4040 
Can’t save program because no 
space available 

Contact BioTek TAC. 

4050 Program run cancelled by user 
Restart instrument if this message 
is unexpected. 

8100 Communications NAK Contact BioTek TAC. 

8101 
Timeout while waiting for serial 
message data 

Contact BioTek TAC. 

8102 
Instrument busy and unable to 
process message 

Contact BioTek TAC. 

8103 Receive buffer overflow error Contact BioTek TAC. 

8104 Checksum error Contact BioTek TAC. 

8105 
Invalid structure type in 
byMsgStructure header field 

Contact BioTek TAC. 

8106 
Invalid destination in 
byMsgDestination header field 

Contact BioTek TAC. 

8107 
Request object received not 
supported by instrument 

Contact BioTek TAC. 

8108 
Message Body size exceeds max 
limit 

Contact BioTek TAC. 
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8109 
Max number of requests currently 
running and cannot run the latest 
request 

Contact BioTek TAC. 

810A 
No request running when response 
request issued 

Contact BioTek TAC. 

810C 
Response for outstanding request 
not ready yet 

Contact BioTek TAC. 

810D 
To communicate with the LHC, the 
instrument must be at its main 
menu 

The LHC can only talk to the 
instrument when its main menu is 
displayed. When the instrument is 
busy, for example when AutoPrime 
is running, press the Stop button 
on the keypad, if desired, to end 
the current process and return to 
the main menu. 

810E 
One or more request parameters 
are not valid 

Contact BioTek TAC. 

810F 
The command was received while 
the software was not ready to 
accept that command 

Contact BioTek TAC. 

A000 Task control block not available 
Service Only. 
Contact BioTek TAC. 

A100 
-A10F 

Software device not available  
Service Only. 
Contact BioTek TAC. 

A200 
Version strings for multiple 
microprocessors do not match 

Service Only. 
Contact BioTek TAC. 

A301 +5v logic power supply level error 
Service Only. 
Contact BioTek TAC. 

A302 
+24v system/motor power supply 
level error 

Service Only. 
Contact BioTek TAC. 

A303 
+42v Peri-pump motor power 
supply level error 

Service Only. 
Contact BioTek TAC. 

A400 Malloc failed 
Service Only. 
Contact BioTek TAC. 
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A500 
Multiple tasks attempted to use 
display simultaneously 

Service Only. 
Contact BioTek TAC. 

A600 Serial EEPROM access error Service Only. 
Contact BioTek TAC. 
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EL406 IS Error Codes 

The EL406 Interface Software (IS) can generate the following error codes when 
you are using the LHC to control the instrument. Generally, these errors are 
caused by protocol parameters that conflict with the instrument's onboard 
settings. The protocol may have been originally created for a different 
hardware configuration, the 192-tube wash manifold instead of the 96-tube, for 
example.  

Quick Fix: Make sure your Instrument Settings accurately reflect your 
instrument’s hardware configuration and then, modify the protocol to fix any 
invalid parameters. With the EL406 connected to and communicating with your 
computer and its main menu displayed on the keypad: 

1. Click the Settings link in the main view. 

2. In the Instrument Settings dialog, click the instrument link to get the 
settings from the instrument. 

3. Modify the protocol step that generated the error message. 
  

Error 
Code 

Description Help 

6000 General communication error 
during download. 

See Communication Errors: EL406 to 
Computer in the LHC Help. 

6001 COM port created by USB 
converter no longer active 

See the LHC Help topic: About COM 
Ports. 

6002 Invalid basecode part number; 
instrument is not an EL406 

Service Only. 
Contact BioTek TAC. 

6003 Invalid Basecode Data Version; 
basecode needs to be updated 

Contact BioTek to obtain latest 
basecode. 

6010 The data is invalid or out-of-
range. 

Service Only. 
Contact BioTek TAC. 

6011 This step type cannot be 
downloaded. 

Review the limitations to transferring 
protocols to the instrument, See the 
LHC Help Topic: Transferring 
Protocols.   

6012 Illegal characters in protocol 
name 

6013 The protocol name length must 
be 16 characters or less.  

See the LHC Help topic: Define a 
Protocol. 

EL406 Washer Dispenser  
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Error 
Code 

Description Help 

6014 A 1536 well plate is not 
supported by this instrument. 

Service Only. 
Contact BioTek TAC.  

6015 The specified volume exceeds the 
cassette maximum limit. 

Modify the volume or change the 
cassette type. 

6016 The volume is out-of-range. Modify the volume or change the 
cassette type. 

6017 Invalid flow rate. Learn about the Syringe Dispense 
Step in the LHC Help. 

6018 Invalid number of  
pre-dispenses. 

6019 Invalid horizontal dispense 
position. 

6020 Invalid dispense height. 

6021 Invalid plate clear height. 

6022 Invalid column selection value 
(must be 0 or 1). 

6023 Invalid protocol step type. 

6024 The Definition String contains 
invalid data. 

  
Service Only. 
Contact BioTek TAC. 
These codes indicate an unexpected 
software error that cannot be fixed 
without BioTek support. 
  
  
  
  

6025 Manifold conflict between protocol 
requirements and instrument 
configuration. 

Change the Washer Manifold or 
change the Instrument Setting. See 
Appendix B. 

6026 Valve module conflict between 
protocol requirements and 
instrument configuration. 

Make sure the Buffer Switching 
setting matches your instrument; see 
Instrument Settings.   

6027 Syringe module conflict between 
protocol requirements and 
instrument configuration. 

Make sure the Syringe dispenser 
setting matches your instrument: see 
Instrument Settings.   

6028 Filter washer conflict between 
protocol requirements and 
instrument configuration. 

Service Only. 
Contact BioTek TAC. 

6029 Required cassette does not match 
installed cassette. 

Change the cassette type to match 
the protocol requirement and rerun 
the protocol. 
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Error 
Code 

Description Help 

6030 Invalid cassette type was 
specified. 

Service Only. 
Contact BioTek TAC. 

6031 Cannot use a 96-well plate with a 
192-tube manifold. 

Modify the Plate Type or Change the 
Washer Manifold. 

6032 Downloading Protocols is not 
supported. 

Service Only. 
Contact BioTek TAC. 

6033 This step is not supported for 
1536-well plates. 

6034 The 32-tube Syringe Manifold is 
required for 1536-well plates. 

6035 The 16-tube Syringe Manifold is 
required for 96- and 384-well 
plates. 

6036 The 128-tube Washer Manifold is 
required for 1536-well plates. 

6037 The 128-tube Washer Manifold 
can only be used for 1536-well 
plates. 

6038 This step only applies to 1536-
well plates. 

Fix the plate type or the Instrument 
Settings. A conflict between the plate 
type and installed hardware devices 
has been detected.  

Change the Plate Type to one 
supported by the washer/dispenser. 
Or, click the Instrument Settings link 
and make sure they match the 
physical hardware: Get settings from 
instrument. 

6039 Conflicting column selection Fix the plate map (selected columns 
to dispense to). A protocol parameter 
may have been changed after a 
partial plate dispense was defined. 

6040 Invalid baud rate 

6041 Invalid data bits selection 

6042 Invalid stop bits selection 

6043 Invalid parity selection 

Service Only. 
Contact BioTek TAC. 
These codes indicate an unexpected 
software error that cannot be fixed 
without BioTek support. 

 

6044 Serial port error 

6045 Serial write error 

6046 Serial read error 

Fix the COM port setting. Check the 
cabling. Click the Port link and use the 
drop-down menu to see all active 
ports. Customize the Pre-defined 
Protocols to avoid this error in future. 
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Error 
Code 

Description Help 

6047 Checksum error Contact BioTek TAC. 

6048 Serial NAK error Make sure the COM port setting is 
correct and the cable is properly 
connected. Restart the instrument. If 
error reoccurs, contact BioTek TAC. 

6049 Excess data, or not enough data, 
received. 

6050 Invalid message header 

6051 Invalid message object 

6052 Invalid message body size 

6053 Serial message timeout 

6054 Port handle error 

6055 Read timeout value is invalid. 

Reset the instrument. Try running a 
different protocol. If error reoccurs, 
contact BioTek TAC.  

6056 Unauthorized to open the COM 
port 

6057 Out-of-range parameter for the 
open port function. 

6058 Unable to open the COM port. 

6059 Unable to clear the transmission 
buffer. 

6060 Unable to close the port. 

6061 Port is no longer available. 

Make sure the COM port setting is 
correct and the cable is properly 
connected. Restart the instrument. If 
error reoccurs, contact BioTek TAC. 

6070 Invalid Syringe specified. 

6071 Invalid number of syringe prime 
cycles 

6072 Invalid syringe Aspirate Delay 
value 

6073 Invalid X-axis offset value 

Service Only. 
Contact BioTek TAC. 
 
These codes indicate an unexpected 
software error that cannot be fixed 
without BioTek support. 
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Error 
Code 

Description Help 

6074 Invalid Y-axis offset value 

6075 Invalid Z-axis offset value 

6080 Invalid Peri-pump prime duration 

6085 Invalid minutes:seconds value 

6086 Invalid hours:minutes value 

6088 Invalid Shake/Soak options 
selected 

6089 Invalid Shake Intensity selected 

6090 Invalid Washer buffer selected 

6091 Invalid Washer Aspirate Delay 
value 

6092 Invalid Washer Aspirate Travel 
Rate value 

6093 Invalid Wash Cycles value 

6094 Invalid Wash format selected 

6095 Invalid Wash Sectors selected 

6096  Wash Aspirate Delay value is 
required. 

6097 Syringe Dispense Volume must 
be an integer. 

Service Only. 
Contact BioTek TAC. 
 
These codes indicate an unexpected 
software error that cannot be fixed 
without BioTek support. 

 

6098 Peri-pump cannot run with the 
pump cover open. 

Close the pump cover door and rerun 
the protocol. 

6100 This functionality requires the 
software to be registered. 

You must register both the LHC and 
the EL406 IS software with BioTek. 
See LHC installation guide. 
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Appendix B 

Changing the Washer 
Manifold 

Instructions for changing the washer manifold: accessory 
manifolds, 192-tube for processing 384-well plates and 128-tube 
aspirate manifold for processing 1536-well plates, replace the 
standard 96-tube manifold.  

Changing the Manifold.................................................................. 226 
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Changing the Manifold 

Three wash manifolds are supported by the EL406: 96-, 192-, and 128-tubes. All three 
manifolds fit onto the instrument and are removed from it in a similar manner. Accessory 
manifolds are shipped in special packaging. Use the shipping case to store whichever 
manifold is not being used.  

Before removing the installed manifold, run a Maintenance protocol (such as 
W-DAY_RINSE) or the “Long_Shutdown” procedure described in the Maintenance 
chapter to flush any remaining residue from the manifold tubes, if the washer has been in 
operation.   

 Tip: It is easier to clean the manifold before removing and storing it 
than afterwards when residuals in the tubing and fluid paths have 
been allowed to dry or crystallize during storage.  

First, clean the manifold: 

1. Run W-DAY_RINSE one or two times with deionized water in the supply 
bottle.  

2. Run the system “dry”: 

1. Disconnect the fluid supply from the instrument,  

2. Run W-DAY_RINSE. 

3. Turn off the instrument and disconnect the power cable.0. 

 Alternatively, use the Ultrasonic Advantage™: Run AutoClean 
instead of W-DAY_RINSE. 

Dual 96-tube manifold 128-tube manifold 

Replace the manifold: 

1. Remove the mist shield.  

BioTek Instruments, Inc. 
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2. Using the 9/64” (3.57 mm) hex wrench supplied with the instrument, remove 
the screws, washers, and springs that hold the manifold in place, and set them 
aside. 

3. Carefully remove the manifold and end plates, holding the upper and lower 
manifolds together as a single unit; the 128-tube manifold is a single unit and 
does not have end plates. Place the manifold into the shipping case for safe 
storage (see photos on next page). If you ran W-DAY_RINSE or an AutoClean 
protocol as instructed, ensure that the manifold is thoroughly dry before 
storing it. 

4. Install the alternate manifold and end plates, if applicable, carefully holding 
the upper and lower manifolds together as a single unit, and making sure that 
the two o-rings do not fall out of their grooves during installation. Do not 
over-tighten the manifold mounting screws.0. 

 

 Important! When reinstalling the manifold, only tighten 
the screw-washer-spring assembly that holds it in place until 
you feel the mechanical stop. Tightening past this point will 
damage the instrument and will void your warranty. 

 

Reinstall the mist shield: 

1. Align the mist shield with the washer so it rests on top of the two posts and the 
two thumbscrew holes in the shield are lined up with the two holes in the base 
of the washer. 

2. Insert the two thumbscrews and finger-tighten only.  

Reconfigure the instrument: 
Configure the washer for operation with the correct manifold:  

1. Using the LHC, select Tools> Instrument Utilities> Washer  

 

2. Under Manifold Selection, choose the button that represents the installed 
manifold. 

3. Click Send to send this setting to the EL406™. 
 

EL406 Washer Dispenser   
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 Important!  The correct manifold must be chosen as the 
Manifold Selection before operating the washer. Failure to 
set the manifold type before operation may damage the 
manifold and void your warranty.  

Storing the Unused Manifolds 
 

 

96- and 192-Tube Boxes 

Separate the dual manifolds 
to store them. Put the 
bottom manifold in the left 
recess and the top manifold 
in the right recess. 

 

128-Tube Box 

Hold the dual manifolds 
together and gently lower 
them into the single recess 
of the 128-tube manifold 
box. Then place the end 
plates, one at a time, into 
the same recess, on the left 
side of the manifolds. All 
components will fit snugly 
into place. 

 



Appendix C 

Chemical Compatibility 

A listing of the materials used in the EL406™ and how they react to 
commonly used chemicals.  
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Chemical Compatibility 

For your own safety and to ensure the EL406’s long life, follow these guidelines 
when choosing compounds to use.  

 Important: We advise against continuous contact with harsh 
chemicals. Best practice is to rinse all components with deionized 
water after contact with any strong acid, base, or solvent. 

 An Excel® spreadsheet containing this information is provided on the EL406™ 
Operator’s Manual CD in the Spreadsheets folder. You may find it easier to use. 

 

The following materials are used in the EL406. Materials listed as 1-20 in  
Table 1 are cross-referenced as headings 1-20 in Table 2. Table 1 indicates 
which component contains the material using W for washer, P for Peri-pump, 
and S for the dual Syringe dispensers.  

Table 1. Material/Where Used List 

# Material  Where Used 
1 304 Stainless Steel W Inlet screen, feeder tube to manifold, vacuum switch, 

fluid pump 
W Fluid inlet filter, feeder tube to manifold, vacuum 

switch, fluid pump 
P Steel dispense tips, pump rollers, carrier rails, 

cassette bolts 

2 316 Stainless Steel  

S Dispense tubes, syringe piston, cylinder head and 
fittings, check valve spring 

 Instrument Base pan, main structural plate 3 Aluminum 
P Center Holder, Tube Tensioner, pump head, dispense 

arm 
4 Borosilicate Glass S Syringe cylinder, supply bottles 
5 Brass P Threaded inserts in Center Holder and Tip Holder 

W Inlet valve, vacuum switch 6 EP (Ethylene Propylene) 
S Check valve o-rings (organic solvent tubing set) 

7 ETFE (Ethylene 
tetrafluoroethylene) 

S Manifold fitting 

8 Neoprene W Manifold channel-end seals 
9 Nylon W Inlet fitting, vacuum switch adjustment screw, carrier 

leveling feet 
 Plate carrier 
W Vacuum switch 

10 Polycarbonate 

P Microplate clamp, cassette rest 
11 Polyethylene W Buffer Bottle 

W Outlet fitting, fittings in bottles, inline fittings, float 
ball 

12 Polypropylene 

P Molded dispense tips 

BioTek Instruments, Inc. 
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# Material  Where Used 
S Bottle cap and fittings, check valves (organic solvent 

tubing set) 
 Assay plates, Mist shield 
W Flow sensor 

13 Polystyrene 

P Peristaltic pump cover, RFID antenna cover  
W Optional check valves (PN: 68098) for fluid pump 14 PTFE (polytetrafluoro-

ethylene) S Syringe seal 
15 CPVC (Polyvinyl chloride) W Inlet screen, inlet valve, manifold, waste sensor, flow 

sensor 
W Outlet valve, fluid pump, CW inlet valve 
P Tube Organizer, priming trough, priming trough 

insert 

16 Ryton® PPS 

S Manifold, manifold plugs, priming trough insert 
17 Santoprene W Fluid pump 

W Inlet tubing, outlet tubing, o-rings 
P Tubing 

18 Silicone 

S Tubing, manifold o-rings, check valve o-rings 
W Outlet valve, inlet valve, buffer switching valves 
P Center Holder, Tube Tensioner, Tip Holder 

19 Ultem (polyetherimide) 

S Check valves 
20 Viton W Outlet valve 
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Table 2. Chemical Compatibility Ratings 

Key 

A   No effect 
B Slight effect 
C Moderate effect 
D Severe effect 
ND No data 

 
Table 1. Materials abbreviated 
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Chemical (1-20 represent Materials listed in Table 1 on the previous pages) 

 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 

Acetic Acid, 5% B A  B  A D B C ND A D A A  D  A  D A  A A  A  B 

Acetic Anhydride B A  A A D A A A A B D B  D  A  D A  A A  ND  D 

Acetonitrile  ND A  B  A ND C A D D C D A  D  A  D A  ND D1 D  D 
Ammonia 10% A A  A A ND A A B A A D A  B A  B A  A D D  D 
Benzyl Alcohol B B  B  A ND D A B B D ND A  D  A  D A  A A  ND  A 
Chloroform A A  B  A B A A C D B D C D  A  D A  D D D  A 
Detergents 1%  A A  B  ND ND C D B C D A A  A  A  A A  B A  A  A 
Dimethylformamide A B  A A ND A A B A A D A  D  A  D A  D A  ND  C 
DMSO 
(Dimethylsulfoxide)  

ND A  A  A ND A A B D A D A  D  A  D A  ND C1 D  D 

Ethyl Alcohol 70%  A A  A  A A A A A B B B A  A  A  B A  B B A  B 
Ethylene Oxide  B B  D  A D ND A D C D C D  C  A  C D ND A  ND  C 
Formaldehyde 37%  A A  B  ND A A A B B A A A  ND  A  A A  ND C  A  A 
Hexane A A  A ND A ND ND C A B D B  D  A  B A  ND D A  A 
Hydrocholoric Acid 
20%  

D D  D  ND D ND A A D A B B  C  A  A D A D  A  A 

Hydrofluoric Acid 
20% 

D D  D  A ND B A B A A D A  ND  A  B A  A D ND  A 

Hydrogen Peroxide 
10%  

B B  A  A D B A C A C A A  A  A  A C ND A  A  A 

Isopropyl Alcohol 
70%  

B A  A  A A B A C A C A A  A  A  B A  ND A  A  A 

Methyl Alcohol 70%  A A  A  A A A C B A A B A  ND  A  A A  B A  A  A 
Methylene Chloride B B  C ND A ND A D C ND D B  D  A  D A  D D D  B 
Phosphoric Acid 10% D D  C A D A ND ND A A A A  B A  B A  A C A  A 
Propylene Glycol B B  B  A ND B C ND A D B A  A  A  C A  ND A  ND  A 
Sodium Chlorate A B  C A ND A A A A B A A  ND  A  A A  A C ND  A 
Sodium Hydroxide 
20%  

B B  D  A B C A D D C A A  A  A  A A  ND A  A  A 

Sodium Hypochlorite 
<20%  

C C  D  A D A A B A A C A  A  A  A C ND B  B  A 

BioTek Instruments, Inc. 



Chemical Compatibility  |  233 

Sodium Hypochlorite 
0.5%  

B B  D  A D D A B B D C A  A  A  A C ND B  A  A 

Sulfuric Acid <10%  D B  B  A ND A A C D B A A  A  A  A A  A C  A  A 
Trichloroethylene B B  D  ND ND C D B C D ND C D  A  D A  D D D  A 
Virkon 10%  ND A  D  A ND A A B A A A A  A  ND A A  ND A  ND  A 
 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 
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 (1) Exposure to DMSO and Acetonitrile may cause the silicone tubing 
to swell, increasing the volume of fluid dispensed. The magnitude of 
this effect will vary with concentration and exposure. Re-calibration of 
the cassette may be required. 

 Please contact BioTek with questions about compatibility of any 
chemicals not described here. 

EL406 Washer Dispenser 
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